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Computer users are not all alike. 
Neither are SYBEX books. 
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about, as well as their ability to write clearly and communicate effectively. Each manuscript is 

thoroughly reviewed by our technical staff to ensure its complete accuracy. Our production 

deportment makes sure it's easy to use. All of this odds up to the highest quality books available, 
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Unlike some other books about System 7, this book was completed after the 
new version of the Macintosh operating system was released and includes both 
last-minute changes that were made in the software itself as well as compatibil­
ity information concerning products you may want ro use with System 7. 

Introduction to Macintosb System 7 is written in a style that everybody can 
understand. It is intended for all Macintosh users who want to learn the impor­
tant information about System 7 without having to be master programmers to 
accomplish this goal. 

How THIS BOOK CAN HELP vou 
If you've never used System 7 and are thinking about updating your current 
system software to this version, you need to know how to install the upgrade 
and how you may be able to continue to use old accessories and programs. You 
want to be able ro weigh the advantages and disadvantages of switching to the 
new version. Finally, you 'd like to find out how you can get the most out of 
System 7's exciting features. This book provides you with practical, step-by­
step help with all of these objectives. 

If you're already working with System 7, you need to learn how to get the most 
from its powerful options such as file sharing and the ability to run several 
programs simultaneously. The chapters that follow are packed with practical 
tips on these and other subjects. 

The explanations of System 7 itself are backed up by descriptions of software 
and hardware that are compatible and can enhance your use of the operating 
system. 

In addition to providing you with detailed instructions on tricky topics, this 
book reproduces hundreds of screens that graphically illustrate the points being 
described. 
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How THIS BOOK IS ORGANIZED 
The following is a summary of the organization of the book and the helpful 
subjects covered: 

• Chapter 1 explains the hardware requirements for using System 7 and 
tells you how to install the system software. You'll also learn how to 
select printer and monitor options and about tricks you can use to make 
older software continue to function properly under System 7. 

• Chapter 2 takes you on a tour of the System 7 desktop. You 'll find 
detailed coverage of each menu and instructions on the use of handy 
desk accessories. 

• Chapter 3 explores the procedures required to install and work with 
several programs simultaneously. The chapter also discusses new ways to 
open and use files and folders, explains the Scrapbook and a powerful 
replacement you can buy for that utility, plus covers the basics of using 
typefaces installed with the system software. 

• Chapter 4 is all about printing your files-how to use multiple printers 
under System 7, letting files print while you continue to work, and the 
options available with different printers. The text tells you how to solve 
special problems too, such as how to share a printer between Macin­
toshes running under different versions of the operating system and how 
to capture and print all or any part of what's displayed on your screen. 

• Chapter 5 reveals the secrets of customizing your Macintosh. You can 
create your own pattern for the desktop and display its contents in the 
typeface of your choice. You can also fine-tune the operation of your 
mouse and keyboard, organize files and folders into groups with special 
names and colors, and even design your own icons. 

• Chapter 6 contains an in-depth look at typefaces. It explains the new 
TrueType technology as well as bitmap and PostScript fonts and how to 
use them all. You'lllearn how to access hidden typefaces that are pro­
vided with System 7 but not installed. There's also information about 
solving typeface problems, new ways to install and view typefaces , and 
helpful accessories that can store fonts more efficiently and even con­
vert them between TrueType and other formats. 



• Chapter 7 is a complete guide to sharing ftles. It tells you how to use your 
Mac on a network and how to restrict and control other users of your files. 
Other topics include sharing disks with users of MS-DOS computers and how 
to use System 7's new publish and subscribe features. 

• Chapter 8 deals with using sound. You can attach comments, sound 
effects, and even music to your files under System 7. If you don't have 
one of the new Macs with built-in sound recording capabilities, you can 
add that feature with an inexpensive accessory. You'lllearn about sound 
recording and editing in HyperCard and through third-party utilities, 
and there's a discussion of Apple's new Qu~ckTime technology too. 

• Chapter 9 features inside information about how to enhance your sys­
tem with powerful new applications, hard drives, CD-ROM drives, scan­
ners, large monitors, and accelerators that make your Mac work faster. 
The chapter describes common pitfalls and how to avoid them, and 
even presents large-screen options for Mac Classic users. 

• Chapter 10 is a problem-solver. You'lllearn how to add more system 
memory and under what circumstances this goal is achievable. You'll read 
explanations of virtual memory and 32-bit addressing, and the fine points 
of allocating memory between applications. Other topics are the repair of 
damaged files and drives and how to fight computer viruses. 

Introduction to Macintosh System 7 is a common-sense, friendly, and authori­
tative approach to the subject. You will benefit from hands-on analysis of Sys­
tem 7 as it was released-plus specific findings about how other programs 
work with the release version of the system software. 

Important procedures are described in numbered steps; after reading about a 
feature, you won't have to guess about how to proceed in order to use it. 

The book has been organized to save you time-tO make you productive with 
System 7's many options as soon as possible. 

After all, productivity is what System 7 is all about. 

xix 
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• Selecting printer and monitor options 
• Making old accessories work 
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If you're using a Macintosh that isn't already set up under System 7, you 'll 
have to install the new version of the operating system. This process may 
involve resolving some incompatibilities with older software and also the selec­
tion and configuration of one or more monitors and printers. If System 7 has 
already been installed (perhaps by your Macintosh dealer), you may still want 
to make some adjustments to the configuration. This chapter will cover these 
subjects. 

WHAT YOU NEED TO RUN SYSTEM 7 
Apple usually furnishes the System 7 software on a group of eight disks. (You 
will have fewer disks if your copy is on high-density floppies.) This version of 
the operating system requires so much storage space that you must have a hard 
disk to use it satisfactorily. However, if you don't have a hard disk, you can buy 
an inexpensive external model and install it by simply plugging it into the SCSI 
port at the rear of your Mac (see Chapter 9). You must have a Mac Plus or later 
model Macintosh. 

You will also need an absolute minimum of two megabytes of memory (RAM, or 
random-access memory). If you want to have two or more large applications 
loaded at the same time, you'll need five to eight megabytes of RAM; the exact 
amount will depend upon the requirements of the specific applications and 
upon the drain caused by memory-resident accessories such as added typefaces, 
sounds, DAs, /NIT files , or CDEVs. 

ADA (desk accessory) is an accessory program you can activate through the 
Apple menu (see Chapter 2), such as the alarm clock, the calculator, and 
the control panels that let you adjust many aspects of your Mac's operation. 

An /NIT (initialization program) is a utility program you install by dragging it 
into your System folder; after you restart your Macintosh, the INIT then resides 
in memory and provides the service for which it was created. An example of an 
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INIT is After Dark (from Berkeley Systems, Inc.); this program produces ran­
dom patterns on your screen during periods of inactivity to prevent burn-in of 
static images, which would damage your monitor. After Dark is also a CDEV 
(see the next paragraph). 

A CDEV (control device) is a software module you also install by dragging it 
into the System folder and restarting your Macintosh; however, you adjust the 
CDEV's operation by accessing it as a control panel (see the explanation of 
control panels later in this chapter). Apple provides a number of CDEVs that 
are installed automatically by System 7; these control panels let you adjust your 
computer's sound level, the appearance of your monitor, the speed of your 
mouse, and many other features. Third-party CDEVs include products as varied 
as After Dark (mentioned previously), SoundMaster (a fun program that applies 
sounds of your choosing to functions such as inserting a disk), and Adobe Type 
Manager (a utility that greatly improves the display and printing of many type­
faces). You'll read more about these products in Chapters 6 and 9. 

If your computer has only a minimum amount of memory, you may have to 
do without some DAs, !NITs, and CDEVs that are already installed. You can 
remove these accessories temporarily and reinstall them later after you've 
added more memory. In most cases, you can deactivate the accessories by start­
ing your computer from a floppy disk containing a recent version of the oper­
ating system (so the accessories won't be currently in use), then dragging the 
icons for the accessories out of the System folder to another location on your 
hard disk. 

After you've installed System 7, you can try reinstalling favorite accessories one 
by one, to determine whether or not you have enough memory to run them 
(and whether or not they're compatible with System 7). If your available mem­
ory is severely limited, it may not be a good idea to push your memory usage to 
the limit in this fashion. At any time, one of your regular applications could 
require more memory than usual for a particular function; you could also crash 
your system, resulting in the loss of any work not previously saved to disk. 

You can use either a standard Macintosh keyboard or an extended keyboard 
with System 7. An extended keyboard provides additional keys usually found 
on the keyboards of MS-DOS personal computers: function keys numbered F 1 
through F 12, Page Up and Page Down keys, and so on. Some versions of Macin­
tosh programs released for use with System 7 make use of these extra keys as a 

• 
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convenience; for example, in Mac Write Pro you can scroll through the pages of 
a document by pressing the Page Up and Page Down keys rather than using the 
mouse or shortcut keyboard combinations. In many programs, you can press 
the Insert key to display help screens or Fl to undo your last action. 

INSTALLING SYSTEM 7 
Prior to installing System 7, you should drag a program called Compatibility 
Checker onto your hard disk. The program is provided on a disk named 
"Before You Install System 7" and requires HyperCard 1.2.2 or later to run. 

Double-click on the Compatibility Checker icon and follow the on-screen 
directions to obtain a report on installed software the program suspects may be 
incompatible with System 7. This report contains information on each pro­
gram stqred on your hard disk, such as version, compatibility status, notes on 
compatibility, and telephone numb~rs for developers of products listed in the 
report. The program will even offer to move questionable items out of your 
system folder. However, often these items will work perfectly with System 7 
after all. 

Transferring System 7 onto your hard disk involves little more effort than giv­
ing the proper response to messages displayed on your screen and inserting 
floppy disks as they're requested. These are the steps required: 

I . If you're using a Macintosh already running under a previous 
version of the operating system, it's advisable (although not 
absolutely necessary) to shut down the computer before you 
begin installation. Otherwise, conflicts could be caused by 
elements of your present operating system that are already in 
memory. 

2. After shutting down the computer, locate the installation disk 
labeled Install 1, and insert it into a floppy drive. (You may have 
more than one diskette drive in your system-for example, the 
usual internal floppy drive plus an additional external drive. 
When you reboot your system, your Macintosh will find and 
load the installation program from either of these drives.) 

3. Then on your Macintosh. After a pause, you'll see a message 
beginning "Welcome to the Apple Installer" (see Figure 1.1 ). 



Getting Started with System 7 

This message informs you that you have two installation op­
tions: either you can choose Easy Install to have the Installer 
program select the appropriate items for installation, or you can 
choose Customize to override the automatic installation proce­
dure. After you've read the message, click the OK button to 
continue to the next screen. 

4. This screen is named Easy Install; it's here that you really make 
your decision as to whether you want to select Easy Install or 
Customize. You would click the Customize button to hand-pick 
items for installation. (\Ve recommend that you do not choose 
this option-unless you have the knowledge to be certain that 
your installation is a special case and unless you know exactly 
how your installation should differ from the standard proce­
dure.) You can also click a Help button if you're unsure of the 
meaning of the options, or click Quit if you want to abort 
the installation process for some reason. Click the Switch Disk 
button if the Installer is about to install the operating system on 
a hard disk other than the one where your system software is 
located. (The name of the disk selected for installation is dis­
played at the bottom of the Easy Install screen.) In most cases, 
all you have to do when you see this screen is click the Install 
button to start the installation using the Easy Install option. 

5. If you should select the Customize option, you will see a screen 
allowing you to select individual elements of the operating 
system for updating. Make your choices, then click the Install 
button to proceed, or click the Easy Install button to return to 
the Easy Install window. 

6. As the installation process begins, the Installer will display a 
progress report: "Determining which files will be needed." This 
message will be replaced by another stating: "Reading from 
Install I. Removing outdated files." You will see a graphical 
representation of the installation disks the Installer will soon 
request, plus an animated drawing of a hand with fingers count­
ing the passage of time as the program proceeds. Soon the 
Installer will eject the Install 1 disk and ask that you insert the 
Install 2 disk. Insert the disk as requested. 

II 
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Figure 1.1 
The Installer 

welcome mess:tge 

7. Continue responding to on-screen prompts until you've pro­
vided all of the disks needed for the installation. The final 
request will be for you tO insert the Install I disk again. 

8. At last, you'll see a screen with a message stating that the instal­
lation has been completed. Click the Quit button. 

9. On the ne?'t screen you'll be given two options: to restart your 
Macintosh under System 7 or to shut down the computer. If you 
choose the shut-down option, remember that you'll still have to 
make decisions later regarding memory management, the desig­
nation of a printer, and the configuration of the display produced 
by your monitor. If you choose Restart, you can continue imme­
diately with the next section of this chapter. 

<1> Welcome to the Apple Installer 

IE&) Your Macintosh needs certain software to start up. 

The Installer places this software on your disk 
in the System Folder. cru 

Sys tem Folder 

NEasy Install" chooses the software Apple recommends and 
creates a disk which can be used to start up your Macintosh. 

(*Customize• if you are sure you want to override those 
recommendations.) 

(( OK ] 

SELECTING MEMORY, PRINTER, AND == MONITOR OPTIONS 
As soon as your Macintosh restarts under System 7, you'll realize that the 
appearance of the screen is slightly different than under previous versions of 
the operating system. For one thing, you'll notice a three-dimensional look 



Figure 1.2 
The Apple menu 
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to the items on the desktop, produced by carefully placed shadow effects. The 
names of some of the menus are different too. We'll explore most menus and 
their contents in Chapter 2. However, in order to complete the details of the 
System 7 installation, you 'II need to use the Apple menu right away. 

Figure 1. 2 shows the basic Apple menu for System 7. Most Mac users will add 
utilities and other options that will expand the list of items on the menu. Unlike 
previous Apple menus, the System 7 version displays a distinctive icon beside 
each name that will symbolize the item on the Application menu; the Applica­
tion menu is a new System 7 menu used to switch between applications and is 
described more fully in Chapter 2. 

About This Macintosh ... 

~ Alarm Clock 
filJ Calculator 
~Chooser 
GB Control Ponels 
Jm Key Cops 
~ Note Pod 
1!1 Puzzle 
~ Scrapbook 

Checking the Memory on Your Macintosh 

First let's investigate the first item on the Apple menu: About This Macin-
tosh .... This option was named About the Finder .. . in previous versions of the 
system software. 

Pull down the Apple menu and select About This Macintosh . . .. You'll see the 
About This Macintosh window displayed in Figure 1.3 , which primarily pro­
vides data on memory usage. 

Incidentally, Figure 1.3 provides a good view of the System 7 desktop, includ­
ing the menus, icons for installed applications, and the Trash. 

• 
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Figure 1.3 
The desktop with 

the About This 
Macintosh window 
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Observe that the About This Macintosh window tells you what version of the 
system software is in use (System 7, of course), the kind of Macintosh on which 
the software is running (in Figure 1.3, the computer is a Mac Ilsi), the Total 
Memory installed, and the Largest Unused Block. 

The memory amounts are shown in kilobytes (represented by the letter K). 
Figure 1.3 shows the Total Memory as 5, 120K; computer users would normally 
round off this amount and say the computer has "five megabytes of memory 
installed." Technically, a megabyte is equal to 1,024 kilobytes. 

The Largest Unused Block item shows the amount of memory that is currently 
not in use and therefore available to load additional programs or accessories. In 
Figure 1.3, the RAM available is listed as 3,044K, which would be enough to 
load two applications with relatively modest memory requirements. 
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Beneath this information, a line runs across the window. Below the line, the 
window always displays the amount of memory occupied individually by Sys­
tem 7 and any applications currently loaded. Only the operating system is 
active in Figure 1.3; both a horizontal bar and the quantity I ,857K tell you the 
amount of memory in use. If applications had been loaded into memory, each 
would be listed by name below the System Software item, along with the mem­
ory drain caused by each. 

As you can see, the About This Macintosh window is a handy way to monitor 
your memory usage. 

System 7 provides ways of adjusting the amount of memory available. You'll 
learn about most of these methods in Chapter 10. However, later in this chapter 
we'll show you one other memory option connected with your monitor that is 
available on many Macintoshes. 

Selecting a Printer or Network Connection 
You can print files either on a printer located near you or through some distant 
facility accessed through a variety of networking options. 

You may have a printer directly connected to your Macintosh; for example, 
Apple Image Writer printers are connected in this manner. 

If you're using a Macintosh that is not linked through a network to any other 
computer and is attached by cables to a printer in the LaserWriter family (at 
home or office), you might think that this Macintosh/printer coupling is a 
direct connection too. Actually, it 's not. Technically, your LaserWriter is con­
nected to your Mac through an AppleTalk network. 

If your computer really is part of a network, you may print files by yet another 
method. You may need to connect through an AppleShare icon or some other 
special icon representing a network with a name like EtherTalk or Token Talk. 

In all of the above situations, you select your printer or network connection 
through the Chooser, a standard Apple menu option that has changed only 
slightly under System 7. Nevertheless, some regular Macintosh users are unfa­
miliar with the Chooser-because a dealer or friend set up a printer for them 
long ago, and they've never had any reason to change the configuration. 

II 
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Follow this procedure to make your selection: 

I. If necessary, click the close box to close the About This Macin­
tosh window. 

2. Pull down the Apple menu, and select Chooser. You'll bring 
up the Chooser window, as shown in Figure 1.4. The list of 
printer-driver icons displayed at the left of the window will 
vary according to the hardware you have available and the 
number of drivers that have been added or removed from your 
System folder. 

3. From the icons available, click the icon representing the printer 
or network connection you wish to activate. 

4. If you select the Image Writer icon, you'll immediately see a 
message at the top of the right side of the window stating: 
"Select a port." This is not a nautical term; the message means 
you should specify the place where your ImageWriter is 
plugged in at the back of your Macintosh-either the printer 
port or the modem port. To make this selection, you click on 
one of the two icons that wiJI have appeared at the right side of 
the window. In case you're not sure to which one the printer is 
attached, all you have to do is match up the symbol on the icon 
with the symbol over your printer cable at the back of your 
Macintosh. (See how easy the Macintosh is to use!) The Inactive 
button will be automatically selected in the AppleTalk area at 
the bottom of the screen, since an Image Writer does not use the 
AppleTalk network. 

S. If you want to select a Laser Writer printer, be sure your printer 
is turned on first. Then clkk the LaserWriter icon. The message 
at the top of the right side of the window will say: "Select a 
LaserWriter." There will be no icons shown on the right side of 
the screen; instead, the Chooser will display the name of your 
particular LaserWriter model. {It can derive this information 
through Apple Talk only if your printer is turned O!J.). 

6. Click the name of your model to select it-even if your partic­
ular printer is the only item displayed; don't skip this step or 
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your documents won't print! (If you work in a large organi­
zation, you may see the names of several Laser Writers at the 
right of the screen, listed not by the model name but by some 
descriptive name provided by the organization, such as Third 
Floor or Accounting Department.) When you select a Laser­
Writer, the Active button is also selected automatically in the 
Apple Talk area at the bottom of the window. 

7. If you're a member of a network, you may have to click a spe­
cial icon to connect to the network, then-from the right side 
of the window-click the name of the printer you want. 
(Printers may have been identified by the network adminis­
trator with special names denoting their specific locations.) 

8. If you're using some printer other than a Laser Writer or an 
Image Writer in a non-network situation, select its icon and 
follow directions from the printer manufacturer. 

9. If you need to use a new printer that does not have an icon dis­
played, you may have to obtain a printer-driver ftle from the 
printer manufacturer or your dealer, then drag its icon into the 
System folder to install it. Following this procedure, you can 
then select the printer in the Chooser. 

I 0. When you've completed your selection in the Chooser, click the 
close box to close the window and return to the desktop. 

You'll ftnd more information about printers and printing procedures in Chapter 4. 

Configuring a Monitor 
You can connect more than one monitor to your Macintosh at the same time. If 
you do so, you can drag items from one screen to the other, as if the monitors 
constituted one continuous screen. You can specify the relative positions of 
each monitor (left, right, etc.) by dragging icons representing the monitors. You 
do all of this in the Monitors control panel, one of a group of control panels 
furnished with System 7. (Under previous versions of the system software, 
there was only one control panel-with items within it that you could select­
merely a difference in terminology. However, you can see most control panel 
options displayed simultaneously now in a window-a definite improvement; 
formerly, you had to scroll a list box to find many of these icons.) 

Ill 



-

II 
CHAPT ER 

Figure 1.8 
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sub-folders in an outline format. However, to do so, you must have chosen one 
of the five file/folder viewing options that lists the items without displaying 
their icons. (For example, you can elect to show the names sorted alphabeti­
cally, or by the dates when they were created, and so on; you make this view­
ing choice through the View menu, explained in Chapter 2). 

Filenames displayed from a sub-folder are indented to distinguish them from 
the files stored in the main System folder. You reveal the contents of a sub­
folder by clicking on a little triangle to the left of its name; the triangle changes 
position to point downward rather than toward the name of the sub-folder, and 
you'll see the contents of the sub-folder. Click again to hide the comems and 
rotate the triangle to its previous position. 

Figure 1.8 illustrates this outlining capability. In this figure, the System folder 
is open, revealing several sub-folders. One of the sub-folders-Apple Menu 
Items-is also open, displaying its contents. You can use the outlining feature 
with any folders and files stored on your disks-not merely the System folder. 
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your documents won't print! (If you work in a large organi­
zation, you may see the names of several Laser Writers at the 
right of the screen, listed not by the model name but by some 
descriptive name provided by the organization, such as Third 
Floor or Accounting Department.) When you select a Laser­
Writer, the Active button is also selected automatically in the 
AppleTalk area at the bottom of the window. 

7. If you're a member of a network, you may have to click a spe­
cial icon to connect to the network, then-from the right side 
of the window-click the name of the printer you want. 
(Primers may have been identified by the network adminis­
trator with special names denoting their specific locations.) 

8. If you're using some printer other than a Laser Writer or an 
Image Writer in a non-network situation, select its icon and 
follow directions from the printer manufacturer. 

9. If you need to use a new printer that does not have an icon dis­
played, you may have to obtain a printer-driver file from the 
printer manufacturer or your deale~ then drag its icon into the 
System folder to install it. Following this procedure, you can 
then select the printer in the Chooser. 

I 0. When you've completed your selection in the Chooser, click the 
close box to close the window and return to the desktop. 

You 'll find more information about printers and priming procedures in Chapter 4. 

Configuring a Monitor 
You can connect more than one monitor to your Macintosh at the same time. If 
you do so, you can drag items from one screen to the other, as if the monitors 
constituted one continuous screen. You can specify the relative positions of 
each monitor (left, right, etc.) by dragging icons representing the monitors. You 
do all of this in the Monitors control panel, one of a group of control panels 
furnished with System 7. (Under previous versions of the system software, 
there was only one control panel-with items within it that you could select­
merely a difference in terminology. However, you can see most control panel 
options displayed simultaneously now in a window-a definite improvement; 
formerly, you had to scroll a list box to find many of these icons.) 

• 
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Most Macintosh users connect only one monitor to a computer, and very few 
connect more than two. When a user employs two monitors, sometimes one 
is a small monitor for everyday work, while the other is much larger, displays 
two full pages simultaneously, and is used for preparing publications. 

To configure a monitor, follow these steps: 

I. Pull down the Apple menu, and select the Control Panels 
option. You'll see the Control Panels window. A typical win­
dow will resemble Figure 1.5 and will contain most of the items 
displayed; you can drag any panel to change its position. Your 
Control Panels window may display CDEVs purchased from 
third-party sources and not provided with the operating sys­
tem. In Figure 1.5, two items at the bottom of the window fall 
into this category: After Dark and Adobe Type Manager (ATM), 
both mentioned earlier in this chapter. 
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Figure 1.6 
The Monitors control 
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2. Click the Monitors icon to select this control panel. The Moni­
tors window will appear, as shown in Figure 1.6. The exact 
options you'll see will depend upon the characteristics of your 
monitor and the video installation supporting it. For example, 
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some Macintoshes can display millions of colors; others are 
limited to 256 colors or less. Monochrome monitors display 
images in black and white; grayscale monitors display many 
shades of gray. 

3. To select the display of Grays or Colors, click one of the buttons 
on the left. 

4. To select the number of colors or grays you want displayed 
(within your system's capabilities), click Black & White or a 
number in the list box. The horizontal bar at the bottom of the 
window will display sample colors, grays, or black and white 
areas to illustrate yo~r choice. 

S. To arrange the positions of multiple monitors, drag their icons 
into the relationship you want (in the area at the bottom half of 
the window). The image on the left-hand monitor will continue 
on the next monitor to the right, as if they constituted a single 
continuous display. 

6. If you're unsure of which monitor is which, cljck the Identify 
button. An identifying number (1, 2, etc.) will be displayed on 
the screen of each monitor. 

7. To specify a monitor as your main monitor, drag the miniature 
menu bar from the top of one monitor icon to another. 

8. On many Macintoshes, if you click the Options ... button, you 
will display a small window showing only the name of a video 
card installed in the computer. However, if your Macintosh has 
built-in video, click the Options ... button to make a memory­
management choice. The Options dialog box will appear as 
shown in Figure 1. 7. 

9. In this dialog box, you can click a button to provide the video 
display with only the amount of memory required to support 
the number of grays or colors you've selected. If you're short of 
memory and don't need to see 256 colors or shades of gray, you 
can click one of the upper buttons to release some RAM for 
other uses. 

I 0. \Vhen you've made your selection in the Options dialog box, click 
OK to return to the Monitors control panel window, then click the 
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close box to close that window and return to the Control Panels 
window. 

I I • Click the close box in the Control Panels window to close this 
window too and return to the desktop. 

ResoLVING coNFLICTS WITH AccessoRIES 
If some of your old utilities won't work under System 7, you may have to go 
through the tedious process of removing all DAs, !NITs, and CDEVs, and then 
reinstalling them one at a time to find out if you're now faced with one or 
more utilities that are incompatible with the new operating system or with each 
other. Based on the results of this research, you may have to delete a utility so 
the remaining ones will load properly. However, you may be able to salvage an 
accessory you used under an earlier version of the system software by moving 
it. The following are two techniques that may succeed. 

Moving Files within the System Folder 
Sometimes you can make a favorite old utility work under System 7 by merely 
changing its location within the System folder. 

Starting with System 7, accessories stored in the System folder are automati­
cally filed in various sub-folders. You can examine the contents of any of these 

m 
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sub-folders in an outline format. However, to do so, you must have chosen one 
of the five file/folder viewing options that lists the items without displaying 
their icons. (For example, you can elect to show the names sorted alphabeti· 
cally, or by the dates when they were created, and so on; you make this view­
ing choice through the View menu, explained in Chapter 2). 

Filenames displayed from a sub-folder are indented to distinguish them from 
the files stored in the main System folder. You reveal the contents of a sub­
folder by clicking on a little triangle to the left of its name; the triangle changes 
position to point downward rather than toward the name of the sub-folder, and 
you'll see the contents of the sub-folder. Click again to hide the contents and 
rotate the triangle to its previous position. 

Figure 1.8 illustrates this outlining capability. In this figure , the System folder 
is open, revealing several sub-folders . One of the sub-folders-Apple Menu 
Items-is also open, displaying its contents. You can use the outlining feature 
with any folders and files stored on your disks- not merely the System folder. 
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When you drag items into the System folder, System 7 automatically files them, 
often storing them in sub-folders it deems appropriate. Unfortunately, this 
procedure sometimes locates older utilities where they cannot communicate 
properly with the new operating system. You can make some uncooperative 
INITs and CDEVs work by merely dragging them out of a sub-folder where the 
System 7 Installer has placed them. To accomplish this move, click on triangles 
to open and inspect the contents of folders (as just described), until you locate 
the item you want. Then drag its icon into the main System folder. 

!NIT files are normaJly stored in the Extensions sub-folder. CDEVs are in the 
Control Panels sub-folder. 

Dragging Desk Accessories out of Suitcases 
If you've used a Macintosh before, you're probably accustomed to having desk 
accessories stored in special files called suitcases. System 7 doesn't use suit­
cases. There are two ways to continue to use those older DAs (assuming that 
they are otherwise compatible with System 7). 

First of all, if you use the Suitcase II utility (or a similar desk accessory/font 
management product) and have a version compatible with System 7, you can 
still open those suitcases and use desk accessories through Suitcase II. (For 
more information about Suitcase II , see Chapter 6.) 

If you don't possess this sort of utility, you must remove the desk accessories 
from the suitcases and install them directly into the System folder. This is easy 
to do: 

I . Locate the suitcase containing the desk accessory. 

2. Double-click on the suitcase icon. Under System 7, this action 
will open the suitcase, revealing its contents in a window, as 
shown in Figure 1.9. 

3. Drag the desk accessory itself (not the suitcase) from within the 
window to the System folder. You'll see a message stating that 
desk accessories should be stored in the Apple Menu Items 
folder and asking your permission to place the accessory there. 

4 . Click OK. The file will be stored, and the desk accessory will 
thereafter be displayed on the Apple menu. 
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Chapter 2 explains the System 7 menus and more features of the new operating 
system. 
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~en you don't see the clutter of application icons usually displayed on a 
Mac desktop , the basic structure of the System 7 user interface becomes very 
simple. In fact , if your Macintosh has a large monitor, the effect can even 
be stark. 

Most of the figures in Chapter 1 were captured from the screen of the 12-inch 
color monitor normally sold with the Mac Ilsi, which exhibits a relatively small 
area. However, Figure 2.1 shows the System 7 desktop of a Mac connected to a 
13-inch Sony color monitor (with the hard disk display closed to conceal appli­
cation icons). As this figure illustrates, in comparison to the Mac Ilsi display, the 
distance is much greater between the menus at the left of the menu bar and 
those at the right end; System 7 menus occupy so little space here they almost 
seem insignificant. The only object visible on the desktop in addition to the 
menus and the hard-disk icon is the Trash icon far below. 

This figure dramatizes how uncomplicated day-to-day use of System 7 can be. 
You don't need to master many system elements in order to handle routine opera­
tions. In Chapter I, you already used some items from the Apple menu. In this 
chapter you '11 explore the remainder of the options on that menu and then 
investigate the other System 7 menus. 

As has always been the case with the Macintosh, some operating-system menu 
items also appear in the same positions on the menus of applications and pro­
vide the same functions. This conformity makes it easier for any Mac user to 
learn new programs. 

OTHER ITEMS ON THE APPLE MENU 
Figure 2.2 shows four accessories accessed through options on the Apple 
menu. Three of them al'e handy utilities; the fourth is merely a game we'll let 
you play as a reward after you finish this book! 
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Here are details of their operation. 

Alarm Clock 

Figure 2. 1 
The Sysrem 7 deskrop 

wirh rhc hard disk closed 

When you select the Alarm Clock command, a tiny horizontal bar will be displayed 
in the upper-right comer of your screen; it will show only the current time, taken 
from the system clock built into your Macintosh. Click on the small lever that is 
pointing upward at the right of the time (in Figure 2.2, this lever is just above the 
tip of the mouse pointer arrow), to turn the lever downward and expand the 
Alarm Clock window so it will appear as it does in Figure 2.2. As you can see, this 
figure shows two time settings; the top setting is the actual time of day, while the 
bottom setting shows the time entered for the alarm clock. 

Here's how to use the options presented: 

I. To set the alarm, click the little alarm clock icon on the right to 
highlight it, then click anywhere in the lower time displayed 
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Figure 2.2 
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to select a segment of the time you want tO change (hour, 
minutes, seconds, or AM/PM). Small up and down arrows will 
appear to the right of the time; you press or click these arrows 
to change the time in the highlighted segment. 

2. As soon as you've set the time when you want the alarm to go 
off, click the small button to the left of the lower time display 
to turn the alarm on. The alarm clock icon will change to indi­
cate a ringing alarm. When the time you select has been 
reached, you'll hear the Mac's alert sound. 

3. To turn off the alarm clock, display the full window for the 
utility again, and click the button that is to the left of the lower 
time displayed once more. The alarm clock icon will no longer 
appear to be ringing, and the alarm function will be rurned off. 

4. To change the time shown continuously on the clock, click the 
clock icon in the lower left corner of the window and change 
the time in the lower display to a new setting, using the tech­
niques explained for the alarm clock in step 1. 

5. As soon as you see the new time you want, click the clock icon 
at the left again. The new time will now appear in both the top 
and bottom time displays. 
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6. To change the date, click the miniature calendar pages shown 
between the clock and alarm clock icons. The currently set date 
will replace the lower time display. 

7. Click the component of the date you want to change (day, month, 
or year). The small up and down arrows will appear to the right 
of the date. 

8. Press or click an arrow to change the selected component until 
you see the date you want. 

9. Click the calendar pages again to save the date setting. 

10. After you've made all of the changes you want in the window, 
you can click the lever to the right of the top time display again 
to reduce the window to its minimum size on the screen. 

I I. If you prefer not to have a continuous display of the current 
time, click the close box in the window. Any changes you made 
(such as setting the alarm) will still be in effect. 

Bear in mind that when you change time and date settings, you are actually 
changing the settings for the system clock. Therefore, the system will use the 
new settings in recording the time and date when files are saved to disk. 

Calculator 
When you select Calculator from the Apple menu, you display a small representa· 
tion of a standard algebraic calculator. To operate the calculator, position the mouse 
pointer on the key you want to "press" and then click the mouse button. You can 
also operate the calculator by using the keys on the numeric keypad. 

You can drag the calculator by its title bar to any convenient location on your 
screen. 

Click the close box on the calculator to remove it from the desktop. 

Note Pad 
The note pad is simply a convenient place to store notes. You can pop up this desk 
accessory from the desktop or from within any application and either write a note 
or review anything previously stored on the eight pages it contains. 

m 
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Try this exercise to familiarize yourself with the note pad: 

I. Pull down the Apple menu , and select Note Pad. The note pad 
wiJI appear. 

2. Drag the utili ty by its title bar if you want to move it to a more 
convenient location on your screen. 

3. Type a short note of a few words. As indicated by the number 
at the bottom of the little page, you will be typing your message 
on page 1 of the note pad. 

4. Now you'll move this note to page 8 of the note pad. Drag 
across all of the text you've written to select the material. 

5. Pull down the note pad's Edit menu at the top of the screen, 
and select the Cut command. (Shortcut: press :le-X.) The words 
you typed will disappear as they're stored temporarily in the 
clipboard . 

6. Click the portion of a page visible below the turned-up corner 
in the lower left area of the note pad. This action will take you 
to the last page of the note pad- page 8. (If you had clicked the 
turned-up corner, you would have djsplayed page 2 instead.) 

7. Pull down the Edit menu again , and select the Paste command. 
(Shortcut: press :~t: -V.) The text you typed has been moved 
from page 1 to page 8. (You could have used the Copy com­
mand to copy and paste selected text from one note pad page 
to another.) 

8. Click the close box to hide the note pad from view. You can 
activate it again with the same contents intact by selecting the 
note pad from the Apple menu at any later time. 

Notes are saved automatically when you close the note pad; you don't issue a 
Save command. 

To delete a note or any part of it, drag to select the text and issue the Edit 
menu 's Clear command. 
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Puzzle 
This desk accessory is purely recreational. The object of the puzzle is to drag a 
checkered square into adjacent squares until all of these squares form a recog­
nizable picture. To display and use the puzzle , you need only select Puzzle from 
the Apple menu. 

But remember: No fair peeking at the puzzle until you've finished reading 
the book! 

7HE FILE MENU 

Figure 2.3 
The System 7 

File menu 

The System 7 File menu (shown in Figure 2.3) offers both familiar commands and 
some interesting new capabilities. When you're actually in an application, you see 
a different File menu-created by the developers of the particular program; some 
commands are identical to system commands, but others have been added because 
they're either necessary or helpful to users of the application. Some special Sys­
tem 7 commands don't appear on menus within programs because they work only 
from the Finder. However, application File menus are still in the same location as 
their System 7 counterpart-next to the Apple menu. 
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You can issue several commands on the File menu (and on some other menus) 
without pulling down the menu at all. Instead, you can use the keyboard 
shortcuts displayed to the right of each command. Nine shortcuts are shown 
in Figure 2.3. 

As was the case with previous versions of the system software, commands that 
are not currently available for execution are shown in gray (dimmed) type. For 
example, the Print command won't be available if you haven't selected any­
thing to be printed. 

The New Folder and Open commands-the first two on the menu-perform 
the same functions as in previous versions of the system software. 

When you select the New Folder command (Shortcut: press :le-N), a new folder 
appears, named untitled folder; you can start typing immediately to give it a 
name, then click outside the folder to save the name. Drag the icons of files 
into the folder to store them there. 

Under previous versions of the operating system, a new folder was called 
Empty Folder. Although you can select a folder or edit its name as you did 
before System 7, the folder icon has changed slightly in appearance in its vari­
ous configurations-when it's selected, when text is being edited, and so on. 
You'll see more on this subject in Chapter 3. 

When you're using the Finder (working on the desktop and not in an applica­
tion), the Open command lets you open a selected file or folder (one that has 
already been highlighted). Of course, you can also double-click the icon of a file 
or folder to open it-a faster procedure. 

The Print command will now print documents from the Finder, without open­
ing the applications in which they were created. Just select a document (or a 
group of documents, by holding down the Shift key as you click each one), 
then issue the Print command and choose the options you want in the Print 
dialog box that will appear. If you select multiple documents that have been 
created in different applications, you'll see a Print dialog box for each. 

The Close Window command (Shortcut: press :IC-W) accomplishes the same 
goal as clicking the close box of a window from the desktop: it closes 
the active window and removes it from view. 
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The Get Info command provides considerable data about a selected file. To use 
the command, click a file to highlight it, then select Get Info from the File 
menu. You'll see an information window similar to that shown in Figure 2.4, 
which provides background on the program file for Aldus PageMaker 4.01. 
Note that you can use this window to determine the kind of file, its size, where 
it's located, exactly when it was created and modified, as well as the version 
number (if it's a program file). Following this data, there is a space where you 
can enter comments. 

At the bottom of the window, you can click the lock check box to keep anyone 
from saving changes to the file (a feature intended primarily to prevent acci­
dental changes, since an experienced Mac user could certainly click the box 
again to remove the protection). In the case of a program ftle such as the one 
shown, you'll also see a Memory box, showing how much memory the applica­
tion requires and how much has been assigned. Read more about using this 
feature in Chapter 10. 

The Sharing ... command lets you designate a folder for sharing with other 
users of a network. The command is explained in more detail in Chapter 7. 

ao:o:·a Po eMalcer 4.01 Info '"""'""'"'""' 

~ ~ Pag•M•k•r 4 .Q1 

Kind : application program 
Siz:• : 1 .4 MB on disk ( 1 ,468 ,218 bytu 

usod) 
Vhl'rl' : Hard Disk: Aldus Pag•Mak•r 4 .01 : 

Cr•.:ot•d : 'o'•d, Mar 20,1991,12 :00 AM 
Hodifil'd : \<led, Mar 20 , 1991, 12 :00 AM 

Version : Aldus Pagt Maktr 4 .01 , Copyricjht 
Aldus Corporat ion 1988-91 

Comments : 

0 Lock•d 

~--~~~.:~~;·;;;;--;:;;;;·-~-, 
/ Curront siz•: ~ K ! 
······-··-.. ·-·-·-·--·-··--·-·-·-···-·--····-··-.J 
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Figure 2.5 
The Find dillog box 
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The Duplicate command makes a copy of a selected file or folder. 

The Make Alias command lets you open a file or folder by opening a tiny 
"stand-in" for the item that can be located anywhere in your system. Aliases 
are explained more fully in Chapter 3. 

The Put Away command removes a selected item from the desktop and stores it 
again in its original location. 

The Find ... command brings up a dialog box in which you can enter the name 
of a file or folder you want to find (see Figure 2.5). Click the Find button to 
start the search. 

Click the More Choices buttoQ in that dialog box to display the expanded dia­
log box in Figure 2.6, which offers a sophisticated search capability that was 
not available before System 7. By using a pop-up menu within the expanded 
dialog box, you can search for an item by its name, size, kind, label (labels are 
explained in the discussion of the Label menu later in this chapter), date cre­
ated, date modified, version, comments, or by whether the item is locked or 
unlocked. A second pop-up menu establishes a criterion for the search; the 
options in this menu change according to the attribute selected from the first 
menu. For example, if you're searching for comments relating to an item, the 
second menu choices are only contain and do not contain. The area to the 
right of the second menu can consist of a box for text entry or a list of choices, 
but-as Figure 2.7 demonstrates-sometimes offers a changeable date display 
instead. 

Find: 11!..11 __________ ___JI 

( More Choices ) Cancel J (( Find J 
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I date modified ... , ._I _l_s_n_o_t ____ ... _.l 5 / 9/0 

Search ../on " Hard Olslc" 0 all at once 

on the deslctop 
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The Search pop-up menu-located in the dialog box below the features just 
discussed-is where you select the portion of your system to be searched for 
items matching your criteria {hard disk, selected folders, etc.) 

You can search for multiple items matching the same description, on any disk 
in your system, by clicking the all at once option. When this kind of search is 
completed, the window containing the items located will switch from display­
ing icons to listing ftJes and folders alphabetically; and any items matching the 
criteria will be highlighted. 

• 
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When you haven't selected the all at once option, use the Find Again command 
to look for an additional example matching the criteria you've provided. 

'-..---.--,.HE EDIT MENU 

Figure 2.8 
The Edit menu 

The Edit menu is very simple (see Figure 2.8) and includes no features new to 
System 7. 

The Undo command often will let you cancel the action you've just taken­
such as accidentally deleting the name of a file. 

The Cut, Copy, Paste, and Clear commands work in the same way as the com­
mands with those names you used in the Note Pad desk accessory. 

The Select All command selects all of the items in a window. 

The Show Clipboard command displays the current contents of the clipboard. 

Cut aGH 
Copy sec 
PBSt~ !leiJ 
Clear 
Select All SCA 

Show oord 

,.HE VIEW MENU 
The View menu lets you look at files and folders in several different ways (see 
Figure 2.9). You can see them represented by small icons; by large icons (the 
default-the choice that will be used unless you specify something else); alpha­
betically by name; by size (with the largest shown first); alphabetically by kind 
of file (application, document, folder, etc.); by label (items identified by text 
labels as part of a group; see the description of labels in the next section); or by 



Figure 2.9 
The View menu 
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the date and time of creation (with the most recent shown at the top of the 
window). 

All you have to do to look at files and folders in one of these configurations is 
use the View menu to select the way you want them displayed. The contents of 
the window will immediately be rearranged in the order you've specified. 

by Sm con 
..lby Icon 

by Name 
by Size 
by Kind 
by Label 

Date 

,.HE LABEL MENU 

Figure 2. 10 
The label menu 

The Label menu (Figure 2.10) lets you tag related files and folders with an iden­
tifying combination of text and a selected color (color only if you have a color 
monitor, of course). For example, if you worked for a construction company, 
you might want to attach the same label to a group of files that concerned a 
particular building project. By default, the Label menu shows names attached 
to colors that are merely placeholders. You're expected to change the labels so 
the colors will represent something more meaningful to you. You make these 
changes through the Labels control panel (more about this in Chapter 5). 

- Essential 
-Hot 
-In Progress 
- Cool 
-Personal 
-Project 1 
-Project 2 
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Once you've established the labels you want , here's how you apply them to file 
and folder icons: 

I • Select the icons to which you want to apply a particular label. 

2. Pull down the Label menu and select the label you want to 
apply to the group. 

Once a label has been attached to a group of files and/or folders, you can search 
for those labels with the Find command. 

You can view files and folders sorted by group through the by Label option on 
the View menu. 

When you look at files and folders in any of the list views, you will see their 
text labels just to the left of the column displaying the date and time of the 
most recent changes. 

,.HE SPECIAL MENU 

Figure 2.11 
The Special menu 

The Special menu is short, but particularly important. You'll use it every day 
(see Figure 2. 11). Some commands have changed under System 7. 

Cl eon Up Window 
Empty Trosh .•. 

Ejec t Disk ~E 

Eruse Olsk •.. 

Rest nrt 
Shut Down 

The first item on the menu-Clean Up Window-arranges the icons in a win­
dow in neat rows. 

When you issue the Empty Trash ... command, you'll see a message telling you 
how many items are in the Trash and how much space they occupy; you're 
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asked if you're sure you want to remove them permanently. Click OK to delete 
the items, or Cancel if you've changed your mind or want to check the con­
tents of the Trash first. (As you'll discover in Chapter 5, you can stop the warn­
ing message from appearing; however, bear in mind that some day the warning 
could keep you from accidentally deleting an important file or folder.) 

Next you 'll see an Eject Disk command (Shortcut: press :IC-E), which will eject 
a disk from your floppy drive. 

Below this menu option you 'll find Erase Disk .... This command reformats a 
disk in your floppy drive. 

The last two commands are the ones you 'll use most often. Restart "restarts" 
the computer without turning it off (sometimes called "rebooting" or "a warm 
boot"). You must use this command to let changes take effect that you've made 
in some utilities such as desk accessories that reside in memory. Bear in mind, 
however, that when you restart the computer, you'll lose any changes you've 
made in a file since you last saved it. 

The final command-Shut Down-must be used to turn off your Macintosh 
safely. Never merely turn the power off. Macs manufactured in recent years are 
constructed so that this command turns off the power too-after the operating 
system has done necessary housekeeping and stored information required to 
maintain the desktop. 

Sometimes you may have to shut down your Macintosh because there 's been 
some software malfunction, then wait a few seconds and restart the computer. 
(This procedure is sometimes called a "cold boot.") 

Occasionally, defective software may freeze up your screen so no mouse move­
ment or keyboard command will have any effect. In these rare situations, you 
may have no choice but to turn off the power and restart-since you would 
then have no way to issue the Shut Down command first. 

.,HE HELP MENU 
The Help menu is at the right side of the menu bar (only the Application 
menu- discussed next- is further to the right) and is identified by a question 

111 
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Figure 2. 12 
The Help menu 
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mark inside a dialog balloon such as those seen in comic strips when characters 
speak. Here you can activate a feature called balloon help in System 7-or turn 
this special kind of help off again. 

Balloon help displays small dialog balloons containing useful explanations, 
whenever you move the pointer to major components of the Mac user inter­
face. This kind of help can be a real boon if you 're using a Macintosh for the 
first time-or even if you're using System 7 for the first time-because com­
monly asked questions are answered for you automatically. 

Figure 2.12 shows the Help menu. You'll see this same menu within most appli­
cations (without the Finder Shortcuts option); often, application developers 
add their own command to the menu when you're using their program, letting 
you access conventional indexed help screens relating to the application. Some 
applications provide the new-style bubble help too (Microsoft Excel is an 
example). 

Finder Shortcuts 

Note: if you have a small-screen Macintosh and are using an application with 
several menus of its own, there may not be room on the menu bar to display 
the balloon help menu too. In these cases, the application will automatically 
sense the presence of the small screen and will let you access balloon help 
through a Window menu used to switch windows within the application. 

The first command in the balloon help menu (About Balloon Help .. . ) brings up 
a screen explaining the feature. The second command is Show Balloons when 
balloon help is not active and Hide Balloons if balloon help is in use; obviously, 
these are the commands that turn balloon help on and off. 



Figure 2. 13 
Balloon help in 

operation 
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The final command-Finder Shoncuts-loads a series of special help screens 
listing those keyboard shortcuts you can use instead of menu commands. 
Figure 2.13 shows an example of balloon help in operation. 

56.9 Titlt bar 

This Is tho 'ol indov 's 
titlt bar. To movt t ho 

l •bl• 

,.HE APPLICATION MENU 

Figure 2. 14 
The Application 

menu 

The final System 7 menu is the Application menu, where you switch between 
items that are currently in memory. You use the Hide command to hide a cur­
rently active application. To make a loaded application current so you can use 
it, select the item by name from the lower part of the menu. 

Figure 2.14 shows that- in addition to the Finder, which is always available in 
memory-only TeachText is loaded. This is a utility furnished with System 7 
that is used most often to display README files; these files are often created by 
developers of applications to provide information that became available after 
the program's manuals were printed. Under System 7, you can also use Teach­
Text to look at graphic files. 

Hide Te8chTeHt 
Hide Others 
Show All 

[II Finder 
../~ TeBchTeHt 
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Selecting the Show All command is a quick way of displaying all of the applica­
tions currently in memory. However, you can work in only one at a time, even 
though you can show windows from others on your screen simultaneously. 

Chapter 3 will provide much additional information about working with 
applications. 
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Most users of previous versions of the Macintosh system software are 
accustomed to working with one program at a time-closing one application 
before loading another. Although the MultiFinder feature of these versions 
permits switching between several programs held in memory simultaneously, 
the average pers~>n exploits this feature only sporadically. Some are uncertain 
as to the exact proce1:1ures required by the MultiFinder, Some are worried that 
their Macs may not have enough memory to run the MultiFinder satisfactorily, 
and others are simply happy handling one task at a time-which is the way 
many of us would prefer to conduct our lives. 

It's a different ball game with System 7. You may still have memory concerns , 
but the ability to load multiple applications on your Macintosh is there all the 
time-whether you utilize it or not. This can lead to confusion and sometimes 
the inability to load an application because you've inadvertently used up all of 
your memory. 

This chapter explains how to handle applications under System 7 and how to 
avoid some potential problems. 

JuGGLING MULTIPLE APPLICATIONS 
Look at Figure 3. 1. What's happening there? At first glance, you might think 
you're simply looking at the desktop. There are two windows visible-one 
showing the contents of the hard disk itself and the other the folder containing 
Claris' FileMaker Pro database application. Yet neither of these windows is 
active because their borders are dimmed and without scroll bars; also, you 
don't see a series of horizontal lines in either title bar, another characteristic 
of an active window. 

Furthermore, there's a menu bar across the top of the screen. Even more con­
fusing, one of the menus on the menu bar has been pulled down-seemingly 
into midair over the desktop. 
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Actually, this figure shows the scene on a monitor after a user has opened File­
Maker Pro and then pulled down the Application menu and switched to 
Ashton-Tate's FullWrite Professional word processing program, previously 
loaded into memory. FullWrite is active, but with no file open at the moment. 
Frequently, under System 7, when an application is open with no document 
displayed, you can see the contents of inactive windows underneath. If you've 
forgotten what you have in memory and exactly where you are in the proce­
dures you intended to follow, a good first step is to glance at the menu bar. In 
most cases, you'll be able to identify the active application by recognizing the 
names of the menus displayed. 

If that effort doesn't reorient you, pull down the Applkation menu. The appli­
cations will be listed that are currently loaded, and the active application will 
be identified by a checkmark before its name. Figure 3.2 shows an Application 
menu for a Mac with the Finder active. (It's always present in memory even 
when it's not the active selection.) Five applications are also in memory and 
available for instant selection. 
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Figure 3.2 
The Application 

menu with several 
applications loaded 

Figure 3.3 
Memory usage 

caused by multiple 
applications 
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Some of the applications shown in Figure 3.2 don't require much memory-for 
example, a mere I92K for TeachText. Even so, it took a Macintosh with eight 
megabytes of memory to load them all. Look at the information revealed, in 
this case, when you pull down the Apple menu and select the About This Mac­
intosh command (shown in Figure 3.3). You can see that an amazing amount of 
RAM is occupied cumulatively by these five programs. You can also see that 
System 7 itself requires 2,636K- or over two and a half megabytes of RAM; 
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some of this drain is caused by accessories and typefaces resident in memory­
not an unusual circumstance. (By eliminating the use of such extras, it's pos­
sible to load the system software so it uses as little as 1 ,OOOK; however, you'll 
be doing without the convenience of these features .) 

When you have reached your Mac's memory capacity, you'll see one or more 
warning messages; some messages of this kind are displayed by the applications 
themselves. 

It's easier than you might think to run out of RAM. The situation usually occurs 
under System 7 when you open an application, create or use a file within the 
application, and close the file . Then you open a different application and create 
or use a file within that second application. 

"What's wrong with this sequence?" you may ask. The problem arises because 
you probably took these steps: You finished using a file in the first application 
and closed the file. Immediately, the windows of other applications and/or the 
desktop became visible-previously hidden underneath the open file. Perhaps 
you clicked on an application whose icon was visiblt:; this action would 
instantly make that window active and would load the application. However, 
although you closed tbe file you were using in the first application, you did 
not follow up by closing the application itself. 

When you've finished using an application, you must either pull down the File 
menu and select Quit-or use the shortcut: hold down the Command key and 
press the letter Q. Otherwise, you can easily end up with four or five applica­
tions still in memory that you've finished using. 

In Chapter 10, you'll find out how to change system and application settings to 
help you use your available memory more effectively. 

INSTALLING AND OPENING APPLICATIONS AND FILES 
There is usually only one way to install an application-the procedure specified by 
its publisher; in this section we'll discuss the most popular procedures used by 
software vendors. 

• 
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Once an application is installed, you can open it in several ways, some of them 
unique to System 7. You'll learn about these options in this section too. 

Transferring Programs to Your Hard Disk 
As current Macintosh users know, you can install most applications right out 
of the package with very little effort. However, because installation procedures 
can vary widely, we' ll review the basic steps: 

I . Open the envelope containing the disks and insert the program 
disk into a floppy drive. 

2. If the program disk doesn't open automatically, double-click on its 
icon to open it. You'Ll probably see either a folder containing the 
application or individual icons for the ftles required to run the 
program. 

3. If the floppy drive does contain a folder, drag the folder onto 
your hard disk. Your Mac will create a new folder on the hard 
disk with the same name and copy the application's files into it. 
You're finished! 

4. However, if there is no folder on the floppy disk (only icons for 
program files), you'll have to create a new folder on your hard 
disk to contain the program files . Pull down the File menu and 
select the New Folder command (Shortcut: press 31:-N). A new 
folder will appear, labeled untitled folder. 

5. Type a name for the folder immediately, and the name will 
automatically appear underneath the folder. (You'll probably 
want to give the folder the name of the application.) Click on 
your desktop outside of the folder area to complete the entry 
of the name. 

6. Drag the contents of the floppy disk into the new folder. (To 
speed up the process, you can hold down the Shift key and click 
in order to select more than one icon at a time; you can also 
press X· A to select all of the items in an open disk or window 
with one command.) 
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7. You may have to open additional disks and drag their contents 
into your new folder too. (Follow the instructions provided 
with the application.) 

8. A few applications require a more involved installation. For 
example, their documentation may tell you to drag certain ftJes 
into your System folder. 

9. Some applications have an automated installation routine. As 
with the installation of System 7 itself, you may have to double­
click on an Installer icon and follow on-screen directions to 
provide needed information and insert disks as requested. 
Don't try to bypass the installation program by dragging icons 
onto your hard disk. The basic reason for most automatic instal­
lation programs is that the files are shipped to the purchaser in 
compressed form; the installation decompresses the files so 
they're usable, as well as placing them where you want them on 
your hard disk. 

Opening Programs and Files 
Once an application has been stored on your hard disk, you can open it by 
using any of several methods which we'll describe now. 

Opening by Scrolling and Double-Clicking 
The most common way to start a program is to double-click on the icon for the 
folder containing the program in order to open the folder, then to locate the 
program icon within the folder and double-click on that icon to load the appli­
cation. You probably use this technique yourself on a regular basis. However, 
you may have trouble locating the right folder on your desktop and then find it 
necessary to scroll the folder window or zoom it to a larger size in order to find 
the program icon. 

System 7 offers better alternatives! 

Opening a Program through a File 
When a file is saved through any application, a record is included with the me of 
the program that created it. To open that file again, you can simply double-click 
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Figure 3.4 
Dragging a file icon 
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on the file icon; the program that created the file will load automatically, then the 
file itself. 

System 7 adds another way to open a file along with a program to run it. For 
example, you can save a file in the PICT format through MacDraw Pro. Several 
other drawing programs can open and use PICT files too. Under previous ver­
sions of the system software, in order to use a PICT file ih Canvas that was 
created in MacDraw, you'd have to open Canvas first, pull down its File menu, 
select the Open . .. command, locate the PICT file in the list box of the Open 
dialog box (perhaps by switching to another folder and/or drive), then select 
the file. Under System 7, you can bypass this entire routine by dragging the 
PICT file icon onto the Canvas program icon, as shown in Figure 3.4. Canvas 
will load, with the PICT file displayed (see Figure 3.5). 

Canvas1M 2.1 ••••••••••••• 1:::::111 

, .............. . 

Remember, this trick works with any kind of file, so long as the application in 
question can normally open and use a document in that file format. 

System 7 provides even more good news on the subject of opening files. What 
if you have a file created in a certain application and saved it in the PICT 
graphic format, but you don't have any other application installed on your 
Macintosh that can open a PICT file? What to do? The version of Teach Text 
shipped with System 7 can come to the rescue. 

Previously, Teach Text was primarily a handy utility for opening and reading text 
ftles . Application developers often create README files to ship with their software. 
These README files list mistakes found in the manuals or provide additional infor­
mation about using a program; you can usually double-click on one of these 
README ftles and fmd that it has been opened for you in Teach Text. 



Figure 3.5 
A Mac Draw PICT file 

opened in Canvas 

Figure 3.6 
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Now, under System 7, when you double-click on a PICT file and when the 
application that created the files is not installed on your Mac, you'll see the 
message shown in Figure 3.6, asking you if you want TeachText to open the 
file. Of course, the purpose of opening files in this manner is so you can look at 
them; you can't revise a drawing with TeachText. Nevertheless, this new way to 
open "orphan PICT files" can be very useful. 

The document "ScreenDump" could not be 
opened, because the application program 
that created It could not be found. Do you 
want to open It using "TeachTeHt"? 

( Cancel ) (( OK ~] 



II 
C H APTER 

Introduction to Macintosh System 7 

Opening a File through an Al ias 
We all h~ve applications that we use more often than others. System 7 lets you 
display those applications on the Apple menu and start them without opening 
folders and looking for program icons. In fact, you can load an application 
from any conveniei:tt spot on the desktop or from within folders anywhere on 
your system. The secret is creating an alias of the program file. 

You can also create an alias for a document. 

An alias is not a copy of the file i it's a tiny "stand-in" for the file that occupies 
only about IK of disk space and lets you open the original from anywhere you 
like. You can make several aliases for a single file. 

Here's the procedure to follow for creating an alias and adding it to your 
Apple menu: 

1. Select the icon of the file for which you want an alias. 

2. Pull down the File menu and select the Make Alias command, as 
shown ip Figure 3. 7. An alias will appear next to the original 
file; the alias will bear the name of the file, with the word alias 
added; the name will be displayed in italics. 

3. Double-click the System folder to open it and scroll the folder if 
necessary until you see the Apple Menu Items sub-folder. Drag the 
alias icon into this sub-folder, as depicted in Figure 3.8. (Unlike 
the manner in which System 7 handles some kinds of ftles, it will 
not automatically store an alias in the Apple Menu Items sub-folder 
if you merely drag that alias into the System folder itself; you must 
place the alias exactly where you want it.) 

4. Pull down the Apple menu. Instantly, as shown in Figure 3.9, 
the alias will be displayed as part of the menu, without restart­
ing your Macintosh. You can now start the program at any time 
directly from the Apple menu. 

Opening Programs and Files Automatically 
Some Macintosh users work primarily with one program everyday- or even 
with one file. An extreme example would be an employee whose job is entering 
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orders into a sales database and who might never use other files or programs. 
Perhaps the boss would like to have that file available at starting time everyday, 
without compelling the employee to learn how to load files and navigate Mac­
intosh menus. 

On the other hand, someone working at home might need to switch between 
three programs everyday and would like all of them handy and ready to use at 
any moment. 

Under System 7, both of these situations can be handled easily and automatically. 

There is a sub-folder inside the System folder called Startup Items. If you want 
any programs or files loaded the instant you turn on your computer, just drag 
aliases of the items into this sub-folder. 
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Figure 3.8 
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Of course, if your daily routine later changes , you can terminate the automatic 
start-up of any program or file by dragging its alias out of the Startup Items 
folder again. 

IDENTIFYING THE STATUS OF FOLDERS 
Under System 7, a folder will acquire a different look every time you alter its 
mode. This section will show you how to identify these changes. 

First of all, if you have a color monitor and have attached a label to a folder, the 
folder will be displayed in the color that accompanies the label. For example, if 
you've defined a label named Accounting and associated it with the color 
green, all folders given the Accounting label will automatically appear in green. 

Before you installed System 7, you may have already applied colors to folders 
through the Color menu that was previously part of the Finder. You may have 
used the colors strictly because they added a bit of sparkle to your desktop. 

The System 7 installation program retains any prior folder color assignments, 
meaning that the label now associated with a color will also be attached to old 
folders with that color. Therefore , you may want to check your colored folders 
to be sure that none of them carry an unintended label. 

If you're not using a color monitor, all folders will appear in a single shade of 
light gray; to identify folders with labels attached, you will have to select one 
of the list formats from the View menu so any assigned label name will be dis­
played along with its associated filenames. 

Now let's review the appearance of folder icons in their \'arious configurations. 

Figure 3. 10 shows a folder on the desktop when no part of it has been selected. 

Figure 3.11 shows a folder when the icon has been selected. Note that the name 
of the folder is now reversed-white lettering on a black background. 

Figure 3.12 shows a folder when the text area has been selected. The lettering 
is black on a light gray background. (On a color monitor, the background is 
whatever color you have selected for highlighting; Chapter 5 tells you how to 
specify this color.) The text area is surrounded by a border. 



CHAPTER 3 

Figure 3.10 
A folder with no pan 
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Figure 3. 11 
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Figure 3.13 shows a folder during text entry; the background turns white, and 
the border remains around the text. 

Figure 3.14 shows a folder when a word has been selected for deletion. All of the 
text is black. The background is white, except for the selected area, which is 
shown in light gray or (on a color monitor) in the color chosen for highlighting. 

0 
Janefs Files 
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UsiNG THE scRAPBOOK 
You know that the Mac clipboard is a handy tool for moving or copying text or 
graphics from one part of a document to another or from one file to another. 
In fact , you can paste a single entry from the clipboard into a series of 
documents-as long as you don't restart your computer or shut it down. 

The instant you use the Cut or Copy commands to place a different item in the 
clipboard, the new entry automatically wipes out the the previous one. 

Fortunately, if you want to store many frequently used text or graphics items for 
days or months and paste them into documents or applications at will, there is a 
way to do it. It's called the Scrapbook. Many Mac users have never taken advantage 
of this feature. However, since System 7 lets you have several applications in 
memory simultaneously, the Scrapbook can help you more than ever. 

Some applications also let you store and play sounds in the Scrapbook. 

You access this desk accessory through the Apple menu and can display it on 
top of any other application you happen to be running. 

The easiest way to understand the Scrapbook is to see it at work. Follow this 
sequence as a design created in the MacDraw format is copied from MacDraw 
Pro into the Scrapbook: 

I . Select the object to be moved by clicking it. 

2. If you're dealing with a graphic actually composed of several 
independent objects, drag to enclose the graphic with a dashed 
line (as illustrated in Figure 3.15). When you release the mouse 
button, all of the graphic's components will be selected (indi­
cated by small square black handles around the boundaries of 
each object). 

• 
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3. If the program has a Group command, issue this command with 
the objects stiiJ grouped. They will thereafter function as a 
single object and-when selected-wiU be bounded by a single 
series of black handles. 

4. PuiJ down the Edit menu, and select the Copy command 
(Shortcut: press :14:-C), to copy the graphic to the clipboard. 

5. Pull down the Apple menu, and select Scrapbook (as shown in 
Figure 3.16). The Scrapbook will appear, displaying the entry last 
accessed. Figure 3.17 identifies the graphic shown as 2/3, meaning 
the second of three total entries in the Scrapbook. When you paste 
in a new item from the clipboard, it will replace the entry dis­
played in the storage sequence, causing that entry and all higher 
numbered entries to have their numbers increased by one. You 
can use the scroll bar to select the exact place in the Scrapbook 
me where you want to insert the new item. 
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6. Pull down the Scrapbook Edit menu, as shown in Figure 3.17, 
and select the Paste command. The item you previously copied 
to the clipboard will be inserted into the Scrapbook. In this 
example, Figure 3.18 confirms that the design imported from 
MacDraw Pro is now number two of four entries (2/4). The 
lettering at the lower right corner of the Scrapbook window 
identifies the file format of the stored entry (in this case, it's 
been stored in the PICT format) and the application in which it 
was created (dPro for MacDraw Pro). 

7. Close the Scrapbook. The graphic is now available for copying 
into other applications and/or documents. 

8. To copy an item from the Scrapbook to the clipboard for past­
ing elsewhere, simply display the item and select the Copy 
command. Displaying the item preselects it for copying. 

II 



C HAPTER 3 

Figure 3. 17 
Pasting the graphic 

imo the 
Scrapbook 

Introduction to Macintosh System 7 

1411 tmli%<kla l§·IM~Rt\!;:~f:il!l~!f.!§'@',Kt l1%1iF1J!lMKtijt\jjHI61 
2 / 3 Pr:T, I1>f't. 

·• ........ . . . . .. ... ... .... .... ... ... .. .. .. .. ... ...... ... .. .. . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

9. To delete an item from the Scrapbook, display the item and 
select the Clear command. 

You may be interested in purchasing a third-party utility named SuperScrap 
(from Solutions International). It allows you to use multiple Scrapbook files , 
name each entry, find entries through either text- or graphic-based tables of 
contents, view an entire entry by scrolling (System 7's Scrapbook displays only 
the top corner of large files), and (through a companion product called the 
Clipper) paste any portion of a Scrapbook file into a document, instead of 
being restricted to the use of the complete item. 

UsiNG TYPEFACES 
System 7 gives all of your applications access to any typeface installed on your 
Macintosh. 
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The Installer automatically installs two different kinds of typefaces. By default, 
bitmapped typefaces are employed in creating the user interface-the desktop, 
the menus, and so on. These typefaces are actually composed of a series of 
small fixed dots; therefore, they come in set sizes that can't be altered. The 
other typefaces provided with System 7 are in the True Type outline format; in 
effect, each typeface is a tiny computer program that lets you instantly create 
any size you want for both screen display and printing. You can access both 
bitmapped and TrueType typefaces through the menus of any Mac application , 
as well as additional bitmapped and outline typefaces you may have purchased 
and installed separately. 

In most applications, you select or change typefaces through a menu or menu 
option named Font. However, the appearance of these font menus and options 
can vary greatly. To illustrate this point, Figure 3.19 shows the Font menu of 

m 
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Figure 3. 19 
The Font menu in 

Microsoft Word 

Figure 3.20 
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Microsoft Word. Figure 3.20 shows the Font dialog box of Excel 3.0, accessed 
through that program's Format menu. Although both programs are offering the 
same typefaces, each approaches the subject in a different way. (In Excel , you 
must scroll a list box to see all of the typefaces installed.) 
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To pick a typeface when you're using an application that is in a text entry 
mode, you can simply use that program's menus to select the typeface and 
size, and begin typing. The text you enter will appear in the new style. 

To change text that has already been entered, drag to select the text, then use 
the menus to pick the typeface and size you want. The selected text will change 
immediately to reflect your choice. 

Chapter 6 treats the subject of typefaces in detail. 

Iii 
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~en you've completed a document, you'll probably want to print it. 
Under System 7, you can accomplish this task very efficiently. In fact, with 
som~ printers you can even issue a print command, leave the program in which 
you created the file , and start working in another program. Your document will 
be printed "in the background" while you perform other functions. 

Unfortunately, after you install System 7, you can also run into real roadblocks 
with certain combinations of printers and circumstances. As a case in point , if 
your computer shares a Laser Writer with one or more Macintoshes functioning 
under an earlier version of the system software-either through simple Apple­
Talk connections or through a more sophisticated network-you may have 
compatibility problems. 

This chapter covers both the options available when you use popular System 7 
printer drivers and the solutions to common difficulties you may encounter. In 
addition, you'll find information here about System 7 print utilities. 

AvoiDING PRINTER SELECTION PITFALLS 
Chapter 1 explained how to use the Chooser to select a printer. However, it 's 
very easy to select the wrong printer-in other words, one you don't have­
particularly since some of the icons have sirnilar names. 

It's also easy to confuse the capabilities of your printer with those of another you 
may have read about or used in the past. Therefore, we advise caution when either 
installing or switching printers. If you always use the same printer, you may need 
to use the Chooser only once-when you first install the printer. 

Using Multiple Printers 
There are situations where it's advantageous to use the Chooser every day. 
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For example, some Macintosh users have only a single computer, but it's con­
nected to two printers. One may be a laser or inkjet for letterheads and reports 
where top quality is required; the other printer could be a dot-matrix model 
using continuous sheets of tractor-fed paper to reproduce large spreadsheets. 
Users of this configuration simply connect one of the printers to the printer 
port of the Macintosh and the other to the modem port. This procedure can 
be very efficient. 

However, not every printer can be attached to the modem port. For example, 
you can connect the Personal LaserWriter LS to either port, without using 
Apple Talk. However, other Laser Writers must be connected to the printer port 
and must use AppleTalk. 

A variation on the two-printer setup is frequently used by a person whose Mac 
is connected to a network. Perhaps the network printers are located far down 
the hall; they produce excellent quality output and can handle large documents 
easily, but usually have many documents waiting for their turn to be printed. 
At the same time, the individual user needs to produce a flood of short memos, 
reports, and letters throughout each day. If this is your situation, the answer can be 
to connect to the network through the printer port and also have an inexpensive 
personal printer in your own office, connected to the modem port. 

Selecting Background Printing 
Background printing-mentioned at the beginning of this chapter-is supported in 
System 7 only for Laser Writer printers (including the Personal Laser Writer LS), or a 
printer not manufactured by Apple that can use a Laser Writer driver. You tum 
background printing on or off through the Chooser (see Figure 4. 1 ); the option 
appears in the Chooser window only if you have selected a printer that supports 
this feature. 

When background printing is active, you can issue Print commands for several 
documents in multiple applications, without waiting for the commands to be 
executed; each file will be queued and printed without any further action on 
your part. 

In addition, you can check on the progress of background printing or remove a 
docu111ent from the queue by using the PrintMonitor utility, which is explained 
later in this chapter. 

II 
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Messages Relating to the Chooser 
If you will be working with several applications simultaneously under Sys­
tem 7, be particularly careful about changing printers. Immediately after making 
the switch, bring up the Page Setup di~log box in each program currently in 
memory and make any changes that may be required because of the different 
capabilities of the newly selected printer. The next section describes how both 
the Page Setup and Print dialog boxes diff~r for several popular printers. 

When you switch printers in the Chooser, you'll see the alert message shown in 
Figure 4.2, which will serve as a reminder to check the dialog boxes. 

Figure 4.3 displays the message you' ll see if you've accidentally selected a 
printer you don't have, or if the printer is disconnected or turned off. 
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CHOOSING PAGE SETUP AND PRINT OPTIONS 
You 'II find Page Setup .. . and Print ... commands on the System 7 Finder File 
menu and on the File menu of every application. However, the appearance of 
the dialog boxes displayed by the commands will vary according to the capa­
bilities of the printer currently selected. For example, the Page Setup dialog 
box may contain as few as three items or as many as 13. 

The subject is further complicated by the fact that some applications add their 
own options to those available in the standard dialog boxes, or replace stan­
dard options with others. Figure 4.4 shows the Print dialog box for the Per­
sonal LaserWriter LS that is displayed within the Claris Resolve spreadsheet 
program; it adds options relating to the printing of the cell grid and row and 
column headings. 

m 
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When you print from MacDraw Pro , you won 't see these particular options. 
Instead, you'll have the opportunity to print copies of MacDraw documents 
created for use in on-screen slide presemations. You can also print handouts 
(small reproductions of the slides, printed several to a page). A third option lets 
you print notes attached to a MacDraw document, or print the document with· 
out the notes. 

The Print dialog box for Microsoft Word provides yet another set of options: 
you can elect to print portions of a document, hidden text (sometimes written 
as notes not intended for printing), or the next file in a sequence of Word docu· 
ments marked for printing. 

In this section, we 'll explain the dialog boxes for some of the more popular 
printers. All of them, except the Image Writer, support the new TrueType type· 
face technology included with System 7 (see Chapter 6) and receive informa­
tion for printing through the QuickDraw descriptive language built into the 
operating system. Of the printers mentioned in this section, only the Laser­
Writer NT and NTX printers support the sophisticated PostScript language, 
also used by professional printing and publishing firms. 

The StyleWriter 
The Apple Style Writer is a relatively low-cost inkjet printer. The inkjet tech­
nology forms a high-resolution dot pattern from tiny sprays of ink. The Style­
Writer's output stands up well against that of Apple laser printers, which use 
the pulses of a laser beam to transfer dot patterns to paper. Both devices can 
deliver a resolution of 300 dots per inch. 



Figure 4.5 
The Style Writer Page 
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The StyleWriter's Page Setup dialog box (see Figure 4.5) presents only three 
options. First, you can specify the paper size you'll be using, by clicking one 
of four buttons. The size options are US Letter, US Legal, a # 10 envelope (the 
envelope customarily used to enclose a business letter), and A4 Letter. The A4 
size (with a printing area of 7.45 by 10.86 inches) is popular in Europe. 

You can click one of two Orientation settings: to print across the narrow 
dimension of the page-referred to as printing in tall or portrait mode, or 
across the wide dimension of the page-called wide or landscape mode. 

The third option in the dialog box lets you increase or reduce the printed size 
of the document; this feature is handy if you want to print a graphic image 
that 's a little too large for your page. 

StyleWrlter 

Paper: ®us Letter 
0 US Legal 

Orientation: 

0 A4 Letter 
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Scale: 1 00'7. [ID 

7 .0 lQWJ 
(Cancel J 

Unless you use a special command in an application to change default settings, 
changes in the Page Setup dialog box apply only to the current document and 
are saved with it. 

For most of your documents, you may never have to look at this dialog box at 
all. The default settings will probably be what you want. 

All experienced Macintosh users know that to print a document you must pull 
down the File menu and select the Print ... command (Shortcut: press X-P). 
This action brings up the Print dialog box. Here again, the Style Writer has the 
very simple Print dialog box shown in Figure 4.6. 

m 
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You can specify how many copies of your document you want to print on a 
Style Writer, which pages, fast printing with average quaUty or slower printing 
with the Style Writer's best quality, and whether the paper is to be drawn from 
the sheet feeder or fed manually (as you might do if you wanted to replace the 
sheet feeder's usual supply of plain white paper with a letterhead to be used 
for a quick business letter). 

These are the only options. ,With a Style Writer, it's hard to get confused. 

There's one change brought about by System 7. When you've made your 
choices in the dialog box and are ready to print, you click a button labeled 
Print. Under previous versions of the operating system, this button was named 
OK. (This change in the button name applies to the Print dialog boxes for all 
printers.) 

The lmageWriter 
The Image Writer is Apple's time-honored dot-matrix printer. It's what is known 
as an impact printer. Striker wires in its print head hit an inked ribbon, form­
ing characters on paper from a series of little dots. One advantage of this kind 
of printer is th:tt it has a tractor-feed mechanism for the use of continuous fan­
fold paper. Many companies rely on this capability in their accounting depart­
ments, to print long spreadsheets on a single page. 

As you might surmise, this hardware feature requires the presence of special 
options in the ImageWriter's Page Setup dialog box (shown in Figure 4.7). 
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This dialog box adds two paper options not available for the Style Writer; 
both options are displayed for the Image Writer because of its ability to use 
fanfold paper. The first option is a Computer Paper button you can click to 
indicate you're using standard US fanfold paper. Second, if you're using the 
international-size fanfold paper (a companion in dimensions to the A4 single­
sheet size used if your Image Writer has a sheet feeder), click the International 
Fanfold button. 

The only adjustment supported here for the overall print size of documents is a 
50 percent reduction, activated by clicking the box beside that option. How­
ever, you can click the Tall Adjusted box to adjust image proportions slightly so 
the dimensions wiiJ be the same as if the document were printed on a Laser­
Writer. Use this option to make a checking copy of a file you will print later on 
a Laser\Vriter. 

The final option is No Gaps Between Pages. If you're using fanfold paper, you 
can use this option to print right across the horizontal perforations that allow 
you to separate the continuous paper into individual pages. 

As Figure 4.8 makes clear, the Print dialog box for the ImageWriter is almost 
identical to that of the Style Writer and provides essentially the same choices. 

However, the Image Writer and other similar dot-matrix printers cannot use the 
new TrueType technology. Fortunately, bitmapped equivalents of the TrueType 
typefaces included with System 7 are automatically installed with the system 
software. 

• 
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Figure 4.8 
The Image Writer 
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If you pur~hase Adobe Type Manager (explained in Chapter 6), you can print 
from PostScript typefaces on an Image Writer. 

The Personal LaserWriter LS 
The Personal LaserWriter LS is a true laser printer, but is sold at an economical 
price because it has fewer capabilities than the more expensive printers in the 
LaserWriter family. It can print graphics and text through the Macintosh's built­
in QuickDraw language, including bitmapped typefaces and graphics (such as 
MacPaint files) . In addition, this printer can use TrueType typefaces, but has no 
support for the PostScript language and offer~ only one of the advanced print­
ing options found in the regular LaserWriter Page Setup dialog box. 

The advanced option it does have is Precision Bitmap Alignment. This feature 
lets you reduce the size of a document by four percent for printing; the reduc­
tion produces a slightly sharper image. 

You can choose portrait or landscape orientation for printing, reduce the printing 
size of a document to either 75 or 50 percent of normal size, and select the follow­
ing paper sizes: US letter, US legal, No. 10 envelope, A4 letter, and B5letter. Like 
A4, B~ is another paper size that is popular outside the United States; its printing 
dimensions are 6.45 by 9.76 inches. 

The Page Setup dialog box for the Personal LaserWriter LS is shown in Figure 4.9. 

The Print dialog box for this printer has the usual support for selecting the 
number of copies wanted and for specifying page numbers for partial printing 
of a document. The dialog box also recognizes special characteristics of the 
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printer: it comes with a multipurpose paper tray, and you can add paper cas­
settes; you identify which paper source you 're using by clicking the appro­
priate button. 

Within MacWrite Pro, this dialog box will display the additional options shown 
in Figure 4 .10. First of all , you can elect to print the pages of a document in 
reverse order (last page first) and to print collated copies. (Four copies of a 
collated 12-page document would be ptoduced by printing one copy of each 
of the 12 pages , then printing a second copy of each of the 12 pages, and so on. 
Without collating, the printer would make four copies of page 1, then four 
copies of page 2; you would have to rearrange the pages manually to organize 
each copy in the proper reading sequence.) 

Personal LoserWriter LS 7.0 

Copies: 11 ;··1 Pages: ® All 0 From: [=:J To: c=J 
Paper Source: 0 Multipurpose Tray ® Poper Cossette 

U Print B 
(Cancel ) 

( Help J 

~ Reuerse Order Printing 
0 Collated copies 

Print: @ All 0 left 0 Right 

0 Print Posted Notes 
~ 
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In Mac Write Pro you can also choose to print only left (or even-numbered) 
pages, or only right (or odd-numbered) pages. You would select this option to 
print a document on both sides of the paper. Of course, you would have to run 
the paper through the printer twice to achieve the desired results-once to 
print each side of the paper. 

A final option lets you choose to print or hide posted notes attached to the 
document. 

As explained earlier in this chapter, the options available in Page Setup and 
Print dialog boxes change for all printers when you use an application offering 
special features that must be supported. 

The LaserWriters with PostScript 

Figure 4. 11 
The LascrWri!cr Page 

Sc1up dialog box 

When you use a printer that supports the PostScript language (such as the 
LaserWriter NT, the LaserWriter NTX, or the older LaserWriter Plus), the Page 
Setup and Print dialog boxes become more complicated, even without consid­
ering PostScript printing options added by sophisticated programs such as 
Aldus PageMaker. This situation exists because the PostScript language creates 
an advanced printing environment with many alternatives. 

Figure 4. 11 shows the Laser Writer Page Setup dialog box as it is displayed 
within most applications. (A few programs delete and/or add options to accom­
modate specialized features.) Some of the items in this dialog box duplicate 
those already mentioned in relation to other printers. 

c:l =os=e=r=UJ=r=lt-e_r _Po•g'-e_s_e~t...;up=-----~=====7=.0== H OK ll 
Paper: ® US l e tte r 0 A4 Letter 

0 US legal 0 B5 Letter 0 I,_Ta_b_l_oi_d ___ ..... _.l ( Cancel ) 

Reduce or rJiiiil% 
Enlarge: ~ 

Orientation 

~~~~ 

Printer Effects: 
181 Font Substitution? 
181 TeHt Smoothing? 
181 Gra phics Smoothing? 
181 Foster Bitmap Printing? 

( Options~ 
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Of course, you have a choice of paper sizes; tabloid is added here (a tabloid 
newspaper page with a printing area of 10.57 by 16.5 inches), which many 
LaserWriter users select when they want to save a PostScript file to disk for 
printing later by a commercial printshop. You can press. the down arrow to the 
right of the word Tabloid to choose from a few additional paper sizes, includ­
ing two sizes of envelopes. 

The Reduce or Enlarge option lets you reduce a document for printing to as 
little as 25 percent of its actual size; just type in a number representing the 
amount of reduction you want. You can also enlarge a document with this 
option to a maximum of 400 percent of its actual size. If you enter a number 
that is out of range, System 7 will automatically change it to the nearest per­
centage that is available. 

The Orientation option works just as it does with other printers; click the 
appropriate button to choose between portrait and landscape modes. 

However, there are four other items in this dialog box that are specific to the 
LaserWriter printer driver and preselected by default. In addition, you can 
press the Options button (under the Cancel button) to bring up several addi­
tional LaserWriter choices. 

When the Font Substitution box is checked, System 7 automatically substitutes 
the Helvetica, Times, and Courier outline typefaces in any document where the 
bitmapped typefaces Geneva, New York, and Monaco have been specified. This 
substitution results in better printing quality, particularly if a bitmapped size 
has been chosen that doesn't actually exist on disk. When a bitmapped font 
must be approximated in another size, the printed result is often lettering with 
jagged edges. On the other hand, outline fonts are created "on the fly " in the 
exact size wanted, producing excellent print quality. (However, the improved 
System 7 printer drivers greatl)' reduce the incidence of jagged lettering.) 

Text Smoothing attempts to reduce the effect of jagged edges generated from 
any bitmapped typeface. 

Grapl'lics Smoothing minimizes jagged edges on graphic images. 

Faster Bitmap Printing speeds up the printing of bitmapped graphic images. 

II 
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Figure 4.12 
The LaserWriter 

Options dialog Box 
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The LaserWriter Options dialog box is displayed in Figure 4. 12. By default, 
none of the items are selected. However, they can be very useful to you in the 
right situation. 

~La::s::e::rw::::rl=;:t e:=-r-D";:p:;=t;:l o';:n~s :;:::.=:::::-~=~===~...;7,;;;.0= [ OK ;:J) 
........................ It, 0 Flip Horizontal [ Cancel ) 

~ I 
I I 

! .. _, _____ ,_J 

0 Flip Uertlcnl · . 

0 I nuert I moge 
0 Precision Bitmap Alignment (4% reduction) 

0 Lorg er Print Areo (Fewer Downloodoble Fonts) 
0 Unlimited Downloodoble Fonts In o Document 

When you use this dialog box, it 's easy to figure out what each item accom­
plishes because the small dog that is shown will illustrate the effect of your 
choices instantly (except for the last item). For example, click the box labeled 
Flip Horizontal, and this trained pooch will immediately turn and face in the 
opposite direction. Select Flip Vertical, and the dog will lie on its back. Pick 
Invert Image, and the white and black areas of the drawing will be reversed. 

Precision Bitmap Alignment reduces the size of a document by 4 percent 
(making for a slightly sharper printout); the dog becomes smaller to demon­
strate the effect. Larger Print Area (Fewer Downloadable Fonts) lets you 
allocate more memory to printing a larger page, at the expense of having to use 
fewer fonts; th is option is mainly of interest to those with a limited amount of 
printer memory and is indicated in the drawing by a slight enlargement of the 
picture area. 

The final option-Unlimited Downloadable Fonts in a Document-lets you use 
as many fonts as you like, by swapping typefaces back and forth to disk during 
printing. This feature certainly sounds desirable, but is not selected by default 
because it slows down the printing process considerably. 

There are three special features in the LaserWriter Print dialog box (see 
Figure 4.13). 



Figure 4. 13 
The LaserWritcr Print 

dialog box 
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Destination: ®Printer 0 PostScript® File 

You can choose to print a cover page either as the first or last page of a docu­
ment. This option is mainly useful if the printer is being used on a network, 
since the cover page provides statistics about the document, including who 
originated it. 

PostScript printers can do more than print a document in black and white. 
They can also reproduce the effect of grays through a pattern of dots (called a 
halftone), if you select the Color/Grayscale option. Of course, this is also the 
option to choose if you want to print a document in color on a color PostScript 
printer. 

At the bottom of the dialog box is a button you can click to change the desti­
nation of a document from the printer to a PostScript file on disk. A PostScript 
file can be used by many commercial printers who can print such files very 
rapidly, at a resolution several times higher than can be produced by the typical 
Laser Writer. 

UsiNG THE LASERWRITER FONT UTILITY 
The LaserWriter Font Utility performs several useful functions , and not aU of 
them are concerned with typefaces. This file is not installed as part of the stan­
dard System 7 installation procedure. It's a stand-alone utility that you can 
store in any convenient location on your hard disk. You'll find it on the Sys­
tem 7 disk named More Tidbits. 

To install the utility, simply insert the disk into a floppy drive, double-click on 
the disk icon to open it, and drag the icon labeled Laser\Vriter Font Utility onto 

Ill 
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Figure 4. 14 
The icon for 

the laser\'i'riter 
Font utili ty 

Figure 4.15 
The Laser\'i'riter Font 

Utility File menu 
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your hard disk (see Figure 4 .14). The util ity will be copied to the location you 
select. 

When you double-click the icon to open the Laser Writer Font Utility, you 'II 
fi rst see a short message stating: "This utility will download, list, or print 
catalogs of fonts on any PostScript imaging device. Other functions are also 
available for devices equipped with hard disks.'' 

Since you will be using System 7 on a Macintosh with a hard disk, those "other 
functions" are available to you. Click OK when you've read the message. 

A short announcement will appear: "Checking characteristics of. . .'' (followed 
by the model name of your Laser Writer printer). 

Next you'll see only a small menu bar containing four menus: Apple, File, Edit, 
and Utilities. Pull down the File menu. You'Ll see the options displayed in Fig­
ure4.15. 

Laser'w'rite-r Font Utility 

Edit Utilities 
Download Fonts... :lCD 
Display Auailable Fonts... :Hll 
Initial ize Printer's Disk ... 

Page Setup ... 
Pr int Font Cat alog ... :HlP 
Print Font Samples ... 

Ouit :~CO 



Figure 4.16 
Primed fom samples 

from a Laser­
Writer 's memory 
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You can use the flrst item on this menu to download fonts to your printer. 
When you issue the Download Fonts . .. command, you 'll bring up a dialog box 
where you select individual font files for transfer to the printer's memory; you 
can change folders and/or drives as required to find the files you want. This 
option does not print the fonts ; it merely makes them available for use by an 
application without a delay for downloading. 

Since most applications these days do a very efficient job of downloading fonts 
automatically, some individual Mac users will see little need for the Download 
Fonts ... command. Furthermore, System 7's background printing feature means 
you can continue to work while fonts are being downloaded to a Laser Writer and a 
file is printing. However, storing fonts in the printer's memory can offer a real 
speed advantage in a busy office where a standard group of typefaces is used 
and many employees are waiting to use one printer; the same fonts can remain 
in the printer all day, with no delays for downloading. 

Other options on this menu let you initialize a hard disk connected to a printer, 
access the standard LaserWriter Page Setup dialog box, and display or print a 
list of fonts currently in the printer's memory. 

In addition, you can select Print Font Samples . .. to print samples of all of the 
fonts in the printer's memory. Figure 4. 16 shows a typical portion of such a 
printout. Of course, if printing from your Mac is handled by a network server, 
you may not be able to use some of these features . 
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Figure 4.17 
Options on 

the Utilities menu 

Figure 4.18 
1l1rning off the 

printer sample page 

The Edit menu for this utility offers only standard Undo, Cut, Copy, Paste, and 
Clear options. 

However, the Utilities menu provides some unusual commands (see Fig-
ure 4 .17). The first option lets you download a PostScript graphics file to the 
printer; this file could be a company logo that workers could add to their docu­
ments throughout the work day without waiting for downloading. Other com­
mands on the Utilities menu remove TrueType fonts from a hard disk attached 
to a printer and initialize (restart) the printer-a quick way of clearing all 
downloaded fonts and graphics from its memory. 

The remaining command on the menu is Start Page Options ... (see Figure 4 .18). 
At last , this option provides a simple way to keep your LaserWriter from print­
ing a sample page every time it's initialized. 

r a File Edit 
Download File ... 
Start Page Options ... 
Remoue TrueType'" ..• 
Restort Printer ... 

Printer stort poge: 

@ On 
QOff 

( Conti J (( OK l 

UsiNG ONE PRINTER WITH DIFFERENT 
== OPERATING SYSTEM VERSIONS 

If your Macintosh shares a printer with one or more other computers running 
under versions of the Mac operating system earlier than System 7, you can be 
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faced with having to reinitialize the printer every time someone wants to print 
a file from a Mac running under a different version. The reason is that the 
printer drivers instaJled with System 7 are not compatible with those instaJled 
with older system software. When the problem occurs, you'll see a warning 
message indicating that the printer must be initialized to print the new file. 

You might say, "Well, obviously the answer is to upgrade all of the Macintoshes 
to System 7 ." However, this solution may not be possible; Macs running under 
earlier versions may have insufficient memory to use System 7 properly, or 
those computers may be using older application software that would not func­
tion properly under System 7. 

Fortunately, there's an easy remedy for the difficulty-provided you're using a 
LaserWriter. Although System 7 printer drivers are not compatible with earlier 
printer drivers, they are compatible with earlier versions of the system soft­
ware . You can install the System 7 printer drivers on computers running under 
6.x system software without affecting the functioning of those computers. 

Follow these steps to replace older printer drivers: 

I. Locate the System 7 installation disk named Printing and insert 
it into a floppy drive of the computer with the old software. 

2. Double-click on the disk icon to open its contents into a win­
dow. The image on your screen will resemble Figure 4.19. 

3. Double-click on the icon named Installer. You'll see the message 
screen in Figure 4.20. 

4. Click OK to continue. Next, the program will display the Easy 
Install dialog box shown in Figure 4. 21. 

S. At this point, you would click Quit if you dido' t use either of 
these two printers or wanted to abort the updating process for 
any other reason. Click Switch Disk if the program is about to 
install the new printer drivers on the wrong hard disk. Other­
wise, click the Install button to proceed with the installation. 

6. You'll see progress reports as the installation proceeds, then a 
message indicating that the updating has been successfully com­
pleted. Click Quit to acknowledge the message and close that 
window, then drag the Printing disk into the Trash to eject it 

Iii 
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Figure 4. 19 
Selecting the printer 

Installer icon 

Figure 4.20 
The installation 
update message 
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from the floppy drive. You can now share the printer between a 
Mac with old system software and another Mac running under 
System 7; since both will be using the same printer drivers , 
there should be no further initialization problems. 
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The Easy Install 
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UsiNG PRINTMONITOR 
You can use PrintMonitor to obtain information about documents currently 
printing, to suspend or cancel printing of any document in the printing queue, 
and to specify an exact time for printing. 

At any time when you've issued a print command-either from the Finder or 
from within an application, PrintMonitor will appear as an item on the Applica­
tion menu. Select the item to display both a small PrintMonitor menu bar and a 
window showing the status of current print jobs. 

Figure 4.22 illustrates this window in use . It shows that the graphics layer of a 
MacDraw Pro document named Concert Poster is being processed for printing, 
while a second document named Brochure Cover is waiting to be printed. The 
name of the printer is shown. If the printer were being used on a network, the 
the name of the user would appear as well , displayed before the word docu­
ment at the bouom of the window. 

• 
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Figure 4.22 
Using the 

PrinL\1onitor utilit y 
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You can cancel the printing of any highlighted document by clicking the Cancel 
Printing button. Click Set Print Time .. . to establish a delayed rime for printing. 
(You might want to use this option to print a lengthy document during lunch· 
time in an office, so as not to tie up the printer during those hours when many 
employees would need it.) 

The PrintMonitor File menu lets you stop or resume printing, as well as open 
and close the window. 

The Preferences ... option on this menu brings up a dialog box that lets you 
display the window continuously during printing, or hide it until you select 
PrintMonitor from the Application menu. (The second option is the default). 

You can also select the method you prefer for PrintMonitor to alert you when 
a job starts that requires manual feeding of paper or when there is a printing 
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error. (One of the most common printing errors occurs when the printer is out 
of paper!) You can choose to receive no warning; in this case, you must pull 
down the Application menu and select PrintMonitor in order to determine that 
there is an alert status. The other two alert options are to display the Print­
Monitor icon in the Application menu position on the menu bar in place of the 
icon for the current application, or to display the icon in a flashing mode. 
(The third option is the default.) 

If you want to establish preferences when no job is being printed, you must 
locate the PrintMonitor icon in the Extensions sub-folder within the System 
folder and then double-click on the icon to display the PrintMonitor menu. 

CAPTURING AND PRINTING SCREEN CONTENTS 

Figure 4.23 
Issuing the Print 

Deskwp . .. command 

You can print the contents of the Finder or an open window, through menu 
options in System 7. You can also capture screens as disk ftles. 

To print the desktop of your Macintosh, pull down the File menu when the 
Finder is active and no windows are open. You 'II see the Print Desktop ... 
option shown in Figure 4.23. When you select this option, the Print dialog 
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box for your primer will be displayed; you can click Print to proceed with 
the printing. 

If a window is selected on the desktop, the Print Desktop ... command changes 
to read Print Window .... The Print Window .. . command prints the em ire 
contents of the window, including any portion not visible on your screen. 

System 7 also lets you capture the current screen to a disk file in the PICT for­
mat. To do this, hold down the 3C and Shift keys while you press the number 3. 
Files captured in this manner will be named Picture I, Picture 2, and so on, in 
sequence, and can be viewed with the Teach Text utility. 

If your screen capturing and printing requirements are more demanding, you 
may be interested in purchasing a utility called Exposure Pro, published by 
Baseline Publishing, Inc. , Memphis, Tennessee. This program has very sophisti­
cated capabilities. In fact, it was used by Apple Computer to capture screens for 
the System 7 manual. 

Exposure Pro is an INIT file that can be popped up on your screen at any time 
' through a hot key combination you select. If you have an extended keyboard, 
you can assign the utility to the F 13 function key, which is already labeled print 
screen. 

Figure 4.24 shows Exposure Pro in action. Its menu and tools have been 
popped up over a MacDraw screen. To move this small window to a more 
convenient location, you drag it by the vertical bar at its left end. 

Once Exposure Pro has been invoked, the screen is frozen. You can then use its 
tools to erase part of the screen, capture only a particular window, add text 
wherever you want it (using any typeface in your system), and save the file to 
disk in any folder you specify, in any of several different graphic formats, and 
with any filename you like. No longer will you have to wonder later which 
screen capture is represented by Picture 18. 

While the screen is still frozen and displayed, you can print it roo- sizing and 
centering the portion captured by using a special print preview window. 



Figure 4.24 
Using Exposure Pro 
to capture a screen 
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Of course, no alterations you make to a frozen screen in any way change the 
original file displayed. 

These are only a few of the main features of Exposure Pro. i\•tany Mac users 
wouldn't be without it. 

• 
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Macintosh 
Operations 

~FEATURING 
• Changing desktop patterns 

• Selecting a startup drive 

• Picking sound, mouse, and 
keyboard options 

• Defining labels for file groups 

• Selecting and mixing colors 

• Using the Map control panel 
• Activating special work aids 
• Using new desktop fonts and icons 

• 
• 

• 

• 

• • 
• 

• 
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System 7 lets you change many aspects of the operation of your Macintosh. In 
addition, you can drastically alter the way your screen looks; the possible changes 
range from creating a custom background pattern for the desktop to displaying me 
and folder names in a different typeface or even creating custom icons. 

UsiNG GENERAL coNTRoLs 
You make a large percentage of operational changes through System 7's various 
control panels. For example, the General Controls control panel is where you 
can change your desktop pattern, the blinking rate of the pointer during text 
insertion, the number of times a menu item blinks when selected (the default is 
three), and the date or time. 

As you discovered in Chapter 2, you can also change the date or time through the 
Alarm Clock accessory. Since you use the same techniques to change the date or 
time in the General Controls control panel, we won't repeat those steps here. 

Changing blinking rates is merely a matter of clicking the appropriate buttons 
shown in Figure 5.1. 

However, changing the desktop pattern requires a bit more explanation. Fig­
ure 5.1 illustrates the creation of a custom pattern by clicking the pointer to 
change an existing pattern. 

Here's the procedure you follow to accomplish this: 

I. Pull down the Apple menu, and select Control Panels. The 
Control Panels window will appear, displaying icons for aH of 
the installed System 7 control panels. 

2. Double-click the General Controls panel to open it. 
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Changing a desktop 
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3. In the upper-left quadrant of th is panel, click either the left­
or right-pointing arrow above the small sample box to cycle 
through the available patterns. Stop when you see the pat­
tern that most closely resembles the custom pattern you have 
in mind. 

4. Click a color (or shade of gray, if you don't have a color 
monitor) that you want to add to the existing pattern, from the 
eight choices displayed horizontally in the color bar along 
the bottom edge of the quadrant. 

5. If you want to add a color that is not displayed in the color bar, 
double-click a color there that you don't intend to use. A color 
wheel will appear, from which you can select another color for 
that position in the color bar. (Options for the color wheel are 
explained in detail later in this chapter.) 

6 . Just above the color bar, to the left of the sample box, is a 
square box where you can see an enlarged view of the pattern 
you've selected. Click any dot in this pattern-editing box to 
change its color (or shade of gray) to the choice you've made in 
the color bar. As you change dots, you can immediately see the 
effect in the display box to the right of the editing box, which 



.... ... 
CHAPTER s 

Introduction 10 Macintosh System 7 

shows a normal-size portion of the pattern, where the individ­
ual dots are no longer discernjble. You can change several dots 
to one new color, in order to achieve a definite change in the 
design , such as the stripe shown in Figure 5.1. On the other 
hand, you can add only a dot or two from a variety of colors, 
thereby mixing colors to achieve the subtle effect of a new hue. 

7. As you work, click a second time on a dot you 've changed to 
restore its previous color. 

8. When you're satisfied with your new pattern, click once in the 
sample box to apply the pattern to the entire background of 
your desktop. 

9. Double-click in the sample box if you want to add the new 
pattern permanently to the choices in the sample box. If you 
don't take this step, this pattern will be lost when you change 
to any other pattern. 

I 0. Click the close box to close the General Controls panel, then 
click the close box of the Control Panels window to close that 
as well. 

SeLECTING A STARTUP DRIVE 
If you have more than one hard drive in your system, use the Startup Disk 
control panel to specify which disk you want your Mac to use in starting 
up-in other words, which one contains your System folder. 

Often a Mac user runs out of storage space on the built-in hard drive and adds 
an external drive, which can be installed by simply plugging it into a SCSI port. 
If this is your situation, you can open the Startup Disk panel and click a disk 
icon, as shown in Figure ; .2, to tell System 7 which disk to access fi rst. 

A problem often arises because manufacturers of these hard drives ship them 
with a System folder already installed. This System folder may even contain a 
different version of the operating system from the one you're using. 

Some applications are also shipped with a System folder. 
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The Startup Disk 
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Regardless of the system software version shipped with an external hard disk 
or with an application, you must have only one copy of one version scored in 
your system. Otherwise, you may experience frequent crashes and erratic 
behavior as you use your Macintosh. Select all of the versions you don't want, 
and drag them into the Trash. 

If you're not sure whether or not you have multiple versions of the operating 
system installed, switch to the Finder, pull down the File menu, and use the 
Find . . . command to search for the word System. 

Some people try this and discover as many as three or four System folders hid­
den away in application folders. These can only be viewed as potential time 
bombs, since the Mac could refer to the wrong folder when least expected. 

SeLECTING souND OPTIONS 
When System 7 displays a special message, it often generates a sound effect to 
attract your attention; this sound is called the alert sound. Through the Sound 
control panel, you can change the defaul t alert sound to any other sound 
instalJed on your computer. Simply click the sound you want in the list box , 
then click the close box to close the panel. Several sounds a_re provided with 
the operating system. When you click a sound , you'll hear a sample so you can 
evaluate it. 
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Figure 5.3 
The Sound 

control panel 
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Figure 5.3 shows the Sound panel for a Mac Ilsi. Since this computer (like the 
Mac LC) has a built-in sound recording capability, it lets you record your own 
alert sound with the microphone provided. Sound recording is explained in 
Chapter 8. 
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If you don't have a Macintosh that can record sound, you won't see the Add ... 
and Remove buttons displayed in Figure 5.3 (which are for adding and deleting 
your own custom sounds); also , your Sound panel will not contain the Micro­
phone section at the bottom of the panel. Your only choices will be to change 
the active alert sound and to adjust the volume of your Mac's speaker by drag­
ging the box on the vertical Speaker Volume bar. 

ifRAINING YOUR MOUSE 
Use the Mouse control panel to adjust the tracking and double-click speeds of 
your mouse. 

As Figure 5.4 illustrates, there are seven speeds you can choose for mouse 
movement (tracking). The slowest speed moves the pointer on the screen in 
exact relationship to the distance you move the mouse on your table or desk. 
Use this speed for drawing with maximum control. 



Figure 5.4 
The Mouse 

control panel 
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You can select any button and try its effect immediately, to see if the setting 
suits your purposes. If you try the Fast button (at the right end of the series of 
buttons), you're likely to think the mouse is completely out of control; it will 
dart across the screen at the slightest provocation. 
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Doubl•-Cliok Spud 

The other option in this panel lets you adjust the speed of double-clicking that 
the system will recognize as an intentional double-click. For example , if you 
frequently load both a file and a program accidentally when all you wanted to 
do was modify the name under an icon, the double-click speed may be too 
slow; click a button further to the right among the three Double-Click Speed 
buttons 'to make System 7 recognize only two clicks in very quick succession 
as an intentional double-click to open a file, folder, or program. 

MAKING KEYBOARD ADJUSTMENTS 
You can make any character on a Macintosh keyboard repeat by simply holding 
down the key. The Keyboard control panel lets you use clearly labeled buttons 
(see Figure 5.5) to adjust the speed with which the repetition takes place, as 
well as the length of the delay before repetition begins. 

If your Macintosh has files installed so you can use more than one keyboard 
layout, you can switch the active layout between those available by clicking an 
item in the list box at the bottom of the Keyboard control panel. In the United 
States, most Macs are sold with only one option: a standard U.S. keyboard. 
Other keyboard layouts are primarily intended to accommodate languages and 
symbols used in countries outside the United States. 

II 
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Figure 5.5 
The Keyboard 
control panel 
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DeFINING GROUPS FOR FILES AND FOLDERS 

Figure 5.6 
The Labels 

control panel 

In Chapter 2, you learned that you can use the Label menu to attach both a 
distinctive color and a text label to files or folders in order to identify them as 
belonging to a particular group or project. The Labels control panel is where 
you can type the name you want associated with each color. 

As Figure 5.6 demonstrates, these names could simply represent the 
departments of an organization. 

To change or edit a name, use standard Macintosh editing techniques to delete 
text you don't want, then type the new or revised label. 

§~~ lubels 
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If you want to use a color not shown next to one of the text labels , click a dis­
played label color to bring up the color wheel; you can then choose any color 
or shade you want as a replacement. (For details, see the following section that 
describes the Color control panel .) 

Click the close box to save your changes and close the panel. 

SELECTING AND BLENDING COLORS 

Figure 5.7 
Selecting a window 

color in the Color 
comrol panel 

Use the Color control panel to change the standard color (or shade of gray) 
used by the system for highlighting. Many Mac users with color monitors 
choose yellow for this color, since the effect is similar to what you see on paper 
when you highlight important points with a yellow marker pen. 

When you press the down arrow in the Highlight Color area of this control 
panel, you'll see a dropdown list of colors from which you can select. If you 
don't like any of the colors offered, you can pick the last item on the list­
Other .. .. This choice brings up the color wheel, where you can choose any 
other color (unless, of course, your system limits the number of colors that 
can be used). 

As shown in Figure 5. 7, this panel also lets you select a window color; in this 
case, you must use one of colors listed. 
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Figure 5.8 
Selecting a highlight 

color with 
the color wheel 
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When you select a window color, the effect is subtle but attractive. The color 
you choose is added to the title bar of each window and to the scroll boxes and 
arrows. By the way, gold creates a particularly pleasing effect- an understated 
aura of opulence. 

You 've seen previous references to the color wheel, which can be used to pick 
a specific color for a highlight, a label , or a desktop pattern. This wheel lets 
you "mix your own colors" by clicking up or down arrows to make precise 
changes "by the numbers" for hue, color saturation, brightness, and the 
percentages of red, green, and blue to be used. (See Figure 5.8.) 

If these numbers confuse you, you can also drag or click the pointer on the 
wheel itself to mix the exact color you want. (In this case, the scroll bar on the 
right adjusts brightness.) 

Regardless of the method you choose, the result will be displayed in the sample 
box at the upper-right corner of the color wheel dialog box. 

If your monitor is set to display only four colors or grays, the color wheel will 
identify color values by letters of the alphabet. 

Choose o highlight color: 
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When you've obtained the color you want , click OK to close the color wheel 
dialog box and put your selection into effect. 

MAKING THE MAP UTILITY WORK FOR YOU 

Figure 5.9 
Initial settings for the 

~lap control panel 

Many individuals look at the Map control panel and cannot imagine how it can 
help them-unless they're world travelers. Actually, you can set up this utility 
so it will help you even if you never leave home. 

As shown in Figure 5.9, the Map panel is initially set for zero latitude and 
longitude, and a zero time zone. A small , many-pointed star marks this spot, 
which is off the coast of Africa and at the intersection of the Greenwich 
prime meridian and the equator. 

Loti tude 

Longitude 

Time Zone 

ml 0 

You can type the name of any major city in the text box, then click the Find 
button, to have the map shift (if necessary) to pinpoint the location of your 
chosen city on the map, with its latitude, longitude, time zone, and the mileage 
from the zero starting point. You ' II hear your alert sound if the city you select 
is not in the utili ty's current database. 

m 
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But how often do you want to know how far a place is from a spot in the ocean 
west of Africa? Even if you live in Africa, this particular location is probably far 
from your area of interest. 

However, you can easily change the starting point for the Map panel's calcu­
lations. Try this: 

I. Type the name Los Angeles in the text box. 

2. Click the Find button (Shortcut: press Return). The map will 
shift, and Los Angeles will be pinpointed, with its latitude, 
longitude, relative time zone, and the mileage between Los 
Angeles and that spot in the ocean west of Africa. 

3. Now click the Set button. This action changes the center of the 
calculations from the intersection of the Greenwich prime 
meridian and the equator to the city of Los Angeles. Note the 
time in Los Angeles. 

4. Delete the name Los Angeles, type New York, and click Find 
(or press Return). You'll discover that New York is 2,450 miles 
from Los Angeles and that it is three hours later in New York 
than in Los Angeles. The exact time is shown (provided the 
clock in your Macintosh is set accurately). Now this is infor­
mation that you could find useful! 

5. Delete the name New York, type San Francisco, and click Find 
(or press Return). San Francisco is shown as 350 miles from Los 
Angeles, and the time there is the same as in Los Angeles. 

If you know the latitude and longitude of any city not listed, you can type 
those coordinates and the name of the city, then click the Add City button to 
add it to the list. The Map urility will then calculate automatically both the 
mileage from your starting location and the local time. 

Select the N box to designate north latitude and the E box for east longitude. 
When the boxes are not selected, south latitude and west longitude are implied. 

You can also remove a city no longer needed; just find it, then click the Remove 
City button. 



Customizing Macintosh Operations • 
UsiNG EASY AccEss To ovERCOME SPECIAL 
== PROBLEMS 

The Easy Access control panel provides features that can overcome special 
problems associated with operating a Macintosh in the normal fashion. 

Sticky Keys 

Figure 5. 10 
The Easy Access 

control panel 

For example, if you're unable (or don't want to) use two hands on your Mac­
intosh keyboard, you might ordinarily have problems executing commands 
requiring you to hold down a modifier key (Command, Option, Shift, or 
Control) while pressing another key. With Easy Access activated, it's possible 
to press the two keys separately. The feature is called Sticky Keys. 

As Figure 5.10 indicates, you click the On button for Sticky Keys to activate 
the option. You can choose to hear a warning beep when the modifier key is 
pressed, or to turn off this sound alert. With Sticky Keys activated, whenever 
you press a modifier key followed by an additional key, your Mac will react as 
if the two keys had been pressed simuJ[aneously. 
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Slow Keys 
Slow Keys helps eliminate accidental keystrokes, which can be a problem for 
people who have difficulty controiJing precise finger movements. With Slow 
Keys active, you must press a key continuously for a short period of time 
before the keystroke is accepted. A series of buttons in the Slow Keys section 
of the Easy Access control panel let you adjust the length of the keystroke 
acceptance delay. 

You can turn an accompanying key-click sound on and off; when this sound is 
on, you 'll hear one click when you press a key and a second click when the 
character you selected appears on the screen. 

You can turn off the entire Slow Keys feature from the keyboard by holding 
down the Return key for eight seconds. You 'II hear a brief sound reminder after 
four seconds have passed and another sound to indicate that the full eight 
seconds have elapsed and the feature has been terminated. 

Mouse Keys 
In addition to Sticky Keys and Slow Keys , the Easy Access panel offers Mouse 
Keys-numeric keypad substitutes for the use of a mouse. 

You can turn on !\•louse Keys either from the control panel or the keyboard. On 
the keyboard, press ac-Shift-Ciear to activate the feature. Press Clear to turn off 
Mouse Keys. (The Clear key is in the upper-left corner of the numeric keypad.) 

With the Mouse Keys feature active, you can press the 5 key as a substitute for 
clicking or double-clicking the mouse button. Press the 7 key to move the 
pointer diagonally upward and to the left, the 8 key to move straight up, and 
the 9 key to move diagonally upward and to the right. Press the 4 key to move 
straight left and the 6 key to move straight right. Press the 1 key to move the 
pointer diagonally down and to the left, the 2 key to move straight down, and 
the 3 key to move diagonally down and to the right. 

Note that these keys form a square, with 5 at the center. 

Press the 0 (zero) key to lock the mouse button down for dragging, then press 5 
or the decimal-point key to unlock the mouse button again. 
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You can click buttons in the control panel to adjust how quickly the pointer 
starts moving after you press a key. You can also adjust the speed with which 
the pointer moves. 

Unless you turn audio feedback off in the Easy Access control panel, you 'll hear 
a special confirmation sound when you start or stop Mouse Keys from the 
keyboard. 

Some artists use Mouse Keys for minute adjustments on drawings, since you 
can tap keys to move the pointer one pixel at a time. 

GeTTING A CLOSER LOOK WITH CLOSEVIEW 
If you have trouble reading small print or if you'd like to magnify some portion 
of your screen for delicate work, the Close View control panel can be very 
handy. With it, you can enlarge any part of a screen up to 16 times its normal 
size. This enlargement is for viewing purposes only and does not affect your 
actual files in any way. System 7's screen capture capability won't even save the 
enlarged view as a PICT file; if you capture a screen when Close View is in use, 
the result will be the normal view of the same screen without magnification. 

System 7 does not install this control panel automatically. You will find the icon 
for Close View (pictured in Figure 5.11} on the Install3 installation disk if you 
have the standard eight-disk installation kit; otherwise, you may find the icon 
on a disk with another name. To install the utility, drag the icon into your Sys­
tem folder and restart your Macintosh. 

Once Close View is installed, you can turn it on or off either from the control 
panel or-if the Keyboard Shortcuts option is on-by pressing Option-81:-0 (the 
letter 0 on your keyboard, not the zero). In fact, you can control all of Close­
View's features from the keyboard if you wish-with the exception of clicking 
a button to make the magnified area display reverse video (white lettering on a 
black background). The CloseView control panel is shown in Figure 5.12. 

When Close View is activated, you'U see a rectangle with a heavy black border, 
as illustrated in Figure 5.13. As you move the pointer, the rectangle will move 
with it. When you have selected an area you want to enlarge, press Option-se-X; 
the selected area will then fill the screen. To increase the amount of magnifica­
tion, press Option-81:-Up Arrow. To decrease the amount of magnification, press 
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Figure 5. 11 
The Close View icon 

Figure 5. 12 
The Close View 

control panel 
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Option-ac-Down Arrow. To turn magnification off, press Option-ac-X again. To 
turn Close View off and remove the black rectangle from the screen, press 
Option-ac-0 again. 

Incidentally, the reason the Close View control panel includes an option for 
turning keyboard shortcuts off is that you might have an application that uses 
the shortcut key combinations for its own purposes. Turning off the shortcuts 
will eliminate this conflict. You could still use Close View in this application by 
controlling the utility entirely through the Apple menu, although the procedure 
would be awkward and time consuming. 
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CHANGING THE VIEW OF YOUR DESKTOP 
The Views control panel provides several functions that affect the way your 
screen looks and the information it displays. 

First of all, you can choose to have icons arranged in straight lines on the 
desktop and within folders, aligned with an invisible grid. As an alternative, 
you can have the icons staggered; this choice can keep long names under icons 
from overlapping each other and becoming unreadable. Furthermore, you can 
elect to have all icons snap to that invisible grid, even after you move them. 

Most Mac users who use icon views of their files prefer the default "straight 
grid'' option shown in Figure 5. 14; these users then make manual adjustments 
to change the positioning of selected icons. However, if automatic tidiness is of 
more interest to you than controlling the exact arrangement of icons, you'll 
like the Staggered grid and Always snap to grid options. 
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Figure 5. 14 
The Views 

control panel 
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To put changes into effect that you make in the Icon Views section of the Views 
control panel, you must pull down the Special menu and issue the Clean Up 
command. 

List views are very popular because you can see detailed information about 
your folders and files , including the date and time of the last revision, the type 
of item (such as folder, application program, or Microsoft Word document), 
and even the size of each folder (although this last option slows down the 
rewriting of your screen slightly, as System 7 calculates these sizes). In the List 
Views section of the panel, you can click boxes to display or omit eight such 
categories of information; remember, however, if you display too many 
columns of data, you 'II have to scroll a window to see them all. 

In addition, you can specify three different icon sizes for list views; the smalJest 
icon is certainly the most practical, unless you believe that identifying the icons 
by their designs is of great importance. 

Ulews 

Fontforvttvs: ._1 _G_en_e_u_n ____ ,..~ IIIEJ 

One of the most interesting Views options appears at the top of the panel and 
is labeled simply Font for views. Here is where you can actually change the 
typeface and font size used on your desktop. The default font is 9-poim 
Geneva. You can press on the down arrow to the right of the word Geneva to 



Figure 5. 15 
A :\-lac desktop with 

text in standard 
Geneva 9-pt. font 
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display the complete list of typefaces installed on your system. Highlight a new 
selection if you like, then use the little dropdown menu on the far right if you 
want to change the size of the typeface as well. Don't forget that larger sizes 
may leave insufficient space to display text without overlapping. 

Any change in font you make here will not affect the appearance of menus nor 
the typefaces used in any of your applications. 

Figure 5.15 shows a Macintosh desktop with text displayed in the standard 
9-point Geneva font. In contrast, Figure 5.16 shows the same desktop with a 
custom desktop pattern and the text displayed in Franklin Gothic Demi-Bold, 
one of many classic typefaces sold by Adobe and other vendors. 

Certainly, the appearance of the two desktops is quite different. 
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Figure 5.16 
The same desktop 

with a custom pattern 
and a different 

typeface 
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Feel free to experiment with changing the font for your desktop, using any 
typeface installed on your Mac that you believe to be both attractive and easy 
to read. You can easily switch to a different selection at any time. 

CREATING ICONS WITH CUSTOM DESIGNS 
If you'd like to use folder icons that don't resemble miniature file folders , you 
can do so. Under System 7, you can replace folder or document icons with any 
graphic image that can be copied to the clipboard. 



Figure 5. 17 
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There are some exceptions. You can' t change locked icons or icons that are parr 
of the system software, such as control panels. 

This is the procedure to follow in customizing an icon: 

I. Select the graphic image you want to use and copy it to the 
clipboard. 

2. Select the icon you want to change, then pull down the File 
menu and select the Get Info command, as shown in Fig-
ure ; .17. The Info window that opens will display a copy of 
the icon in its upper left corner. 

3. Click to select the copy of the icon in the window, then pull 
down the Edit menu and issue the Paste command (Shortcut: 
press 31:-V), as shown in Figure 5. 18. 

4. The image from the clipboard will replace the original icon 
both in the Info window and on the desktop, as shown in 
Figure 5.19. 
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Figure 5. 18 
Pasting new graphic 

image into 
icon's info window 

Figure 5.19 
Icon is displayed with 

new graphic image 
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If you don't consider yourself an artist, of course you can apply appropriate 
clip art files to your icons. For example, all folders containing reports on oil 
exploration could display a miniature oil well. 

Later chapters provide additional examples of how you can customize your 
Macintosh to make your work easier and more efficient. 
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Handling 
Typefaces 
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• Typeface categories 
• Adding styles for effect 
• Using the installed typefaces 
• How typefaces are stored 
• Solving System 7 typeface problems 
• Installing and using hidden typefaces 
• Helpful accessories 
• Selecting the right typefaces 
• Converting between typeface formats 
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System 7lets you use typefaces produced in four different formats-provided 
you have a printer capable of supporting all of these options (see Chapter 4). First 
of all, every Mac printer can print bitmapped fonts; these files consist of characters 
composed of fixed patterns of dots and were the only typeface choice for early 
users of the Macintosh. You can also use typefaces in the Adobe Type 1 and Type 3 
outline formats, intended primarily for use with PostScript printers. In addition, 
you can use the new 'frueType outlines with any PostScript printer, as well as with 
printers either designed specifically to print 'frueType fonts or supplied with spe­
cial TrueType drivers by their manufacturers. 

When you install System 7, certain typefaces are placed in your System folder 
automatically. Surprisingly enough, additional typefaces and even small draw­
ings are stored on the installation disks; you can use these on any Mac printer, 
but you must install them yourself. This chapter will tell you what these extra 
items are, how to find them, and how to install them. 

We'Ll also cover some tips about typography, how to access special characters, 
and the features of third-party accessories that can make your work with type­
faces much easier. 

LEARNING TYPEFACE CATEGORIES 
When you work with typefaces under System 7, it helps to know the meaning 
of a few terms used universally in the printing and publishing industries. 

Some readers will be surprised to learn that the two words typeface and font 
are not synonyms. Here are some basic definitions: 

A typeface family is a group of letters, numbers, and symbols that are all part of 
a single design concept. A style is a variation within the design such as boldface 
or italics. A typeface is a complete set of characters with one of those styles, 
regardless of the size involved. 



Figure 6. 1 
A Timrs True Type 

typeface in 
1hrcc poim sizes 
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Afont is one typeface in a single size. Type is usually measured in points; a 
point is approximately 1/72 of a inch. 

Therefore, Helvetica is a typeface family. Helvetica Bold is a typeface. Helvetica 
10-point Bold is a font. 

Figure 6.1 shows the Times TrueType plain (often called Roman) typeface 
installed by System 7, in 12-, 24-, and 48-point sizes. Each size is considered a 
different font. 

This is 12 point 

This is 24 point 

This is 48 point 
All type is either monospaced (also called fi xed-pitch) or proportional. Most 
typewriters use monospaced typefaces. ln a monospaced typeface, each charac­
ter occupies exactly the same amount of space on paper. Although a capital M is 
much wider than a lowercase i, each is allocated an area of equal dimensions. 

Most type that you see in newspapers, magazines, and books-even on package 
labels-is proportional. In a proportional typeface, each character occupies 
only as much space as it needs. This type you're reading now was set in a pro­
portional typeface. 

In Figure 6.2 , the top typeface is the TrueType Courier included with System 7. 
Courier was originally designed for use on typewriters and has been popular 
for over a quarter of a century. It is monos paced and used on computers mainly 
by those who want to give the impression that a document was created as a 
personal effort on a typewriter. 

liD 
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Figure 6.2 
Monos1>aced vs. 

proportional type 
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However, proportional typefaces are being accepted more and more as a stan­
dard for business correspondence. The bottom typeface in Figure 6.2 is the 
proportional TrueType Times. 

As you can see, there's a lot of wasted space surrounding the letter i and the 
two l's in the word Willow as seen in Courier. These spaces make it difficult for 
the eye to recognize that these spread-out characters constitute a single word. 

On the other hand, in the Times version of Willow, one character seems to lead 
smoothly to the next and the word is perceived as a unit. 

Willow 
Willow 

You can divide typeface designs into four major categories. A serif typeface 
consists of characters with small nubs or projections at the ends of its strokes 
or curves. These subtle additions help the eye identify the individual charac­
ters. Therefore, books and long articles are usually printed in a serif typeface. 
(This book is no exception.) Most serif typefaces give a traditional appearance 
to text. 

A sans-serif typeface has clean, modern lines, with no serifs. (Sans is a French 
word meaning without.) You'll often find sans-serif typefaces used for headings 
in reports or in short blocks of copy in magazine advertisements. Some book 
designers do use sans-serif typefaces for the text of entire volumes. 

A decorative typeface is usually created to attract attention-or, at l~ast, to 
produce a specific impression on a reader. These typefaces are frequently intri­
cate and therefore hard to read; they're great in headings and rarely used for 
large blocks of text. 

A script typeface resembles handwriting. Like the decorative category, it's used 
to produce a specific impression (such as in a heading or note where a casual 



Figure 6.3 
Examples of typeface 

categories 
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touch is wanted) and becomes difficult to read when used in more than a few 
consecutive lines. 

Figure 6.3 shows examples of these design categories and presents Times as a 
typical serif typeface. This design was introduced in 1931 in the London Times 
newspaper. The typeface is still widely used because it's very readable, slightly 
condensed (consisting of narrow characters, which save space), and incon­
spicuous enough never to detract from the message it conveys. 

This is Times, a serif typeface 
Helvetica, a sans-serif typeface 

{T\etropolitai] is a De,orative Typefa\e 

H~-~¥(~~~ 

Helvetica is the world's most popular sans-serif typeface. Its strokes are all of 
an even width, the characters have conventional shapes for easy recognition, 
and it has a relatively large x-heigbt so that it reads well in small sizes. (X-height 
refers to the median height of lowercase characters in a typeface and derives its 
name from the height of the lowercase x, often used for measuring this attribute.) 

Metropolitan is a decorative typeface reflecting the Art Nouveau school of 
design that flourished between 1890 and 1910. Decorative designs often 
include some elements of both serif and sans-serif typefaces. For example, 
Metropolitan has tiny serifs at the ends of strokes; however, those strokes 
vary in width and combine with distinctive flourishes to set the design apart. 
(This typeface is available from Dubi-Ciick Software.) 

Mistral is a popular script typeface sold by several vendors. Some script type­
faces actually mirror the personal handwriting of their designers. One of the 
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challenges in designing a script typeface is to make lowercase characters seem 
to connect naturally when joined in any normal combination. 

AooiNG A STYLE FOR A DIFFERENT EFFECT 

Figure 6.4 

You can change the appearance of many typefaces by adding a style attribute 
such as bold or italic. Figure 6.4 shows a typical Style menu within a Mac 
application. (This menu is for the Claris Resolve spreadsheet program.) 

Figure 6.5 displays the result of adding various style attributes to the Bernhard 
Modern type family (available in TrueType format from Bitstream). This family 
is distinguished by elegantly formed characters and a small x-height that draws 
attention to the long upward strokes (called ascenders). The overall effect is an 
air of sophistication. 

Bernhard is sold as a family , including individually designed typefaces for 
plain, bold, italic, and bold italic. 
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If all candles be out, all cats be black. 
If all candles be out, all cats be blacl~. 
I/ all candles be out, all cats be black. 
If <OJ.JlJl candllies Jbe 01ULty a.ll ca.ts Jbe Jbliadkc 
l/ ®gg @tmooJll@f2 fk ®oofl:~; cm!I!J rccmfl:12 

~ lbl@lrclk<> 

The first line in Figure 6.5 is Bernhard Modern Roman (the plain version of this 
family). The second line is boldface. 

The third line is italic. Look at the letters a, e, and u in this typeface. They 
don't look the same as those characters in the Bernhard Roman or bold type­
faces. These characters demonstrate that the actual design of the Bernhard italic 
style is unique; it was not created by merely slanting the plain characters. (A 
typeface created by slanting the plain characters is called an oblique version; 
the Helvetica typeface family includes an oblique rather than an italic style.) 

The fourth line is the Bernhard Roman typeface, with the !\'lac's outline style 
added. The fifth line combines Bernhard's own italic with the Mac's shadow style. 

As Figure 6.5 illustrates, a single typeface family offers considerable variety 
when these styles are applied. 

But what happens when you use the Style menu to add boldface or italic to a type 
design that comes only in a plain version? Often the results can be disappointing. 

Figure 6.6 shows a Mac Write Pro screen displaying various styles created from 
Bitstream's Exotic 350 Demi-Bold typeface. (Exotic is the Bitstream version of a 
typeface called Peignot.) You can see that the boldface version is darker than 
the plain version, and that the italic is really an oblique, created by slanting the 
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Figure 6.6 

Exotic 350 Demi-Bold 
with St}·les added 
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plain characters. We've added outline and shadow styles too, which have been 
displayed satisfactorily. 

Now let's print that file and see what happens. Figure 6.7 exhibits the result. 
The outline and shadow styles have printed correctly; the plain, bold, and italic 
versions all look exactly the same. 

Tl-ti s is PlAiN TEXT 

Tl-lis is BoldfAcE 
Tl-lis is lrALic 

Thoss ~ss ©l\,m[o~[E 

1Tlkl~S5 ~ss ~lkl~©\W 

What has happened is that tbe System 7 style commands for bold and italic 
were ignored. This situation occurred because of deliberate programming 
decisions made by the typeface designers. 

Why would designers want to do this? In this case, they didn't want the 
appearance of the typeface corrupted. There is no italic (or oblique) version of 
Exotic 350 (or Peignot), and the designers don't want you to try to create one! 



Figure 6.7 
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commands were 
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TJ.tis is PlAiN TEXT 
TJ.tis is BoldfAcE 

TJ.tis is ITAlic 
lf~ ·o§ o§ Ollnr[o~ !E 

1ffWij$ ij$ ~rw~~(O)~ 

Another reason why many typefaces will not accept Mac style commands is 
that rhe vendors of the typefaces want you to purchase separate plain, bold, 
italic , and bold italic variations; they don't want you to be able to approximate 
the effect of style variations through System 7. 

UsiNG THE TYPEFACES INSTALLED WITH SYSTEM 1 
As mentioned at the beginning of this chapter, not all typefaces furnished with 
System 7 are installed by the installation program. Later in this chapter we'll 
introduce you to those hidden goodies. 

Right now let's investigate how to use the typefaces that are installed automati­
cally. Figure 6.8 displays samples of each family. 

When System 7 was first shipped, the installation program automatically 
installed e\'ery typeface shown in Figure 6.8, in both bitmapped and TrueType 
versions- with the sole exception of Palatino. Palatino was supplied only in a 
bitmapped version, but a TrueType version may have been added by the time 
you read this. 

The presence of those bitmapped fonts means that, if you have a dot-matrix 
primer such as an Image Writer-designed before TrueType was invemed­
you can still use every typeface shown in Figure 6.8. 

liD 
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Figure 6.8 
Therypcface Chicago is used for Apple menus. 

fam.ili~ instalkd with 
Systc:mi Cour ier is used most on typewriters. 

Geneva is used for the Apple desktop. 

Helvetica is the most popular sans-serif typeface. 

Monaco i s the I mageWriter draft mode font. 

New York substitutes for Times on ImageWriters. 

Palatine was provided in bitmapped sizes, not TrueType. 

cr 'I' ~ ~ o A. we <1> rn n 8 (Symbol) 

Times is the most popular serif typeface. 

If you have a PostScript printer or some other printer that can use True Type 
typefaces, you'll have the advantage of being able to specify any font you want 
and have it built for you instantly from an outline-a file that contains a mathe­
matical representation of the family's characteristics; the outline will provide 
sharp screen and printer versions of the typeface in whatever size you want 
(although some applications don't support extremely large sizes). 

You'll probably achieve good output results in a variety of sizes even with the 
bitmapped Palatino-thanks to the greatly improved printer drivers Apple has 
created for System 7. Before these drivers were devised, bitmapped characters 
became very jagged when printed in a size not stored on the computer. Now 
the new drivers do an admirable job of extrapolating between existing sizes and 
smoothing out rough edges. 

Furthermore, you 'II be happy to know that you can apply any of the style 
options to any of these installed typefaces and see the styles appear on paper 
as specified. 
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There is one potential problem for LaserWriter users. As discussed in Chapter 4, 
the LaserWriter Page Setup dialog box includes an option called Font Substitu­
tion; this option is selected by default . When Font Substitution is activated, the 
Monaco typeface will be replaced automatically by Courier. The New York 
typeface will be replaced by Times. The Geneva typeface will be replaced by 
Helvetica. Before the development of the new printer drivers and the TrueType 
outline versions of all of the typefaces , this substitution was a blessing in dis­
guise; it kept Laser Writer users from selecting bitmapped typefaces in non­
existent sizes instead of PostScript typefaces and thereby producing printouts 
full of uneven, poorly formed fonts . However, now that quality is not such an 
issue, if you want to use Monaco, Geneva, or New York-you must still pull 
down the File menu, select Page Setup .. . and deselect Font Substitution before 
you print. Otherwise, you will see the substitutes for those typefaces. 

Selecting the Right Typeface for the job 
Among the typefaces installed with System 7, Helvetica, Palatino, and Times 
are all excellent choices for the body copy of a document. In larger sizes and 
with bold added, these families are also appropriate for headings of aU kinds. 
Palatino is not used as frequently as the other two choices, so it could impart 
a freshness to your work. However, Palatino has wider characters than the 
others. If you really need to cram a lot of words into a small space, Helvetica or 
Times will do the job better. (As an alternative, you can purchase many highly 
condensed typefaces that are specifically designed for space-saving.) 

Chicago is a good choice if you need a headline that will be noticed. Pick 
Monaco to make a casual impression. Geneva and New York are really much 
like Helvetica and Times, except with wider characters and a larger x-heighr. 
The Symbol typeface contains useful Greek and mathematical symbols. 

Understanding Typeface Storage 
Under previous versions of the Mac operating system, you had to use the Font/ 
DA Mover to install typefaces. This utility placed the typefaces inside the Sys­
tem file, within the System folder. Through the Font/DA Mover, you could see a 
list of the fonts and desk accessories in the System file, but you certainly could 
not open up the file itself to take a look at it. 
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Figure 6.9 
An open Srstem file 
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That's all changed now. The installation program automatically installs certain 
fonts and some alert sounds in the System file. You can install others without a 
special utility. 

If you want to remove fonts, you can actually double-dick on the System file 
itself to open it into a window. Scroll the window as you would any other to 
examine the contents, then remove any item by simply dragging it out of both 
the System file and the System folder. 

Figure 6.9 shows a portion of a System file displaying typefaces installed by the 
installation program. 

Bitmap and outline typefaces have always been installed in files called suit­
cases, designated by an icon that resembles a small suitcase. An example is 
shown in Figure 6.10. 

$il.)if,IJ, . ~"C; Twmoo-l'iJ2 
0 H1mt Sin ~ 

() Chi .. IO 44K font 
CJ CoLrltr 581< font 
0 Co~ritr' 9 5< font I. 
() Co~rltr (bold) 561< font 

I 
() Co~rltr 10 5< font I 
(] ColJ"itr 12 61< font ~ ~ 
() Co~rltr 14 61< font 

I 
i 

() co ... ltr IS 71( font I 
(] CourWr 24 IOK font i 
0 Otntn :54K font ! 
() Otntn (lt•lio) 9 3K fl)llt jt 
(] O•ntn 10 3k font !. 
(] Otntn 14 4K font ' 
() OtMv.IB :II( font 
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Cl Otntn 24 9K font 

Cl H•lvttioa 60K font 
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CJ H•lvttlc. 24 I ISIC font 
(] Monaco 491( font • fl ;. II 
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m 
Helvetica 

Before the advent of System 7, you had to rely on the Font/DA Mover to place 
items in a suitcase or remove them. Now, if you want to open a suitcase and 
install only a few of its typefaces into the System file, all you have to do is 
double·click on the suitcase itself. The suitcase will open, revealing its con­
tents; you can drag the typefaces you want into the System folder, from where 
they will be placed automatically in the System file. 

If you want to install all of the contents of a suitcase, drag the suitcase itself 
into the System folder. It will be opened automatically, the typefaces will 
be stored in the System file, and then the suitcase itself will disappear into 
midair-no longer needed. 

Figure 6.11 shows the contents of the TrueType Helvetica suitcase, in a list 
view. Figure 6.12 demonstrates how you can change to a view with icons by 
selecting by Icon from the View menu. 

Figure 6.13 illustrates the difference between a TrueType outline typeface and 
a bitmapped typeface. The outline typeface displays three ~s in varying sizes, 
indicating that type can be generated in any size wanted. On the other hand, 
New York 18 displays only one letter A and is identified by size under the icon; 
this is a bitmapped typeface in an 18-point size. · 

If you want to know what a particular typeface looks like without installing it 
or using it in a document, double-click on the typeface file ; it will open and 
display a handy sample. If the file is a True Type outline, you'll see samples of 
the typeface in three different sizes: 9-point, 12-point, and 18-point, as shown 
in Figure 6.14. If the file is a bitmapped typeface, you'll see one sample, in the 
size represented by the bitmap, as shown in Figure 6.15. 

lED 
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Each TrueType typeface requires only one file; the same outline file is used to 
generate both the screen image and the output for the printer. 

Typeface files in an Adobe PostScript format are composed of two elements: 
bitmapped typefaces in a suitcase, used to generate the screen display, and 
separate outline printer files from which the printed typefaces are created. 
You can double-click on an Adobe bitmapped screen typeface file and see a 
sample, as just described. lf you double-click on an Adobe printer typeface, 
instead of a sample you 'll see the message shown in Figure 6. 16. 

ll<~l u e. tir.n 

r~~~o~~~~~·~~:~~;~·;~;·;;~~.~~~~·;;~:·;-··1 
i gymnu tsl 1 
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, .. ·12 point .. _ ............ - ........................ _ .. , ........ - ........... - ...... - ..• 
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1
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! I 
t I 
L ... R,_,.,,,,, _,,_,,_,,_,,,,, .. ,,_ ,,_ ,._ , .. ,H.,_,,_,,_,,, .......... - ............ _,,_,,_J 
, ... 18 point ---·---·--·--·-··--·-·--...... ,_ ...... _ .......... ,_, __ 1 
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! I 
' I l I 
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To un this font, dr• g it into your Systom filt . 
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New Vorl< l ll 
r· S•mp lt -·-·-·-··-·-.. ·--.. ·-·-... -................................. . 

I How 
! razorback- jumping 
I frogs can level six 
I piqued gymnasts! 

I • 
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To us• this font, dr•g it into your Systtm fiJ. . 

Syst em eHtenslon 

This fil e adds functionality to your 
Macintosh. To add this file's functionality 
to your Macintosh, place the file In the 
EHtenslons folder and then restart the 
computer. 

n OK )J 

JL 
SoLVING A FEW SYSTEM 1 TYPEFACE PROBLEMS 

Many well-known applications have been based on support for PostScript 
typefaces. Consequently, TrueType typefaces did not work properly with some 
of these programs when this chapter was written. Check with the publisher of 
any software about which you have a question, to see if they currently support 
TrueType. 
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Here are a few examples: 

Aldus Fontographer 3.2 and earlier versions are not compatible with TrueType. 
Select only PostScript typefaces when using this program. 

Aldus PageMaker 4. 0 1 prints all TrueType fonts in the Courier typeface if you 
print using the default Aldus driver. However, you can prim documents cor­
rectly that contain True Type typefaces by using ~he Apple printer driver 
instead. To select the Apple driver, simply hold down the Option key as you 
select the Print ... command from within PageMaker. 

Microsoft Word 4.0 will not print TrueType typefaces correctly on the Personal 
Laser Writer LS printer unless the Background Printing option in the Chooser is 
turned on (see Chapter 4). 

Adobe TypeAiign 1.0.2 and earlier versions are not compatible with TrueType. 

Adobe Illustrator is not compatible with TrueType. 

SmartArt 1.0 is not compatible with TrueType. 

Broderbund TypeStyler 1.5.2 and earlier versions are not compatible with 
TrueType. 

Letraset FontStudio 1.0 is not compatible with TrueType. 

Some applications don't display TrueType typefaces properly in sizes above 
120-pt. However, the typefaces will probably print correctly. 

You can continue to use PostScript typefaces under System 7 with all of the 
product versions mentioned here as having difficulties with TrueType. 

Font/DA Juggler and Master Juggler are not compatible with System 7. 

If you were using the Suitcase II urility (described in detail later in this chapter) 
to manage your typefaces prior to installing System 7, you may find that suit­
cases will not open when you double-click on them. In fact, you'll see the 
warning message displayed in Figure 6.17, stating that the suitcase "could not 
be opened, because it is damaged." 
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Figure 6.17 
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The font suitcase "Adobe Garamond Screen 
Fonts" could not be opened, because It Is 
damaged. 

n OK » 

More than likely, the suitcase is not damaged at all. You probably used the 
Suitcase II utility called Font & Sound Valet co compress the contems of your 
suitcases so they would take up less space on your hard disk. Compressed suit­
cases work fine with Suitcase II (even under System 7) but are not recognized as 
being in operational condition to be opened. You can continue to use the type­
faces if you access them through Suitcase II. 

You must have Suitcase II version 1.2 .1 0 or later to have full compatibility with 
System 7. Version 1.2 of Font & Sound Valet (and earlier versions) do not work 
properly with System 7, either for compressing or decompressing typefaces. 

If you want to open compressed suitcases for some reason, you have two 
choices: either decompress them under a previous version of the system soft­
ware or copy the uncompressed suitcases again from their original floppy 
disks to your hard disk. 

If you try to use any version of Font/DA Mover under System 7, you '11 see the 
warning message displayed in Figure 6.18. The new font-handling features of 
System 7 make the utility obsolete. 

Some applications are not compatible with certain features of typefaces. For 
example, as illustrated by the message reproduced in Figure 6. 19, Ventura Pub­
lisher 3.0 on the Macintosh won't work with typefaces containing more than 
30 characters in their names. 
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This uersion of Font/OR Mouer is out of 
date. To install a font, drag It to the 
System file. To put a desk occessory in 
the Apple menu, drag It to the Apple Menu 
Items fol der. 

n OK n 

Kerning is an important aspect of typography and can make the typefaces in 
your documents look much more professional. The absence of kerning is par­
ticularly noticeable in headings. (Kerning is the adjusting of the space between 
individual characters so they fit together better. In Figure 6.20, the word WAVE 
is displayed at the top without kerning; note the awkward spaces between 
characters. Underneath, the word is shown properly kerned.) Typefaces are 
usually accompanied by kerning pairs-lists of paired characters to be placed 
closer together by programs supporting automatic kerning. (Without automatic 
kerning, you must laboriously adjust kerning manually; even this procedure is 
not supported in some applications.) Ventura Publisher does support automatic 
kerning, but-as indicated by the warning message shown in Figure 6.21-it 
can handle only 1,024 kerning pairs for a single typeface style. This means that 
you '11 have to kern the remaining pairs yourself when they appear in your 
Ventura documents. 

·u• (hnpter Frome Tags Graphics 

IJen tunt Publi sher 

The font "HI Franklin Gothic 
HeauyObllque" hos more than 30 
choracters in Its name. The font 
cannot be Included In the System 
fonts width table. 

n OK tt] 
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Figure 6.20 
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WAVE 
WAVE 

!IJJ Chapter Frome Tag~ Graphic~ 

Llentura Publisher 

The font "Fronkfurtloser" hos more 
thon I 024 kerning pairs for a style. 
The remainder will not be included 
In the System fonts width table. 

t OK ~J) 

You may not be aware that there is a great difference between the number of 
characters provided in different typefaces. Although extra characters do not 
appear on your keyboard, they can be easily accessed by pressing the correct 
key combinations. For example, you can enter many of these hidden characters 
by pressing a keyboard character in combination with the Option, 00, Control 
and/or Shift keys. (However, there is no Control key on a Mac Plus keyboard.) 
Obviously, there are two problems connected with these bonus characters: 
how do you find out which characters have been added to a particular typeface 
and how do you know which keys to press to use those characters? 

Sometimes vendors provide a chart in their typeface packages that answers 
these questions. Otherwise (or if you've misplaced the chart) you can find the 
characters by using Key Caps; you can pop up this System 7 desk accessory 
within any application by merely selecting Key Caps from the Apple menu . 

When you activate Key Caps, you'll see the reproduction of a keyboard dis­
played in Figure 6.22. You can pull down the Key Caps menu and select any 
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installed typeface in your system for examination. The characters shown on the 
keys will change to reflect both the appearance of the chosen typeface and the 
individual characters obtained by pressing each key. When you press a modifier 
key, such as the Option key, the display will change (if additional characters are 
available) to show the key assignments for characters you can access in combi­
nation with that modifier key. In addition, you can test the available characters 
and the effect of the typeface design by typing and observing the results in the 
Key Caps text box. 

The Key Caps desk accessory is insta11ed automatically with System 7. 

A much better desk accessory for evaluating typefaces has been created by 
Dubi-Click Software. It's called BigCaps, and the company includes it free of 
charge with the purchase of any of its inexpensive typefaces. We'll explain just 
a few of the many BigCaps features. First of all, you can make the accessory 
fill your entire screen and then display a typeface in any point size you wish , 
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Figure 6.23 
Dubi-Ciick's 8igCap~ 

desk accessory 
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giving you the opportunity to analyze character attributes in detail. You can see 
the typeface with any style applied. BigCaps contains a large text box where 
you can type several lines of text and observe the effect; when you first open 
BigCaps, the words Sample Text appear in this box by default, so you can 
quickly select several typefaces in succession from the dropdown font menu 
and note their appearance without typing anything. 

Figure 6.23 shows Monotype's Gill Sans Extra Bold typeface displayed in 
BigCaps; the Option key has been pressed, showing part of the rich variety of 
extra characters included with each Monotype typeface for the Macintosh. (You 
can obtain still more characters by using other modifier key combinations.) 

• li rue Edit 

UsiNG SYSTEM 7'S HIDDEN TYPEFACES 
You can use six additional typefaces under System 7 that are not installed auto­
matically but are included on your installation disks. Five of these typefaces 
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provide pleasing alternatives to the installed type families. The sixth is actually 
a collection of small drawings you access by pressing designated keys on your 
keyboard. The typeface consisting of drawings is named Cairo and is provided 
only in an 18-point size. All of the typefaces carry the names of cities and will 
be "old friends" to long-time Mac users, since these typefaces were acquired by 
Apple years ago and supplied to early purchasers of the computers. The type­
faces included in addition to Cairo are Athens, london, Los Angeles, San Fran­
cisco, and Venice. 

Although these typefaces are provided only in a bitmapped format and only 
in a single size and style (except for los Angeles, which has two sizes), you 
can probably use them on your printer in any size or style you like with good 
results, thanks to the improved System 7 printer drivers. 

If you have the standard eight-disk System 7 kit, you will find all of the extra 
typefaces on the disk labeled Fonts. To install them, just drag their suitcases 
into your System folder. 

Figure 6.24 shows the result when you open the Fonts disk, then the San Fran­
cisco suitcase, then the San Francisco 18 font, djsplaying a sample. This "fun" 
typeface resembles nothing more than a ransom note, b4t its effect can be 
delightful under the right circumstances. 

All of the extra typefaces are shown in Figure 6.25, except for Cairo. You'll find 
every drawing included in Cairo displayed in Figures 6.26 and 6.27 (as seen in 
BigCaps), with each drawing shown in the key position used to access it. Fig­
ure 6.27 shows the drawings available when the Shift key is pressed in combina­
tion with a character key. 

You can tell very quickly what bitmapped sizes are available for any installed 
typeface by selecting the typeface and then pulling down the Size menu in any 
application. Figure 6.28 shows the Size menu for Mac Write Pro, with the 
True Type Helvetica typeface selected. Since this is nor a bitmapped typeface, 
all of Mac Write Pro 's normal size alternatives are displayed with an outline type 
style applied, meaning tbat all oftbese styles are available. In fact, since 
TrueType typefaces will be generated in any size you want, all of the point sizes 
not shown are available too. 

1111 
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In contrast, Figure 6.29 shows the Size menu when the Athens bitmapped type­
face is selected. Since this typeface is supplied only in 18-point, only that size is 
displayed with the outline style applied. 

Figure 6.30 demonstrates how well Athens reproduces on a LaserWriter printer 
when sizes and styles are selected that are not provided on disk. The last line 
shows 72-point Adobe PostScript Helvetica, which displays characters that are 
more smoothly formed . However, by seeing this sample reduced on a page in a 
computer book, you may be unable to detect any difference in quality without 
a magnifying glass. 
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This is R thens reduced to 12 pl., not available on disk. 

This is Rthens in its actual bitmapped 18 pt. 

This is R thens in 36 pt. 
This is Athens with bold added. 
This is Rthens in italics. 
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72 pt. Athens 
72 pt. Helv. 

UsiNG HELPFUL TYPEFACE ACCESSORIES 
TrueType typefaces require no accompanying bitmapped typeface to function; 
the same outline file is used to produce both the font display on-screen and the 
printout. System 7 produces on-screen and printed versions of bitmapped type­
faces from the same bitmap file. However, typefaces in Adobe Type 1 or Type 3 
PostScript formats require bitmapped versions to create the screen display and 
generate the printed result from a separate outline file. Of course, the outline 
delivers excellent results on paper because-like TrueType-it creates exact 
sizes for printing on demand. 

When you use a PostScript typeface in a size not available in the bitmapped 
versions, the result on the screen can be terrible. Figure 6.31 shows the same 
72-pr. Adobe Helvetica font seen in Figure 6.30 as displayed on the screen. 
(Of course, TrueType Helvetica would have been displayed correctly.) 
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Figure 6.31 
A PostScript typeface 
displayed in a size for 
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72 pt. Helv. 
You can eliminate this PostScript display problem by purchasing the Adobe 
Type Manager utility. If you use only TrueType typefaces, you won't need it. 

Adobe Type Manager requires that at least one bitmapped screen font be avail­
able for each PostScript typeface you use. However, the utility uses this bitmap 
only for internal bookkeeping. It generates all of the screen displays from the 
same outline file used for printing, in any size you specify. 

Adobe Type Manager is an INIT file. You install it by dragging it into the System 
folder and restarting your Macintosh. Thereafter, it functions automatically. 
However, it performs its magic only on Adobe Type 1 typefaces. These are the 
PostScript typeface versions originally created and sold only by Adobe, using 
secret "hints" to generate characters with subtle detail features. Typeface ven­
dors who didn't have access to the Type 1 secrets created what are known as 
Type 3 typefaces, trying to adjust their designs to compensate for the missing 
"hints" by using some other method of fine-tuning. 

In the interests of standardization, Adobe eventually released the Type 1 speci­
fications to the industry at large. However, some typefaces are still sold only in 
the Type 3 format-either because th<:; vendors decided it would be too expen­
sive to convert their libraries or because their typefaces contained certain 
unusual features they could not duplicate in the Type 1 format. (To see an 
example of a Type 3 font with unusual features , look ahead at the words 
Child's Play in Figure 6.36.) 

When you use Adobe Type Manager, you can still use Adobe Type 3 fonts, 
TrueType fonts, and bitmapped fonts as well. They will simply be unaffected 
by the operation of Adobe Type Manager. 

Adobe Type Manager has another tremendous advantage if your printer is a 
dot-matrix model such as an Image Writer. The utility lets you print quality 



Figure 6.32 
Opening a suitcase 
with the Suitcase II 

desk accessory 

Handling Typefaces 

reproductions of any typeface in the Adobe Type 1 PostScript format , in 
addition to your usual bitmap fonts . 

If you install a large quantity of typefaces, sounds, and desk accessories, your 
System file can become enormous. Each of those items adds to the memory 
requirements of your system software and slows down the operation of your 
Macintosh slightly. In addition, your Font menu can swell to unmanageable 
proportions, requiring that you scroll the menu almost every time you want to 

select a typeface. This particular problem is further complicated by the fact that 
the bold, italic, and bold italic variations of many typefaces are displayed as 
separate options. 

Two utilities can make sense out of this chaos. One is Suitcase II, mentioned 
earlier, from Fifth Generation Systems. When you use this desk accessory, you 
can store typefaces and desk accessories anywhere you like on your hard disk­
outside the System folder and without removing them from their suitcases. 
Then you can use the simple dialog box shown in Figure 6.32 to open only 
those suitcases you need for your current work. Just as easily, you can close 
suitcases that you won't be using again for a while. 
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Figure 6.33 
Examining a typeface 
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For example, you might use some special typefaces in producing a meeting 
announcement. After the job was finished , with a few keystrokes you could 
return all of those typefaces to their suitcases. 

Suitcase II has many other features . One of its accessories can resolve conflicts 
between typefaces using the same system identification numbers. Another can 
compress the contents of your suitcases so they occupy less disk space. One 
Suitcase II dialog box quickly shows you the appearance of any installed type­
face in any available size and style (see Figure 6.33). You can display all of the 
names on your Font menu in their actual typefaces; this feature is demonstrated 
in Figure 6.34. 

Use Suitcase II in combination with a second utility-Adobe Type Reunion­
and you can unite all of the style variations of a typeface normally displayed 
in different locations on a Font menu so they will appear as a single listing, as 
shown in Figure 6.35. Then, if you want to see the actual appearance of the 
typefaces, hold down the Shift key as you select the Font menu, and you can 
still obtain the kind of display that is shown in Figure 6.34. 
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SeLECTING THE RIGHT TYPEFAces 
You add typefaces to your system from many sources, in any of the formats sup­
ported by System 7: bitmapped, Adobe Type 1, Adobe Type 3, and 'frueType. 
Several typeface vendors now offer their em ire libraries in the TrueType format. 
Other vendors (as of rhe time when this book was written) have ignored True Type 
entirely. 

Fortunately, as you'll discover later in this chapter, you can now obtain pro­
grams that can convert typefaces automatically between the Adobe formats and 
TrueType. In other words, you can buy a typeface in any of these three formats 
and use it in the other formats as well. 

Among sources for typefaces, both Adobe and the Font Company sell large 
libraries in the Type 1 format. Vendors supplying libraries in both Adobe and 
TrueType formats include Agfa Compugraphic, Bitstream, Casady & Greene, 
Dubi-Ciick, Image Club, Kingsley/ATF, Linotype, and Monotype. 

Good typefaces are plentiful. Many of them are very inexpensive. These circum­
stances mean that you should be able to find exactly the typeface you want to 
convey a particular mood or message. Figure 6.36 shows a nursery school sign 
composed of typefaces that certainly fit the subject. The words Child's Play are 
in a novelty typeface with the interesting name Rock A Billy. The remainder of 
the sign appears in an informal typeface called Comic Book. Both typefaces are 
available from Image Club. 

Figure 6.37 shows an announcement for a nightclub. Five different typefaces 
are used. Because of the nature of the announcement, the use of each typeface 
is warranted. However, it must be emphasized that most documents look better 
if they use no more than two separate typeface families-one for the text and 
possibly a second family for beadings. Resist the temptation to show off all of 
your typefaces at the same time! The result can be simply dreadful. 

In Figure 6.37, the name of the club is displayed in a typeface named Paladin. 
The second line and the days of the week were printed with a typeface family 
called simply Sans Serif. The other typefaces used were Meath, Gatsby Demi, 
and Abilene- all from Casady & Greene and available in an inexpensive 
TrueType Starter Set package. 
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CoNVERTING TYPEFACES 
If you have PostScript typefaces in the Adobe Type 3. format and you'd like to 
convert them to the Adobe Type 1 format for use with Adobe Type Manager, 
you can do it. You can also convert all of your Type 1 or Type 3 typefaces to 
True Type, to standardize on that technology. If you use high-end desktop 
publishing programs and perhaps work with professional service bureaus that 
require that documents for publication be submitted to them in PostScript 
format ohly, you can even convert your TrueType typefaces to Adobe Type 1. 

All of these options and additional typeface editing and design features are 
provided by four conversion programs: FontMonger (from Ares Software 
Corporation), Altys Corporation's Metamorphosis, Letraset's FontStudio, 
and Image Club's Evolution. 
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Before the i~troduction of System 7, you could use the Apple File Exchange 
utility on a Macintosh to transfer files to and from computers running under 
the MS-DOS operating system. Under System 7, you can still use Apple File 
Exchange for this purpose and even enhance its capabilities, as will be 
explained later in this chapter. 

In addition, through the purchase of special software and hardware, it has long 
been possible to form networks between Macintoshes and also with computers 
using MS-DOS, UNIX, and other operating systems. Of course, you still have 
these networking options under System 7. 

However, System 7 adds two exciting new capabilities. One is the new publish/ 
subscribe technology, which lets you create a document in one application and 
then use all or part of the document in other documents-even in other appli­
cations and on other computers; the copies will be updated automatically every 
time the original document is changed. You'lllearn about this feature here in 
Chapter 7 too. 

The other major innovation is built-in networking. You can use the familiar 
AppleTalk cables (recently called LocalT.1lk cables) and System 7 to transform 
two or more Macintoshes into your own personal network. You don't need to 

buy anything extra. 

IIETWORKING THROUGH SYSTEM 7 
If you use a printer in the Laser Writer family (except the Personal Laser Writer LS), 
the printer is connected to your Mac through LocaJTalk cables. This means you 
already have a good start toward operating a network. 

If you connect a second Mac to the same Laser Writer, both computers can easily 
share the printer; the operating system's PrintMonitor utility can manage the 
printing jobs so that each document is printed in its turn, from either source. 
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For years, thousands of small offices have been sharing a LaserWriter in this 
manner between several Macintoshes. 

With only this hardware and cabling setup, and with System 7 running on all of 
the Macintoshes, you can now share files and folders between the Macs, com­
plete with security precautions and password protection. You can even operate 
an application from your Macintosh that is stored on another computer. You 
can have your own LocalTalk network! 

Add special AppleShare software, and you can dedicate one Mac as a file 
server-a repository for files to be used by the operators of dozens or even 
hundreds of other Macintoshes. Other AppleTalk options are the installation 
of Ethernet or Token Ring networks, both of which require that a special 
expansion card be inserted into each Macintosh on the network. 

AppleShare, Ethernet, and Token Ring networks have sophisticated features 
that are usually managed by a network administrator or a company technical 
support staff. However, it's easy to connect to these networks and use them, 
following the same procedures outlined in this chapter for connecting to a 
Local Talk network. The difference is that if you have a Laser Writer hooked up 
to two or more Macs through LocalTalk connectors , you can follow the steps 
presented here to set up and administer your own network right now. You 
won't need a dedicated file server either. 

Setting Up Your Mac for a Network 

Figure 7. 1 
The control panels 

used for networking 

You set up your Macintosh to connect to any kind of AppleTalk network 
through the Control Panels window. Three control panels are involved with 
networking: Sharing Setup, Users & Groups, and File Sharing Monitor. The 
icons for these control panels are shown in Figure 7 .1. 
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FilE' Sharing Monitor 
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Figure 7.2 
The Sharing Setup 

control panel 
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Follow these steps to prepare your Mac for network use: 

I . Pull down the Apple menu, and select Control Panels. The 
Control Panels window will appear. 

2. Double-click the icon named Sharing Setup, to open this control 
panel, shown in Figure 7.2. 
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3. In the Network Identity section of the control panel, type an 
owner name in the Owner Name text box. Normally, since 
you're the individual entering this information, you will be 
considered the "owner" of your computer. 

4. Press the Tab key to move down to the Owner Password text 
box. Enter any password you like here, up to eight characters in 
length . This box is case-sensitive; in other words, capital letters 
are considered different from lowercase characters. Select a 
password that will be easy for you to remember and hard for 
others to guess. 

5. Press Tab to move down to the Macintosh Name text box. As 
soon as you leave the Owner Password text box, the characters 
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in the password you typed will be replaced by bullets- as a 
security measure. 

6. Enter any name you like for the Macintosh Name. It doesn 't 
need be the model name of your Macintosh. In a small office, 
where all of the Macintoshes may be sitting next to each other 
in one area, you and other users may find it convenient to use 
the model name-provided each of the Macintoshes is a differ­
ent model and that all of the users know which is which. As an 
alternative, you could use simple designations such as Left­
Hand, Middle, and Right-Hand. In a large company, you might 
want to enter the name of a department, such as Personnel. 

7. To permit others to share files on your computer, click the Start 
button in the File Sharing section of the control panel. (How­
ever, you can access files on other network computers without 
allowing others to access your fil es.) Before this feature will 
function , you'll have to designate at least one file to be shared. 
(Sharing will be discussed shortly.) 

8. If you want to permit Program Linking, click the Start button in 
the Program Linking section of the control panel. This feature 
allows the operators of other Macintoshes to establish links 
between their applications and applications you've designated 
for sharing on your Mac. (Applications that support linking 
display one or more link commands on their Edit menu .) 

9. Click the close box when you're finished. The control panel 
will close. 

I 0. Now double-click the Users & Groups control panel to open it 
and take a look at what's inside (Figure 7.3). You'll see that it 
contains icons representing just two users. One icon has your 
name on it and is surrounded by a heavy black line; this icon 
represents the owner of the computer. The only other access 
permitted to your computer at this point is for Guest . By 
default, this icon is set up so that anyone can log onto your 
computer as Guest and work with designated files (unless 
you've established passwords for certain files through applica­
tions installed on your Mac). You'lllearn how to change this 
default later on. 
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I I . Click the Users & Groups close box to close the control panel, 
then click the close box on the Control Panels window to close 
that window as well. You've completed the basic sharing setup. 

Sharing a Folder 
Although System 7 refers to File Sharing, you don't actually designate individ­
ual files fo~ sharing; you designate folders, hard disks (but not floppy disks), or 
CD-ROM drives. You can specify up to ten such items at a time; this limitation 
may sound restrictive; however, each of these items can contain as many fold­
ers and files as you like. Obviously, if your Mac has only one hard disk and 
you've chosen that disk for sharing, you've granted access to your entire system. 

To designate a folder for sharing, you use the Sharing . . . command on the File 
menu. This command appears only when the Finder is active, rather than an 
application. 

This is the procedure required to share a folder: 

I . Select the folder you want to share. 

2. Pull down the File menu, and select the Sharing . .. command 
(as shown in Figure 7 .4). This command will be dimmed if you 
haven't selected a folder to share. 
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3. If you haven't activated File Sharing in the Sharing Setup con­
trol panel, you 'll see the message displayed in Figure 7.5, indi­
cating that you must first turn on File Sharing. If File Sharing 
has been activated, you'll see a sharing window for the item 
selected. Click the box labeled Share this item and its contents 
(see Figure 7.6). In this window, you can choose exactly the 
kind of access you w~nt to allow for specific individuals and 
groups; we'll discuss these options later. 

Folders con not be shored until file shoring 
is turned on using the Shoring Setup 
control panel. Do you wont the control 
panel opened now? 

( Cancel J {LE J 
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Figure 7.6 
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4. Click the close box. You'll see the dialog box shown in Fig­
ure 7. 7, displaying a message asking if you want to "Save 
changes to access privileges" for the folder. 

5. Ctick Save. The dialog box will disappear. Users of other com­
puters on the network will now be able to share the contents of 
this folder with you. 

Using Files on Other Network Macintoshes 
Use this routine to access files on other Macintoshes on your network: 

I. Pull down the Apple menu, and select the Chooser. The 
Chooser will open. You'll see the icons you've used for select­
ing a printer. You'll also see the AppleShare icon highlighted in 
Figure 7 .8. If your Macintosh is connected to an Ethernet or 
Token rung network, you'll see an additional icon representing 
that network. 

2. Click the icon for the network you wish to access. 

3. A list of available file servers (often merely other Macs) wiU 
appear in the box to the right. On a large network with assigned 
zones, you may first have to select the zone in which the file 
server or computer is located that you wish ro access. If you're 
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using a LocaiTalk network (with no dedicated file server), each 
of the other Macintoshes on the network will appear as file 
servers, under the names their "owners" have assigned to 
them. (Of course, if a computer has been turned off, its name 
will not be on the list.) Click the name representing the Mac 
with the files you want to access. You'll see the dialog box 
shown in Figure 7 .9. 

4. In this dialog box, the default display will indicate that you 
want to log onto the other computer as a Registered User, rather 

7.0 



C H A PT ER 7 

Figure 7.9 
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than as a Guest If you wish to log on as registered user, or if the 
other computer is set up not to allow guests , you can use your 
name as displayed, but you must click the Password box and 
enter a password. This may not be the password you 've estab­
lished to protect your control of your own computer; you may 
have to use a different password, assigned to you by the owner 
of the other computer. 

5. If you wish to change the password you use to access the other 
computer, click the Set Password button. You'll then be asked 
to type your current password, followed by the new password 
you want to use. You can change your password only if the 
owner of the host computer has set up file sharing so this action 
is permitted. (To the right of the Password text box, you'll see a 
few words in parentheses , indicating the type of encoding the 
host computer is using for passwords.) 

6. If you wish to log on as a guest, select Guest (if the host permits 
this choice). 

7. Click OK to obtain access. You'll see a dialog box listing the 
items that have been approved for sharing, as shown in 
Figure 7. 10. 
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8. Highlight the items you want to use. You can select more than 
one item by holding down the Shift key as you click items. If 
you click the box to the right of an item, that item will automat­
ically be available to you the next time you start your computer 
(unless the host computer is not turned on, of course). 

9. Click OK when you've completed your selections. Those selec­
tions will now appear as icons underneath the disk icons on 
your computer (as shown in Figure 7.11 ). 

I 0. Double-click one of these icons to open the item. A window 
will open, displaying the contents of the shared folder, disk, 
or CD-ROM drive (see Figure 7 .12). You can use these files 
and folders just as if they were stored on your own computer 
(within the guidelines established by their owner). You can also 
drag icons onto your own desktop to copy them to your hard 
disk, unless the owner has prohibited this action. In the next 
section, you'lllearn the ways in which an owner can control 
access. 

II . When you've finished using a shared item, you can break the 
connection by simply dragging the icon for the item into 
the Trash. This action will in no way affect the integrity of the 
item itself, which will still be stored safely on the computer that 
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originated it. However, if you drag a file within a shared item into 
the Trash, you 'll delete the file on the host computer! 
So be careful! 

System 7 Jets you share items from several different computers simultaneously, 
if you so desire. Simply repeat the steps just described for each computer or file 
server that is storing files you want to use. 
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Controlling Shared Access 
You can use the Users & Groups control panel to allocate specific file access 
privileges to individual members or groups on your network. 

You'll remember that this control panel contains, by defaul~, only an icon for 
the owner of the computer and another for Guest, who could be anyone on the 
network. Obviously, with the default settings, the only security you have is 
the fact that an uninvited guest cannot share or open any folders, hard disks, or 
CD-ROM drives that you haven't designated for sharing. In addition, any guest 
would need a special password to open individual files you've protected 
through security features provided within particular programs. 

As a first step toward increased security, you might want to add a password to 
the Guest icon. At the least this would mean that all guests would need to know 
that one password to gain access to your Macin~osh. However, you can add a 
new user icon for each individual on the network to whom you wish to grant 
access to your files. You can establish separate p~sswords for each, and you can 
decide which access privileges each will have. Furthermore, you can create 
groups with certain privileges and decide to which of your groups an individ­
ual will belong. Finally, you can restrict the kind of access each individual user 
or group will have to each shared item. 

Establishing Users and Groups 
Here's how to establish new users and groups: 

I . Pull down the Apple menu, and select Control Panels. 

2. Double-click the Users & Groups control panel to open it. Two 
new commands will now appear on the Finder's File menu: 
New User and New Group. 

3. To create another user icon, pull down the File menu and select 
New User (Shortcut: press :le-N). An icon will appear, bearing 
the temporary name New User. Like the other user icons, it will 
be in the form of a stylized human head in profile. 

4. Type the user name you wish to assign to this icon, and click 
outside the icon to complete the entry. 
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5. To create a group, pull down the File menu and select New 
Group. An icon will appear, bearing the temporary name 
New Group. It will be in the form of two stylized human heads 
in profile. 

6. Type the name you wish to assign to the group, and click out­
side the icon to complete the entry. Figure 7.13 shows the Users 
& Groups control panel for a Macintosh owned by Fred. The 
panel displays an icon for Fred, the usual Guest icon (which 
cannot be deleted or duplicated), and three other individual­
user icons. In addition, the panel contains group icons for the 
Accounting and Sales departments . 

0 
Frtd <Guts I> Ptl• Arthur 

~ ~ 
Solos 

7. To make a user a member of a group, drag the user's icon to 
the group icon. A copy of the user icon will be stored inside the 
group icon, in the form of a photo hanging on a wall. Fig-
ure 7.14 shows what you mjght see if you double-clicked on 
the Sales group icon to open it; the icons indicate that Arthur 
and Pete have been made part of the group. 

8. When you double-click on a user icon, you'll see specific 
restrictions and privileges pertaining to that user, which you 
can change at any time as the owner of your computer. As Fig­
ure 7. 15 shows, you can permit the user to connect to your 
computer or withhold that privilege. Also, you can assign or 
change the password you want used, allow the user to change 
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the password too if you wish, and allow the user to link to 
shared programs {discussed later in this chapter). Your owner's 
icon displays one option not provided for other user icons: 
Allow user to see entire disk; if this option plus Allow user to 
connect are both selected (as they are by default), you as the 
owner can access the entire contents of your own Macintosh 
system from any other computer in the network. Figure 7. 16 
shows a typical log-on situation for a registered user, who, 
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unlike a default guest, must provide an assigned password 
(represented by bullets after it 's entered). 

9. Click the close box on a user icon when you've completed 
making changes. You 'II then see a message asking if you want 
to save those changes; click the Save button. 

I 0. Click the close box on the Users & Groups control panel, then 
the close box on the Control Panels windows, to close those 
items too and return to the desktop. 

If you will frequently be making changes relating to user access on your net­
work, you may want to create an alias for the Users & Groups control panel 
and drag the alias into the Apple Menu Items subfolder within the System 
folder. Then you can access that control panel very conveniently at any time 
from anywhere in your Macintosh system. 

Also for convenience, you may want to create an alias of the File Sharing Con­
trol Panel, described in the following section. 
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Monitoring Shared Usage 

If you can't remember which of the folders on your Macintosh you decided to 
share on the network, you can refresh your memory quickly by glancing at 
folder icons; the icons for shared folders have a different appearance. In Fig­
ure 7.17, the icon on the left represents a folder designated for sharing; the icon on 
the right is for a folder that is not shared. On a shared folder, the top of the tab will 
display a wide black horizontal line; this line indicates that you own the folder. (See 
Changing Ownership of Shared Items later in this chapter.) If a folder is both desig­
nated for sharing and is currently being shared by the operators of one or more 
other computers on the network, the center of the folder will display the two 
heads in profile also associated with group icons (see Figure 7 .18). 
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You can use the control panel called File Sharing Monitor for a running sum­
mary of sharing information. As shown in Figure 7.19, this control panel sup­
plies you with a list of items currently shared and with a list of connected 
users. In addition, a horizontal bar at the bouom of the panel shows the rela­
tive sharing activity in progress, ranging from Idle to Busy. The bar often 
reports an Idle status; others on the network may be connected to your 
computer-meaning that icons for some of your shared files are now sitting on 
their desktops-but they may not be using those files at the time you open the 
File Sharing Monitor. 
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There are several ways in which security problems can be handled quickly and 
efficiently. For example, if you notice that a user is engaging in questionable 
activities while sharing your files, you can terminate that user's privileges 
instantly. As Figure 7.20 demonstrates , you can simply highlight the user's 
name and click the Disconnect button. 

You can follow up this action by opening the icon for the user and changing the 
privileges to deny aU access. If a user tries to log onto your computer as a guest 
when no guests are permitted, or tries to log on with an unapproved user 
name, that individual will see the warning message shown in Figure 7 .21. 
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Remember that you can be very specific in your access authorizations for any 
shared item (folder, hard disk, or CD-ROM drive). Through the Sharing dialog 
box for the item, you can assign different privileges to various individual users 
and groups. 

Figure 7.22 shows how a payroll folder can be set up to allow company depart­
ments to turn in their payroll information to the accounting department 
(headed by Cindy} without being able to see or read the payroll files deposited 
in the same folder by other departments. The secret is simply to click the 
appropriate boxes to prevent users from seeingfiles. (They must be able to see 
folders or else they wouldn't see the payroll folder itself.) With this access 
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configuration, they can select the payroll folder from the accounting depart­
ment's computer, then drag the file or folder containing their own payroll 
information into the shared folder at any time. However, if they choose to open 
that folder, they will see only an apparently empty folder containing "0 items" 
(Figure 7.23), despite the fact that the folder may actually contain dozens or 
even hundreds of payroll files. 

Of course, if you're the owner of the folder in question, you would reserve full 
access privileges for yourself. 

System 7 provides an even better way of allowing users only to insert files or 
folders into a folder. You set up what is known as a drop folder , a folder estab­
lished only to serve as a depository for information. Create a folder within a 
shared folder. Deny users the right to see files and folders. In this case, the 
folder will appear inside the shared folder with a strap around it and an arrow 
above it, indicating that it must be used as a drop folder (see Figure 7 .24). 
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If a user has been granted the right to see folders, but has not been permitted 
any personal access to a particular folder within a shared folder (not even to 
use it as a drop folder), the user wiU see the restricted folder encircled with a 
strap but not surmounted by an arrow. 

Please note: If you deny users the privilege of making changes to a particular 
folder, you have not protected the files within the folder. Although users could 
not then change the folder itself, they could-for example-drag any or all of 
the files out of the folder and into the Trash, thereby destroying them on the 
host computer as well. They might take this action in all innocence, believing 
that they were merely terminating a network connection. 

So-to protect files from this disaster, click the bottom option box in the dialog 
box for the item: Can't be moved, renamed or deleted. 

If you don't want a user to make changes in ftles either (to be allowed only to 
read them), click the Make Cbanges box to deselect it. 

Changing Ownership of Shared Items 
Normally, you will see all shared folders on your own computer displayed with 
a black edge running along the top of the tab for the folder (see Figure 7. 17); as 
previously mentioned, this symbol indicates that you own the folder. However, 
you can give up the ownership of any folder or disk in your system. You might 
want to do this because someone else has assumed responsibility for the materi­
als in the folder or on the disk, or because you have unused storage space that 
you want to make available on a secure basis to others on the network. 
Here's how to relinquish ownership of an item: 

I . Select the shared folder or disk. 

2. Pull down the File menu, and select Sharing .... 
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3. From the Owner pop-up menu, select the name of an individual 
user or group. If you want everyone on the network to share 
ownership jointly, select <Any User>. 

4. Click the close box, then click Save in the dialog box that 
appears asking if you want to save changes. A second dialog box 
will appear, asking you to confirm that you want to change 
ownership. 

5. Click OK to complete the change of ownership. The dialog box 
will close. If the item is a folder, the black edge will disappear 
from the top of its tab. 

Caution! Don't forget to remove your personal files from a folder before turn­
ing over ownership to someone else who will have the authority to limit future 
access. 

Handling Shutdown on a Network 
You're probably accustomed to shutting down your Macintosh when you've 
finished working on it for the day, giving no thought to the procedure other 
than making sure that you've saved any files you've been using. In fact, you 
don't have to give much thought to saving files either-because most appli­
cations will warn you if you haven't saved changes. 

Other considerations enter the picture when you're connected to a network­
particularly a LocalTalk network running under System 7 with no dedicated file 
server. This configuration means, as you've learned already, that any Macintosh 
on the network can serve as a file server; all that is required is for the operator 
of the computer to decide to share some of its files. 

If you suddenly decide to shut down, without notice, a Mac containing shared 
ftles, or if you experience a power failure, the other computers on the network will 
display a warning that this server has shut down. Of course, this warning will 
provide little comfort to a network member who was using one of the fLies, which 
will no longer be available unless it was copied to the guest's hard disk. Changes 
already saved will be stored on the owner's hard disk, but changes not saved will 
be lost. 

Of course, you want to avoid sudden, unannounced shutdowns. 
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If you decide to terminate a user's access privileges while the user is connected 
to your computer (a decision probably made only because of a discovered secu­
rity problem), that user will see a special message saying that "The file server's 
connection has unexpectedly closed down." Note that the message does not 
say that the server has shut down; it says a connection has closed down. Fig­
ure 7.25 shows this message displayed on the screen of a Mac that was using 
the Payroll file on the Accounting file server (or computer) when access privi­
leges were revoked. 

If you decide to shut down your Macintosh while others are using your files, 
you will see the message shown in Figure 7.26, reminding you that file sharing 
is in progress and asking you how much warning you want to provide before 
the shutdown takes place. The default period of time allowed before shutdown 
is 10 minutes, so that users can finish their current work and save their files. 
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As soon as you've entered the amount of warning time you want to permit, all 
users on the network will see a message informing them that you're going to 
shut down and telling them how much connect time they have left. You, the 
owner, will see a reminder like the one shown in Figure 7.27, indicating that 
your Macintosh is about to shut down automatically-because of the command 
you previously issued. 

The Macintosh will Shut Oown In one minute. 

[ Cancel ~JJ 

Obviously, you should make every effort to be thoughtful and give other users 
adequate warning before you shut down. 

Sharing Programs with other Computers 
If you ;ve designated a folder for sharing that contains an application, a member 
of your network can use that application just as you can. When a member 
double-clicks on the program icon inside the folder, the application will load 
just as if it were installed on the member's own computer. The only difference 
is that the program will probably load and operate more slowly. 
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Figure 7.28 shows a network access dialog box for a Macintosh named Ware­
house; the name was chosen because the computer is located in the office at the 
company 's warehouse. You'll note that the dialog box lists shared items that 
you might expect from a warehouse computer, such as files named Items to 
Reorder and Out of Stock. However, Aldus PageMaker and Microsoft Word are 
also listed as shared items. Although a warehouse office might use Microsoft 
Word to create reports and correspondence, not many warehouse operations 
would be involved in the desktop publishing operations for which PageMaker 
is normally used. Nevertheless, the warehouse might have a large hard disk­
bought with future expansion in mind; the company could store programs such 
as PageMaker on this computer to alleviate shortages of storage space on other 
Macintoshes in the network. 
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Figure 7.29 shows a network computer with the icon for a folder containing 
Microsoft Word displayed under the icon for this Mac's hard disk. The user can 
double-click the icon for this folder stored on another computer to open the 
folder, then use the application and its files as if they were on the individual's 
own hard disk. 

Some programs have the capability to link to other programs so they can 
exchange data and otherwise interact. You can permit the linking of your 
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shared programs by taking the following steps: 

I. Pull down the Apple menu, and select Control Panels. The 
Control Panels window will open. 

2. Double-click Sharing Setup to open this control panel, and click 
the Start button in the Program Linking section to permit pro­
gram linking. Click the close box to close the panel. 

3. Open the Users & Groups control panel, and double-click to 
open the icon for a user to whom you wish to extend program 
linking privileges. 

4. In the Program Linking area of the opened icon, click the box 
labeled Allow user to link to programs on this Macintosh (illus­
trated in Figure 7 .15), then click the close boxes to close the 
icon, the control panel, and the Control Panels window. 

5. Select the program icon for a shared application (an application 
in a folder you've designated for sharing), then pull down the 
File menu and select Sharing .... A small Sharing dialog box 
will open. 

6. The box marked Allow remote program linking is selected by 
default for applications that support linking. If this box is not 
already selected, click it to select it, then click the close box. 
Network users can now link your application to their applica­
tions that support linking. 
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UsiNG APPLE FILE EXCHANGE 
You've found that System 7 will let you exchange files between computers, 
using its built-in networking capabilities. With Apple File Exchange-a utility 
provided with System 7-you can also exchange files on disk with computers 
running under the MS-DOS operating system and even initialize floppy disks 
in the MS-DOS format. Moreover, with added translator files, you can convert 
files to and from many different application formats-both Mac and IBM. 
However, to use this utility, you must have a SuperDrive-a floppy drive that 
can use high density 3.5-inch disks. 

Apple File Exchange is provided in a folder with that name which is stored on 
the Install 2 installation disk (if you have the standard eight-disk version of 
System 7). The utility is not transferred to your hard disk by the Installer during 
the standard installation of the system software. To use Apple File Exchange, 
you'll have to copy it yourself, by dragging the folder from its floppy to your 
hard disk. 

You open Apple File Exchange as you would any other program: double-click 
its folder to open it, then double-cHck its program icon. 

You'll see a window much like that shown in Figure 7 .30. Of course, you may 
have one or more hard disks with different names; and you certainly will have 
some folders installed with names different from those shown in the left-hand 
list box. 

Once the window has been opened, you can insert a disk into your floppy 
drive that has been formatted for i\•1S-DOS, and it will be recognized as such. 
The window display will change to show the name of the inserted disk (if it has 
been named) and will add two more menus: Mac to MS-DOS and MS-DOS to 
Mac (see Figure 7. 31 ). These menus contain the conversions that are currently 
available (meaning that translator files have been installed for them). 

Apple File Exchange has a built-in capability to translate files between System 7 
and 1\•IS-DOS disks in two default formats: a text format for text files and a 
binary format for all other files . In addition, a single translator file is provided 
that will translate between DCA-RFT (Document Content Architecture/ 
Revisable Form Text) and MacWrite. Third-party vendors supply many other 

• 
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translator files, and some applications include a translator utility or can save 
files in an MS-DOS format. 

One of the best sources for translator files is Software Bridge, a utility from 
Systems Compatibility Corporation and available in both IBM and Macintosh 
versions. The Macintosh version provides translator files that will convert 
documents between several Macintosh formats such as Microsoft Word and 
WordPerfect/Macintosh to MS-DOS formats such as various versions of Word­
Star, Word, WordPerfect, and MultiMate. Once you complete a conversion using 
one of these translators within Apple File Exchange, you can take the .MS-DOS 
formatted disk and load its translated files directly into the IBM application for 
which they were made. 

Figure 7.32 shows the Installer program for Software Bridge in action. It allows 
you to select only the translators you need-and to add more at any time. If 
you install all of the 400 possible pairings, you 'II need a full 1. 7 megabytes of 
disk space. 
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Figure 7.33 shows the appearance of the Apple File Exchange Mac to MS-DOS 
menu when many translators have been installed. A checkmark precedes each 
active translator. 

Apple File Exchange has several features that are not immediately obvious. For 
example, there is a user log; you 'II be directed to this log if a translation problem 
develops, and you can access the log at any time by selecting the Show User Log 
command from the utility's File menu. Figure 7.34 shows a typical message seen 
when translation was not possible. In this case, the translator ftle did not support 
Microsoft Word's Fast Save feature; resaving the Word document with the Save 
As ... command corrects the problem. The user log is deleted when you exit Apple 
File Exchange unless you first save it under another name. 
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Figure 7.34 
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Another File menu option permits the renaming of destination files (the files to 
be created during the translation). When you don't exercise this option, Apple 
File Exchange creates a standard MS-DOS filename of eight characters plus a 
two-or three-letter extension that reflects the new ftle format. As Figure 7. 3 5 
illustrates, this extension is WP for WordPerfect files. Since System 7 permits 
much longer ftlenames, Apple File Exchange would translate both Book Chap­
ter 1 and Book Chapter 2 into an MS-DOS WordStar format as BOOKCHAP.WS. 
Obviously, this default procedure for translating names would indicate that you 
should provide new names such as BKCHAPO 1. WS and BKCHAP02. WS if you 
want to tell these two files apart or prevent one from overwriting the other. 

Fortunately, no naming confusion should result from the example shown in 
Figure 7. 3 5: the automatic translation of the Mac name Learning Theory into 
the MS-DOS name LEARNING.WP. 

• 
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Figure 7.36 shows the appearance of the Apple File Exchange window after a me 
has been successfully translated into an MS-DOS fonnat. The next step would be to 
click the Eject button to eject the MS-DOS disk from the Macintosh. 

Incidentally, if you activate Apple File Exchange and then insert an unformatted 
floppy, you will be given the opportunity to have it formatted either as a Macin­
tosh or MS-DOS disk. However, please note that if you insert a formatted MS­
DOS floppy into your Mac at any time when Apple File Exchange is not open, 
the disk will be recognized only as "not a Macintosh disk." You 'll be asked if 
you want to initialize the disk-which, of course, would mean reformatting it 
as a Macintosh disk. You would lose any files stored on the disk. If you acciden­
tally run into this situation, be sure you click the Eject button instead of Initialize! 
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Figure 7.36 
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UstNG SYSTEM 7'S NEW PUBLISH/SUBSCRIBE 
== FEATURE 

As indicated at the beginning of this chapter, you can designate all or part of a 
System 7 document as a "publication," to which other documents or applica­
tions can "subscribe." Many major applications now support this new feature 
of the system software. (Programs that do provide support display an Edit 
menu option with a name relating to publishing.) 

The concept is simple but powerful. These are the steps to follow in creating 
and/or subscribing to a publication: 

I. Select aU or a portion of a document from which you want to 
create a publisher. A publisher is any material in a document 
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that you want to designate for inclusion in other documents, 
with automatic updating. 

2. Pull down the Edit menu, and select the publishing option, as 
shown in Figure 7.37. (Usually, this option will be named either 
Publishing . . . or Create Publisher. . .. ) You wiU then see a dialog 
box where you will be asked to provide a name and a location 
for an edition file (see Figure 7 .38). An edition is the file where 
material selected as a publisher is stored for access by other 
documents and publications. It's often a good idea to store 
editions in a folder named Editions. (The dialog box shows a 
preview portion of the selected material so you can be sure 
your selection is what you wanted.) 
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3. Specify the storage location and name for your edition and click 
the Publish button. The edition will be created, and the dialog 
box will close. 

4. To use the edition in another document or application, select an 
insertion point for the material, then pull down the Edit menu and 
select the Subscribe ... command. (The name of the command may 
vary, and it may be located on a submenu under the name Publish­
ing . ... ) You'll see the dialog box shown in Figure 7.39. 

5. Highlight the name of the edition to which you want to sub­
scribe, and click the Subscribe button. The published material 
will appear in the new document. (This dialog box also has a 
Preview area at the left, where you can see the contents of the 
edition and verify that you've chosen the correct file.) 

Changes to an edition can be made only by changing the document containing 
the publisher. By default, changing the publisher will, in turn, change the edi­
tion. When a subscriber document is opened, it 's updated automatically from 
the edition file. You don't have to open the edition in order for this revision to 
take place. 
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If you want to have editions updated manually instead of automatically, you 
can change the default procedure from within the document containing the 
publisher, through an Edit menu option called Publisher Options. 

Users of other computers on your network can subscribe to your publications. 
All you have to do is designate your Editions folder for sharing. Then, when the 
subscribers log onto your computer and pick the Editions folder, they will 
probably want to click the box beside the name so that the folder will automati­
cally appear on their desktops thereafter when they turn on their computers. 
As soon as they open a document that subscribes to an edition in the folder, 
that document will be updated. 

SeeiNG AND CONTROLLING OTHER MAC scREENS 
Using LocalTalk or another Macintosh network, you can control several other 
Macs simultaneously, monitoring the contents of their screens in separate win­
dows on your own Mac. For example, you can view and discuss 24-bit graphic 
designs displayed on the screens of competing Macintosh computer artists­
seeing the designs on your own Macintosh, supervising modifications in real 
time, and selecting the design you prefer-without ever leaving your own 
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office. You can transfer any text or graphic across the network as if it were a 
giant clipboard, without requiring that network users have the applications in 
which the items were created. 

All you need to perform these feats of magic is to purchase a copy of Farallon 
Computing's Timbuktu for each Macintosh involved. This utility also works 
across telephone lines, letting you operate a Mac hundreds or thousands of 
miles away as if you were sitting in front of it. Timbuktu is a standard utility 
that is commonly used in the technical support departments of many corpora­
tions. Starting with version 4.0, it is complete~y compatible with System 7. 
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Using Sound 
under System 7 

:? FEATURING 

• Recording and playing sounds 
• Adding sound recording to your Mac 
• Using sound in HyperCard 
• Editing sounds 
• Using sound in applications 
• Using sound in Quicklime 
• Adding sound to Macintosh functions 
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Apple now places a strong emphasis on the use of sound. Of course, the 
Macintosh has always been able to reproduce sound-whether it be voice, 
music, or sound effects. However, user-recorded sound has suddenly been 
thrust into the limelight. For example, the Mac LC and IIsi computers were 
introduced with a built-in recording capability, and a microphone is shipped 
with each unit. The version of HyperCard included with System 7 supports 
both sound recording and editing, and the operating system makes it easy for 
application developers to permit the attaching of sound notes to spreadsheet 
and word-processing documents. 

Fortunately, you don 't have to buy a new Macintosh to be able to record sound. 
Inexpensive accessories can make any Mac a miniature recording studio. 

Even without a recording capability, you can obtain prerecorded sounds at 
little or no cost from sources such as computer bulletin boards, edit these 
sounds, and incorporate them into your system. 

UsiNG THE MACINTOSH'S sou No FACILITIES 

Figure 8.1 
The icon for the 

Sound control panel 

Can your Macintosh record sound now? There's an easy way to tell: 

I . Select Control Panels from the Apple menu. 

2. Double-click on the icon for the Sound control panel (shown in 
Figure 8.1). The panel will open. 

~~: 

Sound 
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3. Note the contents of the panel. Figure 8.2 shows the Sound 
control panel for a Mac Ilsi. 

If your Macintosh is not set up to record sound, this control panel will display 
only the volume control bar and a list of sounds from which you can choose 
the alert sound you want for your system. (The alert sound is used by the sys­
tem software and by applications to attract your attention.) 
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Operate the panel like this: 
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(Options ... J 

I . Drag the handle on the volume control to change the volume of 
your Mac's speaker system. 

2. Click on the name of a sound to select it as your alert sound; 
when you click a sound, you'll hear a sample. 

3. Click the close box to make your choice take effect. 

If your Mac can record sound, the Sound control panel will contain the addi­
tional elements shown in Figure 8.2. It will display buttons labeled Add . .. and 
Remove, plus an Options ... button that will be dimmed (not available for use) 
if the installed sound recording hardware and software provide no options. 
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Below the buttons you'll see an area named Microphones that will show an 
icon for each microphone installed. The Mac LC and Ilsi display a micro­
phone icon labeled Built-in. Some Mac owners install two microphones so 
they can record in stereo. 

Recording and Playing Sounds 

Figure 8.3 
The Record com rol 

panel during 
recording 

Here is the process involved in recording and playing sounds through the 
Sound control panel: 

I . If you have more than one microphone, click the icon for the 
one you want to use. 

2. Click the Add ... button. The Record dialog box will open 
(shown in Figure 8.3). 
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3. Test the level for the sound you want to record. Using a built-in 
microphone, you can change the volume only by adjusting the 
sound itself (example: speaking louder or more softly) or by 
moving the sound closer to the microphone or further away. 
Some other microphones and recording devices have volume 
control knobs. You can judge the correctness of the sound level 
by watching the simulated sound waves emitted from the small 
loudspeaker icon in the dialog box. When the sound waves 
strike a vertical line (as demonstrated in Figure 8.3), the sound 
is too loud and will probably record with some distortion. 

4. When you're satisfied with the sound level, click the Record 
button to begin recording. You have a maximum of ten seconds 
to complete the recording; a horizontal bar at the bottom of the 
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dialog box and a readout in seconds will indicate the elapsed 
time since recording started. 

5. Click the Stop button to stop recording. 

6. Click the Pause button to pause temporarily while recording. 

7. Click the Play button to listen to a completed recording. 

8. Click the Cancel button to close the dialog box without saving 
the sound. 

9. Click the Save button to save the sound. You 'II be prompted to 
provide a name. 

I 0. Name the sound (see Figure 8.4), then click OK. The Record 
dialog box will close, and the new sound will appear in the list 
of alert sounds in the Sound control panel. 

I I. Select the new sound as your alert sound if you like, adjust the 
volume if necessary, then click the close box to close the con­
trol panel. You'll return to the Control Panels window. 

12. Click the close box in the window to return to the desktop. 

Sound 
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To remove a sound from the list of alert sounds, open the Sound control panel, 
highlight the sound, and click the Remove button. You'll be asked to confirm 
your decision to erase the sound. 

Although the Sound control panel limits the length of your alert-sound record­
ing to 10 seconds, an application will often allow you to make much longer 
recordings, limited by the amount of memory allocated to the particular appli­
cation. (See Chapter 10 for more information about memory allocation and 
management.) 

Applications often give you the opportunity of varying sound quality as well. 
For example, if you select Good quality instead of Best, the sounds you record 
will have less fidelity but will require less memory and disk storage space. 

Adding Sound Recording to Your Mac 
If your Macintosh doesn't have a built-in sound recording capability, you can 
easily add sound recording and even a sophisticated sound editor for a total 
cost of $200 to 8300. 

The best known sound-recording add-on product is MacRecorder, manufac­
tured by Farallon Computing, Inc. MacRecorder will work with any Macintosh 
that can run System 7. 

You can purchase either a basic MacRecorder unit that matches the capabilities 
of Apple's built-in sound function, or you can buy the MacRecorder Sound 
System, which also contains Farallon's SoundEdit and HyperSound Toolkit; 
these utilities add extensive editing and programming capabilities. For example, 
with SoundEdit you can mix four sound channels simultaneously. 

Mac Recorder consists primarily of a small gray box about the size of a transistor 
radio that includes a digital recording unit, a built-in microphone, and two input 
plugs to which you can attach an external microphone or a line connected to a 
device such as a TV set or tape recorder. To make System 7 recognize the Mac­
Recorder, all you have to do is plug the box into either your modem or printer 
port, then drag a MacRecorder sound driver icon into your System folder. As 
soon as you restart your Macintosh, your Sound control panel will then resemble 
Figure 8.5. 
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You'll note that the Options .. . button is not dimmed in this control panel. You 
can click it to see the Porr Status dialog box shown in Figure 8.6. Here you can 
quickly verify at any time to which port your MacRecorder is attached, with­
out standing on your head to examine the rear panel of your Mac; and you can 
press the Update button to make sure the dialog box is displaying the latest 
information. 

Of course, the disadvantage to using a device such as MacRecorder instead of 
a Mac with built-in sound recording is that you lose the use of either your 

.-- Port status - - ----, 

Modem port: MacRecorder 

Printer port: busy 

[Update) 

Driuer uersion: 1.0 Don eli) 



...... 
lliil 
CHA PT ER 8 

Introduction to ~1acintosh Srstcm 7 

modem or printer serial port while the product is connected. However, com­
puter stores sell inexpensive switch boxes that let two or more devices share 
a single serial port. 

Another alternative to built-in Macintosh sound is Voice Link, from Articulate 
Systems. It too includes a digitizer/microphone unit and software to make it 
usable with System 7. 

UsiNG souND IN HYPERCARD 

Figure 8.7 
The first card 

in the HyperCard 
Home stack 

As most Mac users know, HyperCard was introduced as primarily a visual 
bypertext tool. Hypertext documents are organized so you can read them in 
an outline form; if you need more information about a particular subject men­
tioned, you can select an option to go to another level and see more detail. 

Early sample HyperCard stacks-as its data files are called-contained mainly 
visual images , stored according to their subject matter. 

As in the past, the HyperCard utility is currently shipped with the operating 
system-at no additional cost. However, the version included with System 7 
contains only sample stacks with an audio rather than a visual emphasis. Fig­
ure 8.7 shows the opening "card" or master menu for HyperCard; this card is 
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the top card in a stack called Home, a file containing part of the actual Hyper­
Card program. The three sample stacks available for use are shown as Appoint­
ments with Audio, Addresses with Audio, and Audio Help. 

Appointments with Audio is a daily appointment scheduler, while Addresses 
with Audio is a computerized personal address book. You can add verbal notes 
to either one. 

Audio Help is a help stack that tells you how to record and edit sound in Hyper­
Card. (See a typical card from that stack in Figure 8.8.) 

Recording in HyperCard 

Figure 8.8 
A typical card in the 

Audio Hdp stack 

To record a so4nd in either the Appointments or Addresses HyperCard stack, 
follow this procedure: 

I. Select the location on a card where you want the icon for the 
sound to appear. This icon will appear after the sound is saved, 
and will be in the form of a loudspeaker; clicking the icon will 
play the recorded sound. 

Editing tools and 
the waveform 

Cord 4 afS 

You can view and select any part of a 
recorded sound using the waveform 
ovelView and close-up view areas of the 
Audio Palette. The entire sound is always 
shown in the waveform ovelView. 
"1/av• farm clas•· up v f•w 

.• ·;··' ' Wavtform ovtrvitw~ 
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Figure 8.9 
The HyperCard 

Audio Paleue 
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2. Pull down HyperCard's Edit menu and select Add Audio Memo. An 
object called the Audio Palette will appear (see Figure 8.9). This is 
really a three-dimensional representation of the Record dialog box 
previously described for System 7, providing the same features and 
operated in the same way-with two exceptions. Audio Palette 
also includes an Edit button, through which you can edit sounds 
and select recording options, as well as a list box from which you 
can select sounds by name to play or edit. 

3. If the Audio Palette is in an inconvenient location for you, drag 
it by its top border to a new position on your screen. 

4. Use the controls as you would those in the Record dialog box to 
record, play, and save the sound. 

5. Click the close box to close the Audio Palette. The speaker icon 
will now appear on the current card at the spot you selected, 
making the sound available for playback at any time. 
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Sound Editing in HyperCard 

Figure 8. 10 
Sliding 1he view box 

10 sclccr a ponion of a 
sound in the expanded 

Audio Palcne 

When you click the Edit button on the Audio Palette, the palette expands 
downward to display both editing and recording options (see Figure 8.10). 

In the center of the palette, you'll now see three boxes that will display differ­
ent waveform views of a selected sound. (If no sound is currently selected or in 
memory, you will see two empty boxes.) In a waveform view, the volume of 
the sound is represented by vertical fluctuations; the duration of the sound is 
represented horizontally. 

The top box is the close-up view, an enlarged version of the portion of the 
waveform seen in the lower left box; this lower box is called simply the view 
box. You can drag the view box to the left or right on top of the third box­
called the wavefonn overview-to select the portion of the sound you want to 
edit in the close-up view. The waveform overview box always displays the 
entire sound, from beginning to end. 

Below the waveform boxes, you can click the Play Through box to hear a sound as 
you record it (an option usable only if you have special hardware that supports 
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this feature). Click the Auto Rec. Level box to have the Audio Palette adjust the 
recording volume for you automatically. 

The slide control at the bottom of the palette lets you adjust playback volume 
manually (not recording volume). A setting you choose here is effective only 
when you're in HyperCard. 

The Compression option has a pop-up menu that lets you save sounds to disk 
in a compressed form if you like, thereby using less disk space. The two com­
pression ratios available are 3 to 1 and 6 to 1; the 6 to 1 option uses the least 
amount of disk space but provides lower sound quality. If disk space is not a 
problem, use no compression, for maximum quality. 

Rec. Quality is another option that affects the quality of the sound you hear. If 
you select Best from this pop-up menu (the default), sound is recorded at a rate 
of 22 kHz (kilohertz) per second, meaning that the sound is sampled 22,000 times 
per second. The other menu choice, labeled Good, records at a rate of 11 kHz per 
second, with a lower sound quality resulting from the lower sampling rate. 
However, the Good option uses both less memory (RAM) and less disk space. 

Saving 30 seconds of sound recorded at 22 kHz requires 660K of free memory 
and disk space. Saving 30 seconds of sound recorded at 11 kHz requires only 
330K of memory and disk space. 

The Delete ... option on the palette lets you highlight and then delete any 
sound listed in the current folder. 

This is the procedure for editing a sound: 

I . Select the sound to be edited from the list box at the top of the 
Audio Palette. 

2. Drag the view box across the waveform overview to select the 
portion of the sound you want to enlarge for editing. 

3. Drag across the enlarged close-up view to select the exact 
section of the sound you want to edit. Figure 8. 11 shows as 
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Playing a selected 

segment of a sound 
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selected a small segment of a voice recording where the person 
speaking inhaled audibly between words. 

4. To make certain that your selection is correct, click the Play 
button. You'll hear only the selected section of the sound. 

5. If you haven't selected exactly the segment you want, drag 
across the close-up view again to adjust the selection. Drag and 
play the highlighted segment until it includes only the exact 
part of the sound you want. 

6 . If you want to delete the selected element, pull down the Edit 
menu and select Clear Sound. You can also use Cut, Copy, and 
Paste commands to move your selection through the clipboard 
to be pasted into another sound recording, at the exact point 
you specify. 

7. Play the affected sounds to evaluate the results of your editing. 

8 . If you're satisfied with the editing, save the changes. 
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WORKING WITH FARALLON'S SOUNDEDIT 
UTILITY 
HyperCard's sound editing facilities work only within HyperCard. However, 
with a program such as Farallon's SoundEdit-included in their MacRecorder 
Sound System-you can edit waveform representations of sounds for use else­
where in your Mac system. In fact, you have at your command very advanced 
recording and editing options. 

If you have a Macintosh with built-in sound, you can buy SoundEdit separately, 
without investing in the complete MacRecorder Sound System. Consider, 
though , that with both built-in sound and a MacRecorder-or two Mac­
Recorders-SoundEdit will let you record in stereo! 

SoundEdit provides four sampling rates instead of two, to help you conserve 
disk space with satisfactory quality. You can record with four different com­
pression ratios. You can add special effects such as an echo chamber, a loopback 
to increase the duration of a sound, or a stereo "ping-pong" effect (where the 
sound seems to switch back and forth between left and right speakers). You can 
play a sound backwards. You can create sounds artificially, such as a siren or 
birds chirping, with synthesized, frequency-modulated signals. And you can 
save sounds in your choice of file formats. Figure 8.12 shows some of the 
special-effect menu options. 

Figure 8.13 displays SoundEdit's Spectrogram effect, which lets you analyze 
the frequency content of sounds. The frequencies are represented by a series 
of two-dimensional graphs. Each graph represents a time interval. The two 
axes are power (in decibels) and frequency (in hertz). You select portions of a 
sound to be graphed and adjust the display through the upper Controls win­
dow. The bottom Spectrogram window displays the transforms. You change 
settings through menu options. 

As you can see, SoundEdit has powers that can both fascinate the hobbyist and 
please the sound professional. Although you may not want to take advantage of 
all of its features, the utility provides many easy-to-use options for managing 
sound recording on your Mac. 
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UsiNG souND IN APPLICATIONS 

Figure 8.14 
The Sound menu in 

Full Write Professional 

Many applications now support the sound capabilities of System 7. For ex­
ample, you can add sound to the current versions of Ashton-Tate's FullWrite 
Professional word processor and Fuiiimpact spreadsheet program. Other 
spreadsheet programs that can use sound include Microsoft Excel and Claris 
Resolve. Mac Write Pro can create effects· for on-screen presentations by 
combining text, graphics, and sound. 

Figure 8.14 illustrates that, in FuiiWrite Professional, you can use menu options 
to make a sound play automatically either when a note panel is opened within a 
document or when the document itself is opened. 

Figure 8.15 shows Excel's Cell Sound Note dialog box, through which sounds 
can be attached to cells, copied, selected for playing, or deleted. 

UsiNG souND IN QUICKTIME 
Apple's new QuickTime software architecture lets developers and Mac users 
combine dynamic media such as sound, video, and animation into an integrated 
whole. Apple caUs QuickTime presentations "movies," and the experience of 
watching a QuickTime movie can be very much like watching a motion picture. 

For the user, QuickTime functions as an extension to System 7. To be able to use 
QuickTime, you need only drag the QuickTime extension into your System 
folder. 
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As you might imagine, creating the effect of a motion picture-with constantly 
changing images and sound-requires the storage of a tremendous amount of 
data. Therefore, QuickTime employs new me compression techniques to enable 
Mac users to utilize QuickTime on their hard disks. Some elaborate QuickTime 
productions are available only on CD-ROM disks. 

QuickTime movies can be interactive. A movie controller designed by Apple 
lets you turn sound on and off and employ techniques familiar to users of 
videotape recorders such as fast-forward and freeze-frame. In addition, some 
QuickTime movies let you select the scene you want to see next, or even 
choose between alternate endings to a presentation. 

AooiNG souND To MACINTOSH FUNCTIONS 
If you'd like to develop a meaningful relationship with your Macintosh, you 
can teach it to talk to you . All you have to do is obtain SoundMaster. This CDEV 
(control panel device) can attach sounds to Macintosh functions such as startup 
or even pressing the Return key. For example, when you insert a disk, your Mac 
could respond politely by saying, "Thank you very much." 

You must provide the sounds used. If you don't want to record your own, you 
can obtain free prerecorded sounds through many Mac bulletin boards and user 
groups. 

• 
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Figure 8.16 shows the SoundMaster control panel. (By the time you read this 
chapter, the product will probably allow you to connect sounds to additional 
functions.) 

SoundMaster is shareware software-meaning that its author would appreciate 
receiving a donation from you if you use and like it. The utility was written by 
Bruce Tomlin, 15801 Chase Hill Blvd. , #109, San Antonio, TX 78256, and can 
be obtained direc£ly from him or downloaded from the GEnie network bulletin 
board. He requests a SlO donation. 

You can obtain SoundMaster, plus four disks of fun sounds, from Advantage 
Computing for a total cost of Sl9.95. The telephone number is (800) 356-4666. 
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• Protecting your screen 
• Adding powerful applications 
• Handling SCSI devices 
• Adding a hard drive 
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In earlier chapters, you learned about some products that can enhance the 
capabilities or performance of your Macintosh under System 7. These products 
were usually introduced in connection with a specific topic such as typefaces 
or sound recording. This chapter will discuss additional products that will let 
you do more with your Mac. 

Products that deal specifically with solving system problems (such as the re­
covery of files that have accidentally been erased) are covered in Chapter 10. 

PROTECTING YOUR SCREEN 
When you walk away from your Macintosh and leave it on for a long period 
of time unattended, the image on the screen can ''burn in,'' causing permanent 
damage to your monitor. After Dark (from Berkeley Systems Inc.) is a screen­
saving utility that prevents this potential damage by automatically replacing 
that static image with a continuously changing display. As soon as you return 
to your Mac and move the mouse or press a key, your original image is restored, 
ready for you to work with it again. 

You can set After Dark to take over your Mac after 15 minutes of inactivity 
(the default), or following the passage of any other number of minutes you 
wish. Obviously, if you set the elapsed time for activation of the utility at too 
brief a period, you could be irritated by seeing your current document 
disappear while you sit in from of your Mac, thinking of the next sentence 
you want to type. 

After Dark provides more than 30 moving screen patterns from which you 
can choose. Figure 9.1 shows an example: a fish display that turns your inactive 
screen into an instant aquarium. In Figure 9.2, you see the control panel for 
this CDEV as it presents the options for the fish display; as you'll note, you 
can select how many fish you want swimming at one time, how fast you want 
them to move, and whether or not you want the sea floor to be visible. 
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Figure 9.2 
The After Dark 
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There's even more. Click the Options ... button for the fish selection, and 
you 'll bring up the dialog box in Figure 9.3. Here you can decide exactly which 
objects you want included in your display: fish (by the name of the species), 
seaweed, bubbles , etc. 
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Each object moves in a characteristic manner; for example, a jellyfish has a 
different movement pattern than an Imperial Angelfish. 

Other After Dark scenes have appropriate options. If you select a Starry Sky­
line, you can decide whether or not you want to see a flashing red beacon on 
top of the highest building. 

Many of the selections have accompanying sound effects; you can turn the 
sound on or off and adjust its volume. A clock can tick and chime. Your amazed 
office co-workers can both see and hear your screen devoured by worms. 
Lightning can be accompanied by thunder. 

After Dark is both useful and entertaining. 

AooiNG POWERFUL APPLICATIONS 
If the programs you're using on your Macintosh don't provide all of the fea­
tures you'd like, other programs may be available that will give you exactly the 
options you want. Fortunately, you can now select from a long list of applica­
tions in almost every program category that are compatible with System 7. 

Compatible doesn't necessarily mean that the application supports all of the 
capabilities of System 7, such as Publish and Subscribe. However, the applica­
tion will function correctly and may be more powerful than the one you're 
currently using. 
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For example, QuarkXPress 3.0 does not support TrueType. Users of Frame 
Technology's FrameMaker 3.0 do receive TrueType support, plus many unique 
features, including the ability to create up to 25 master pages in a document. 

Of interest to large organizations engaged in electronic publishing is the fact 
that FrameMaker is available in versions for many platforms in addition to the 
Macintosh. These include DEC, HP/Apollo , IBM, NeXT, Sun, PCs running SCO 
Open Desktop, many X terminals, Altos, Bull Worldwide Information Systems, 
Cetia, Data General, Encore, Intergraph, Matsushita, MIPS, .Motorola, Pyramid, 
Sequent, Siemens, Silicon Graphics, Sony, and Toshiba. 

If you frequently need to make color separations on your Mac for use by pro­
fessional printshops, you may be interested in Letraset's DesignStudio 2.0. This 
desktop publishing program includes a separation utility offering unusual 
power and versatility. 

FrameMaker and DesignStudio are only two options in a rapidly developing 
field that now even includes high-end word processing programs. 

HANDLING SCSI DEVICES 
You can expand your Mac system by adding SCSI devices. The letters SCSI 
stand for Small Computer System Interface. By merely attaching a device 
through a cable connected to a SCSI port on your Macintosh, you can make 
the device a regular part of your system; some devices are accompanied by 
special software also required for their operation. 

What kind of devices can you connect? The most common are external hard 
drives , scanners, and CD-ROM drives. (These devices will be described individ­
ually later in the chapter.) 

Macs are sold with only one SCSI port, but this fact does not limit your use of 
SCSI hardware to one device. You can daisy-cbain devices-connecting up to 
seven devices in a single chain. 

Assigning Unique SCSI ID Numbers 
You must assign eacb device a unique SCSI identification number, which 
is usually done by pushing buttons to change the number displayed in a small 
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window on the back panel of the device. Address 7 is always reserved for your 
Mac itself. Address 0, by general industry agreement, is normally an internal 
hard drive (a drive installed inside the case of your Macintosh). This arrange­
ment leaves addresses 1 through 6 open for assignment to other devices. 

Let's say you have two Macintoshes. You might attach an external hard drive 
to each, and-in this case-give each hard drive the same SCSI ID number; let's 
say you pick the number I . There will be no problem because the two SCSI 
devices with the same number are attached to different Macs. 

However, what if the power supply goes out on one of these Macs; and you 
take the computer to your local Macintosh dealer for repair? While the Mac is 
out of service, you still want to use the data and programs stored on its external 
hard drive. You can do this through daisy-chaining; connect both external 
drives to the remaining Macintosh, and yo~ pn use them both. If both drives 
still have tbe same ID number wben you do tbis, you will lose the data on at 
least one of tb'e drives! The reason is that you'll be confusing System 7; the 
catalog files will become scrambled that identify the nature of stored data on 
the disks for the system software. 

For the same reason, you risk losing data if you change the SCSI ID number for 
an external hard drive without turning its power off first. 

If you do have more than one Mac with an external hard drive, it's a good idea 
to give each external drive a unique ID number to avoid a future problem if the 
two drives should ever be daisy-chained. 

Terminating Devices 
When you daisy-chain devices, each end of the daisy-chain must be marked 
with a terminator, a piece of hardware that identifies the beginning or end of 
the chain. There must be no more than two terminators in the chain. 

An internal hard drive is already terminated. Therefore, if you have an internal 
hard drive, you can add only one more terminator. If you'll be using only one 
SCSI device on a Mac, you usually don't have to worry about termination. The 
device-hard drive, scanner, or whatever-will probably be shipped with inter­
nal termination already in place. Just plug in the device, install accompanying 
software if necessary, and use it. 
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If you want to daisy-chain-in other words, use at least one additional SCSI 
device with the same computer-you must remove the internal termination 
from one of those devices. Either device can be at the end of the chain. Most 
Mac users simply remove the internal termination from the device for which 
the process is the easiest. Usually, you must follow printed instructions care­
fully to remove termination, opening the case that houses the device and 
removing a small object from a circuit board. 

The device that is not internally terminated becomes the middle device in the 
chain. SCSI devices usually have two SCSI ports. You use a SCSI cable to make 
the connection between the computer and the middle device, plugging into 
either one of the device's SCSI ports. You then run additional SCSI cabling from 
the middle device's remaining SCSI port to the device at the end of the chain. 

If you later need to restore termination to a device from which you've removed 
the internal terminator, you can do this by merely plugging an external termina­
tion plug into either one of the device's SCSI ports . 

ADDING A HARD DRIVE 
As was stressed at the beginning of this book, you need a hard drive to use 
System 7. This drive could be an external drive. You can install the system 
software on this drive and designate it as your startup drive through the Startup 
Disk control panel. In fact, as demonstrated in Figure 9.4, you can choose an 
external drive as your startup drive even if you also have an internal hard drive. 

Most users of System 7 do have an internal drive, even if its storage capacity is 
limited. They're interested in adding an external drive to increase that capacity 
and to provide some protection for critical data; if you have both internal and 
external hard drives, you can easily copy a critical file or folder from one drive 
to the other-a quick and effective method of backing up a limited number 
of items. 

Some Mac users use an external device that can contain any one of a series of 
removable hard drives, making possible almost unlimited backup and storage pos­
sibilities. This type of device is often expensive though, and the access speed of a 
removable drive is usually slower than that of conventional hard drives. 
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You can purchase some external hard drives at very low cost. For example, 
Ehman Incorporated (Evanston, Wyoming) manufactures and sells direct a 
series of attractive drives that can fit under most monitor stands. Ehman has 
been selling an external drive with a 170-megabyre capacity for less than 
$800. A drive with a 40-megabyte capacity is about 5250. 

You can rename a hard drive using exactly the same technique you'd use to 
rename a folder on your desktop (however, not while the drive is being shared). 
If you have two or more external drives in a daisy-chain, you certainly don't 
want them to carry identical names. Many external drives are initially identified 
simply by the name of their manufacturer. 

CHANGING THE INTERLEAVE 
When you buy an external hard drive, it will probably be sold preformatted and 
ready for use. If you buy through a local computer store, that retailer should for­
mat the drive with the proper interleave for maximum performance with the kind 
of Mac with which it will be used. The interleave ratio determines how the sectors 
are arranged on each track of the hard disk. A fast computer can use a 1 to I (I: I) 



Enhancing Your Macintosh under System 7 

interleave ratio, wherein the sectors are in strict numerical order (I, 2, 3, and so 
on). A slower computer may require that the first sector (number I) be followed by 
the second sector in a number 3 position; in other words, the magnetic reader head 
will skip the number 2 position temporarily to give the computer more time to 
read the data. 

These computers are all fast enough to use a 1: I interleave ratio: any Mac II, 
the Mac LC, and the SE/30. The standard Mac SE and the Mac Classic require a 
2:1 interleave. The Mac Plus needs a 3: I interleave. If you try to use an external 
hard drive that has been formatted with too fast an interleave factor for your 
Mac , the Mac will nor recognize the drive. 

For this reason, most vendors of external hard drives ship them formatted 
with a 3: 1 interleave. This means that they can be used without difficulty on 
any Macintosh. However, if you have any Mac other than a Mac Plus, your drive 
will be operating at half or even a third of the speed it should deliver. 

You correct this disparity hy cbanging tbe interleave when you receive the 
drive (provided a dealer has not already done this for you). Usually, the drive 
manufacturer will have furnished software with the drive that can easily 
accomplish this goal. 

Since changing the interleave requires the reformatting of the drive and the 
loss of any data already stored on it, you'll want to change the interleave before 
you use the drive. 

Figure 9.5 shows the interleave dialog box for the formatting software shipped 
with the Ehman drives. As you can see, this dialog box makes it very easy to 
choose the proper interleave ratio for your particular situation. 

If you purchase a large external drive, you may want to divide it into parti­
tions. Usually, the software supplied with the drive can handle this task too. 
The result of partitioning will be that the drive will appear on the desktop as if 
it were actuaJly two or more separate drives. You might think of partitions as 
extra-large folders that will help you organize your files and folders. 

Advanced Mac users sometimes partition hard disks so that one or more 
partitions actuaJly function under a different operating system. This pro­
cedure requires special software and knowledge. 
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UsiNG CD-ROM DRIVES 
CD-ROM drives are a kjnd of compact-disk player. A single CD-ROM disk can 
hold the equivalent of hundreds of floppy disks. Therefore, you can buy and 
access a complete electronic encyclopedia on one compact disk-or a complete 
typeface or clip art library, or a QuickTime movie presenting highlights of all of 
the tours available through a travel agency. 

lf you already have a CD-ROM drive that you used before you installed Sys­
tem 7, you will need to update your CD-ROM software before you can run the 
unit under System 7. 

Apple provides a CD-ROM Setup disk for this purpose with its Group Up­
grade Kit for System 7. This particular disk is not included in the System 7 kit 
for individuals and is intended for use only with Apple's own AppleCD SC 
CD-ROM drive. If you're an individual who needs this CD-ROM software, 
contact your Macintosh dealer. 

Figure 9.6 displays the contents of the setup disk, which includes support 
for the HFS, ISO 9660 and High Sierra CD-ROM file formats , as well as a desk 
accessory called CD Remote that lets you play regular audio compact disks 
on your CD-ROM drive. 
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You can use a CD-ROM drive on a network. Any CD-ROM disk that is mounted 
on the desktop when file sharing is started will automatically be made available 
for sharing. However, you can't eject a shared CD-ROM disk while file sharing 
is active. This means that if you want to switch disks, you must first terminate 
file sharing, then insert the new disk, and, finally, restart file sharing. 

To avoid shutting down a network merely to change a CD-ROM disk, some 
companies install a separate CD-ROM drive for each disk to be shared. This 
solution is expensive, but means that all of the wanted disks are available all 
the time, without causing any interruption to activities on the network. 

AooiNG A scANNER 
A scanner is a SCSI device that can convert images on paper into digital com­
purer files your Macintosh can use. You operate most scanners by laying the 
subject matter to be scanned face down on a flat glass bed, then closing a lid 
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and using software to control the actual scanning operation. Most of these 
products can scan an image as large as a legal-sized page and retail for S 1 ,;oo 
to S3,000. Scanners geared for the professional market can cost many thou­
sands of dollars more. 

You can also buy a hand-held scanner for a few hundred dollars; however, these 
scanners capture only part of a page at a time. 

Some scanners can handle only a black and white or grayscale image. Others 
can scan in full-color-some in 24-bit color, meaning that the scanner can rec­
ognize millions of individual colors. 

Chinon America offers a full-page color scanner that recognizes 4,096 colors, 
has a unique pedestal construction, and boasts a list price of less than S 1 ,000. 

With special software, scanners can perform optical character reading (OCR). 
You can supply the scanner with a typed manuscript, and it will produce a 
computer file of the document-with no retyping. 

Although scanners would seem to be primarily a question of hardware, you 
use computer programs not only to accomplish the scanning process but also 
to retouch and manipulate the image after you've.captured it on disk. There­
fore, we come back to that old bugaboo again: System 7 compatibility. You 
want to make certain that the programs you use for these purposes will run 
properly under System 7. 

Often the vendors of scanners include software with their products­
sometimes for both capturing and editing images. The practice is known as 
"bundling." If a particular scanner unit was manufactured some time ago and 
has been sitt ing in a warehouse waiting for a purchaser, the bundled software 
included in the carton could be many months out of date. It's good business to 
check out software version numbers before you buy a scanner that comes with 
software. After all, in reality you are paying for the software- even if the 
price is hidden and discounted. 

Some of the better scanners are sold with both scanning software in the form 
of a Mac desk accessory-so you can scan an image at any time without leaving 
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some other program-and with sophisticated image retouching and modifica­
tion applications like Letraset's ColorStudio and Adobe Photoshop, which 
can also control the scanning of images. 

Figure 9.7 shows the special scanning desk accessory supplied with Abaton 
scanners. It allows you ro select a scanning mode appropriate to the subject 
being captured (line art, photograph, and so on), preview the subject, crop the 
image to select only the portion you want, adjust attributes such as brightness 
and contrast, and, finally, capture the image to disk in your choice of Macintosh 
graphic file formats . 

Adobe Photoshop is also included with Abaton scanners. 

Figure 9.8 shows the ScanDo desk accessory bundled with Epson scanners. It 
provides the ultimate in carefree scanning for novices, since you can select 
settings in plain English that will provide the best scan for each type of image. 

Both Letraset ImageStudio (for grayscale work) and ColorStudio are also 
bundled with Epson scanners. 

Scan 

Scan Mode f;>IH!iii!i!ii!'!ii!iiHh;;i;i;i!i!i!iH!i!i!t!'!![ J~ 

1256-leuel Gray Scale! 
Scaling 181 Uniform 

1 00 OJ. 
24 f;>J;;iii!ili!t!iHm;;;;;:;t I~ 1 oo 

Width 5.50 ln. 

1 00 OJ. 
24 ~;>l >'''"w'i!"''"'''''' 'o~ 1 oo 

Height 6.12 in. 

Scan Size (ln.) 

~H[§J 

Image Size 2960 K 

Ell 



CHAPTER 9 

Figure 9.8 
Ep)on's Scan Do desk 

accessorr 

Introduction to ~lacintosh System 7 

Scan To: 

Image Type: 

Dropout: 

Resolution: 

Color for: 

Gamma for: 

Brightness: 

50 "1o 

!Halftone R (sharp) I 
!None I 
!Photograph I Q 
!Laser printers I 
!Printer R I 
-3 .,'-'¢ ..... 1_1111._1 _ __._l¢'-'1 0 

Scaling: 1 00% 

Width: 1.27 in. 
(8] Uniform Scaling 

Height: 1. 78 in. 

Image l<b: 4 
Disk l<b free: 9553 

[ llelp )( Final ~J[ Zoom 

Uersion 
1.6 

All of the scanning software mentioned here is compatible with System 7. 
Both the Abaton and Epson scanners support 24-bit displays with their mi!Hons 
of colors. 

When your scanner is part of a SCSI daisy-chain, you can use the other devices 
in the chain without turning on the scanner. 

BuYING A LARGER MONITOR 
If you have a smaU-screen Macintosh, you could be tempted to buy a larger 
monitor. You might think of how much more efficiently you could work if you 
could see an entire 8.5 by 11-inch page of a document at one time- or even 
two full pages side by side. 

The temptation becomes stronger when you see the relatively low prices 
advertised for some brands of monitors. Two-page monochrome displays are 
available for less than 5900. You can buy a two-page color monitor for under 
53,000. These prices include the video card that must be installed in your 
Mac so the monitor can function. 
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Install two monitors, and you can make them operate as if they were one large 
screen (through the monitors control panel). Drag an object beyond the right 
edge of the screen of your left-hand monitor, and the object will appear on the 
screen of your right-hand monitor. 

Assuming that these large monitors provide adequate quality at these prices­
and some of them certainly do-you could still be very disappointed with your 
purchase. 

The catch is that it takes real computing power to rewrite the information 
on a large-screen monitor at an acceptable rate of speed every time you move 
an object or add a line of text. Whether your goal is to create engineering draw­
ings or to publish a newsletter, you can become very irritated if you continually 
have to wait a second or two for the results of your latest change to appear on 
the screen. 

If you don't have a fast Macintosh, the answer is to buy an accelerator as 
well as a monitor, or buy a monitor that has an accelerator incorporated into 
its video card. An accelerator does exactly what the name implies. It's an 
electronic gadget that makes your Mac perform some functions faster. The 
next section discusses these speed-up options in more detail, but be forewarned 
that not all accelerators are compatible with System 7. 

When you add an accelerator, the price for that large-screen monitor starts to 
go up. Sometimes you can invest so much in speeding up an inexpensive com­
puter that you'd be better off buying a faster Mac in the first place. 

Another point to consider regarcting a large-screen upgrade is that some Macs 
(including the Mac Classic) have no expansion slots; at least one is required if 
you're going to plug in one of those video cards that support a large-screen 
monitor. 

However, enterprising developers have already come up with large-screen 
monitors and accelerators for the Classic anyway. For example, Mobius Tech­
nologies (Emeryville, California) offers both one- and two-page monitors for 
the Classic, with built-in acceleration. Mobius gets around the absence of an 
expansion slot by having the interface clip onto the computer's logic board. 
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Figure 9.9 illustrates the relative size of Apple's line of monitors. On the left 
is a 13-inch color unit-a size often used with the more expensive Mac II 
computers. At the right end of the display is a 12-inch monitor-the size 
usually sold with the Mac LC and !Isi. Next to the 12-inch monitor is Apple's 
1 S-inch unit, which provides a full-page monochrome display. The remaining 
monitor-in the left center position- is the 21-inch two-page mono-
chrome model. 

SPEEDING UP AND EXPANDING YOUR MAC 
If you decide you want to speed up your computer, be sure you find out the 
total cost. For example, for some thousands of dollars you can buy a new 
motherboard for a Mac !Ix that will, presumably, give it the performance of a 
Mac Ilfx. However, you'll also need to buy new memory chips to make it func­
tion properly (see Chapter 10 for more about memory); and you'll need a new 
hard disk to match the speed of the hard disk provided with the real Ilfx. 

If you want to install any card in the expansion slot of one of the low-cost Macs 
such as the LC or the Ilsi, you must make certain that the card has a low power 
drain. These computers have low-capacity power supplies. 

Because the LC and the Ilsi each have only one expansion slot, several vendors 
have produced multi-function cards for them. 
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A good example is QuickSilver, from Applied Engineering, Dallas. This card is 
shown in Figure 9. 10. 

QuickSilver includes all this: an on-board static RAM cache that speeds up 
performance as much as 40 percent, a socket that lets the Ilsi use SE/30 circuit 
boards, plus a socket where you can install a math coprocessor chip (to speed 
up math-intensive applications such as spreadsheet and CAD programs). The 
card retails for about S400; the math coprocessor adds another S 140. 

To speed up a Mac II, Mac Ilx, or Mac Ilcx without going to the expense of 
buying a new motherboard, you may want to consider a product like the 
PowerCard 030 produced by DayStar Digital. The card includes its own 
Motorola MC 68030 processor and comes with your choice of 25 , 40, or 50 
MHz clock speeds. A math coprocessor is optional. The PowerCard can more 
than double the processing speed of some functions. However, it installs into 
your CPU socket; we suggest that you have a professional make this installa­
tion, since it 's very easy to damage some of the delicate components. 

The Mac Ilci has a built-in cache socket, into which you can easily insert a 
cache card to improve processing speed as much as 40 percent. Some of these 
cards are inexpensive, priced at about 5300. Figure 9.11 shows an example, 
Applied Engineering's Cache-In . 

Another Applied Engineering product-QuadraLink-fits into an expansion slot 
on any Mac II and provides four additional serial ports (see Figure 9.12). With 
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this product, you could attach a printer to your regular printer port, a modem 
to your modem port , and a MacRecorder to one of the Quadralink ports, and 
still have three additional serial ports available. But QuadraLink is even more 
interesting because of another of its features . It comes with a control panel 
device called AE Shadow. Use this driver on every computer in a network, and 
all of the network users can share any devices connected to a Quadralink, such 
as modems and even Apple Image Writers, Style Writers, and Personal 
LaserWriters-printers normally not usable on a network. Quadralink sells for 
about 5300. 
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Everyone runs imo problems sooner or later when using a personal com­
puter, although the Macintosh is so easy to use that it keeps simple "human 
error" problems to a minimum. Of course, you will still hear stories such as the 
one about the novice who lost a file for weeks and assumed that it had been 
accidemally erased-only to discover one day that it was only hidden behind a 
window. However, even computer gurus sit at their Macintoshes occasionally 
when they're tired or in a hurry and may really erase a file accidentally. 

Another class of problems occurs because a computer mns out of memory, and 
therefore the memory management plan must be adjusted. 

The third problem area is the worst-difficulties caused by hardware or soft­
ware failure. A disk fails, or an electrical surge or power failure destroys or 
damages data. A new software program has an undiscovered bug that causes 
the system to freeze up. A file can no longer be opened because information 
about its type and origin has bee·n lost or corrupted. 

This chapter deals with some of these difficulties and how to handle them. 

MANAGING MEMORY 
As indicated earlier in this book, the more memory you have in your Mac, the 
more you can take advamage of the features of System 7. For example, even 
activating file sharing can soak up 350K or more of your available RAM. So if 
you have a few dollars to spare, adding memory to your system is a good idea. 

Adding Memory 
Buying memory chips is far less expensive than it used to be. However, there 
are several considerations to adding memory other than having the extra 
money handy. 
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First of all, not all memory chips are the same. RAM upgrades are usually 
accomplished by installing SIMMs. A SIMM is a Single In-Line Memory Module, 
consisting of a tiny circuit board with memory chips soldered to it. You can 
buy five kinds of SIMMs: 256K, 1MB, 2MB, 4MB, and 16MB-and they come 
in different speeds. It 's OK to install SIMMs that are faster than your particular 
Mac can use. It 's not okay to install SIMMs that are too slow; your system will 
crash. It's also not OK to install 4MB SIMMs in a Mac Classic, Plus, or SE; these 
models don't understand high-capacity Sil'flMs. In fact, a Mac II can't handle 
4MB SIMMs either unless its ROM has been updated, and a Mac llx needs an 
extra logic chip on each SIMM board (called a PAL-technically a Program­
mable Array Logic chip). 

You have ro buy a memory-expansion board to install SIMMs on a Mac Classic; 
the computer's main logic board has no sockets for SIMMs. 

The construction of the Mac Classic , Plus, and SE limits them to a maximum of 
4MB of RAM (in other words, four 1MB SIMMs). The SE/30, II, Ilx, and Ilcx can 
use no more than 8MB of RAM. 

Using 32-Bit Addressing, Virtual Memory, 
and the Disk Cache 

If you have a Mac LC , Ilsi, Ilci, or Ilfx, you can use 32-bit addressing, a new 
memory-management process through which you can access up to 128MB of 
RAM. If your computer supports 32-bit addressing, your Memory control panel 
will display a section where you can turn this feature on (see Figure 10.1 ). 
You're provided with On and Off buttons because some programs don't 
support 32-bit addressing. 

If your computer is an SE/30 or a member of the Mac II family, you can use 
virtual memory. This means that you can use huge files by having the com­
puter swap parts of the files back and forth to disk. For example, Figure 10.1 
shows the Memory control panel for a computer that has 5MB of RAM, but can 
act as if it had 20MB more, by using available hard disk space. If your computer 
supports virtual memory, you'll see On and Off buttons for this feature in your 
Memory control panel. 
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The use of virtual memory will slow down the operation of your Mac and is 
recommended only when you're working with giant files that need more RAM 
than you have available. 

... 

All Macs have a disk cache area in their Memory control panel under System 7. 
A disk cache is a special area of RAM where an active program can store infor­
mation it needs frequently, thereby speeding up operations. You can't turn this 
feature off, but you can adjust its size. Be aware that a large disk cache may 
make some of your programs run faster, but any memory you allocate to your 
disk cache is not available for other purposes. The default cache size of 128K 
is a good choice if your memory is limited; however, if you have problems 
running multiple applications, you may want to reduce that cache size to 
64K or even 32K. 
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Adjusting Application Memory Size 

Figure 10.2 
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Each application on your Mac requires a minimum amount of memory to 
work properly. If you want to use very large files in a favorite program, you 
may need to increase its memory allocation. For example, to load a fuU-page 
graphics file in a draw or paint program may require this sort of adjustment. 

Here's how to change the memory reserved for an application: 

I. Close the application, if it's open. 

2. Select the icon for the program (not its folder). Don't double­
click on the icon because you don't want to open the program. 

3. Pull down the File menu, and select Get Info. You'll see an Info 
window. The Info window for Microsoft Word is shown in 
Figure 10.2. 

4. In the Memory section at the bottom of the window, the num­
ber shown as Suggested size is the amount of memory the appli­
cation needs in order for all of its features to function. If the 
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Figure 10.3 
Checking application 

memory usage 

program's memory usage has never been adjusted, the Current 
size box will display the same amount of memory. 

5. To change the amount of memory allocated, type a new number 
in the Current size box, then click the close box to close the 
window. 

6. If you want to work in the application, open it in the usual way. 
The changed amount of memory will be available immediately 
(unless your Mac cannot load the program because insufficient 
overall memory is available). 

If you find that you're runnjng out of memory frequently when you want to 
have multiple applications loaded, you may want to reduce the allocated mem­
ory for one or more applications. Howeve~, it's not a good idea to reduce the 
allocation below the Suggested size; the program could crash unexpectedly. 

The amount of memory allocated to a program will be reserved for it whenever 
it's loaded and will not be available for other programs, regardless of whether 
or not a large allocation is currently needed for its operation. You can check 
current memory usage by pulling down the Apple menu and selecting the first 
item, About This Macintosh ... You'll see a graphical representation of the 
amount of memory in use and available for each application. For example, in 
Figure 10.3, the black area of the horizontal bar for Microsoft Excel represents 
the amount of memory actually used at the moment by that program; the gray 
area of the bar represents the remaining memory reserved for the application 
and unavailable for other programs. In this instance, you might think it would 
be wise to reduce the Excel memory allocation because little of it is in use; 

~[J ltbout This' Modntosll ell!! 

Syst•m Softwar• 7 .0 

~ Macintosh lls1 CD IIppi• Compul•r, Inc. 1983-1991 

Total H•mory: 5,120K Lartest Unund Bloclc: 314K .. Microsoft Exoel 1,536K '!:E[Ei!!.'ht £4~!1 IQ 
~ Microsoft 'w'ord 1,024K t,Xc;,: .d 

~ liD System Soft.., art 2,027K . ~- · 

tQi 



Sol ring i\lemory and Other System Problems 

however, 1, 5 36K is the recommended size and is required for some of the 
program's major features . 

PROTECTING AND RECOVERING DATA 
If you don't want to lose data (and who does?), it 's a good idea to back up 
your files frequently. Apple used to provide a backup utility with each copy of 
the operating system, but the company stopped this practice, starting with the 
release of System 7. 

Of course, you can still back up files and folders by copying them: dragging 
their icons onto other disks. A better alternative is to use a commercial backup 
utility, such as those included as part of most file recovery programs. The 
advantage is that these programs let you make selective backups-only certain 
kinds of files or only files that have been changed. The programs can also com­
press backup files so they require less disk storage space and can split large files 
for rejoining later (such as a graphic image that may be too large to be copied 
onto a single floppy disk). 

Even if you do back up files, you will probably be faced some day soon with a 
file that won't open or a disk that has gone bad. 

Using Disk First Aid 
System 7 includes a disk repair utility called Disk First Aid. This is a very simple 
program that may not succeed in repairing your disk and, in fact, could make 
repair by some other utility more difficult if you let it make automatic changes 
through its Repair Automatically command. 

Here's how you use it: 

I. Load the utility. You'll be asked to select a disk for examination. 

2. Select the disk you want checked (it could be a floppy or a hard 
drive), and click the Open button. 

3. When the utility has opened the disk to be tested, click the Start 
button to begin the analysis. You'll see this message: Checking 
disk volume . . .. 
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4. As illustrated in Figure 1 0.4, if Disk First Aid categorizes the 
tested disk as undamaged, you'll see a second message: Fin­
ished. No repair necessa1y. You can then pull down the File 
menu and select the Quit command to return to the desktop, or 
you can select Open Volume ... from the same menu if you want 
to check another available disk or drive. 

5. If the test disk does present a problem, you may obtain an 
advance warning. For example, Figure 10.5 displays a message 
reading Disk with Bad Name-before the disk is even opened! 

6. To have Disk First Aid repair a disk automatically, select the 
Repair Automatically command from the utility's Options menu. 
You may still end up seeing the message shown in Figure 10.6: 
Unable to read from disk. 
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7. When Disk First Aid indicates that a disk is bad, you may be 
able to salvage the disk (but not its data) by selecting the Erase 
Disk . .. command from the Options menu. This command will 
begin reinitialization of the disk. In many instances, the initial­
ization process will fail. 

8. As mentioned in step 4, select the Quit command from the File 
menu to close the utility and return to the desktop. 

Disk First Aid messages can be confusing. For example, one message reads: 
Tbis is not an HFS disk. If you haven't any idea what an HFS disk is, the mes­
sage won't be of much help. (HFS refers to the Mac's Hierarchical File System of 
files and folders , used on all Macintoshes following the early 128K and 512K 
models. Therefore, the message is really saying: This disk is not formatted for 
use on a Macintosb.) 

Using Commercial Recovery Programs 
Commercial recovery programs can usually analyze a file or disk, provide you 
a detailed report as to what's right or wrong about the tested item, then supply 
you with several options for recovery. You may already have such a program, 
which you bought long ago ' 'just in case'' or because of a past crisis. If this 
program does not specifically support System 7, don't use it on any Mac run­
ning under System 7. By using one of these utilities created for use with pre­
vious versions of the operating system, you could easily alter files or disk 
information in such a way that recovery will be impossible. 
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Figure 10.7 
The Rescue main 

menu 

This section will present a few sample screens from Central Point Software's 
MacTools Rescue utility-just to demonstrate typical recovery options and 
procedures. 

Figure 10.7 shows the Rescue main menu, where you can choose to restore 
files deleted unintentionally, repair damaged disks, or repair individual files. 
For example, if you click the Fix Volumes button on this screen and select a 
disk or drive for analysis, Rescue will run checks on the item, providing in­
progress reports as long as the tests show favorable results. As soon as a prob­
lem is encountered, the testing process stops; and you'll see a screen such as 
Figure 10.8, wherein the user is told: An entire block in the extent file is dam­
aged. Symptoms are listed that the error could produce, and you're asked if 
you want to search for files that can be recovered. 

Figure 10.9 shows a search in progress, as Rescue lists files that are candidates 
for recovery, along with their size, an estimate as to how much of the file can 
be recovered , the date (usually not retrievable), and the type of file. 

MacTools® Rescue 

(undelete Files) 

c t ; :=rJ] 
( FIH Uolumes~ • ~~ 

~·~ ( Repair Files ) 

Help----------------------------------------------, 
Hold down the Option key and point to an Item on the screen. A brief me$$ege eppeers 
explei ni ng the purpose of that item. 

for edditionel help, click the question merk end select the epproprlete item. 



Figure 10.8 
A report on disk 

damage 

Figure 10.9 
Searching for files 

that can be recovered 
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Figure 10.10 
Reassigning type and 

crca10r codes 

System 7 uses type and creator codes attached to files for multiple purposes: 
to determine what kind of icon to display, which application should be opened 
when you double-click the file icon, and to help applications find and open 
their own me types. Sometimes when a file or disk is damaged, the recovery 
utility cannot locate or read these codes; it may even assign the wrong codes to 
files. If this happens, you 'II double-click on the file to open it and see a message 
stating that the file can't be opened because the application that created it is not 
available. 

In actuality, that application may be stored within the Mac's system and ready 
for use. If you can reassign the proper type and creator codes to the file, the 
application may be able to open it. 

Recovery programs usually provide a way you can accomplish this reassign­
ment. Figure 10.10 shows the MacTools Rescue feature that lets you reassign 
codes-either from a list supplied , or by typing in the four-letter designations 
yourself. If you don't know the proper codes for a damaged file and you do 
know what kind of a file it actually is and which program created it, you can 
have the utility look at an undamaged file of the same type so you can see the 
codes assigned and copy them down. 

Select the file type from the 11st below. or type 1n 
your own volues for the Type ond Creotor. 

Name: liMemory dialog I 
MacDrefl PICT <1-

Type: IPICT I MocDr6fl PICT m 
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Many experts believe that the Norton Utilities for the Macintosh is currently the 
most powerful and comprehensive data and disk recovery utility for Macs run­
ning under System 7. It supports balloon help and multiple-user access across 
networks. 

FIGHTING VIRUSES ON YOUR MACINTOSH 

Figure I 0. 1 I 
SAM checks 

hard drives for 
viruses 

Computer viruses, as most Mac users know, are files created by people with 
twisted minds with the objective of destroying your data. If you download files 
from public bulletin boards or use programs acquired from friends or acquaint­
ances, you're particularly vulnerable to virus infection. 

Some viruses are designed to alter your System file so that your data will start dis­
appearing. Others add special instructions to a file, or create a new Startup file. 

One of the best System 7 anti-virus programs is SAM (Symantec AntiVirus for 
Macintosh). It can check your system for viruses, remove any it finds, repair 
damaged files in some cases, then maintain a watch so that it catches future 
viruses and destroys them before they can cause any d~mage. 

Figure 10.1 1 shows SAM in action as it scans the drives of a system looking for 
viruses. 

Macintosh HD 
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A 
Abaton scanners, 211 , 212 
About This Macintosh command, 7-9, 

40-41, 222 
accessories. See desk accessories (DAs) 
active window, 38, 41 
Adobe Illustrator, 125 
Adobe Photoshop, 211 
Adobe PostScript typefaces, 110, 

135-139, 142 
Adobe Type Manager, 68, 136, 142 

Adobe Type Reunion , 137, 139 
Adobe TypeAlign, 125 
After Dark, 200-202 

Alarm Clock, 21-23 
Aldus Fontographer, 12 5 
Aldus PageMaker, 125 

alert sound, 89-90, 183, 185 
aliases, 28, 47- 49 

Apple File Exchange, 144, 169-175 
Apple menu, 7, 20-25 
Apple StyleWriter, 64-66 
AppleShare, 9, 145 
AppleTalk, 9, 10, 51, 60 
Application menu , 35-36, 39-40 
applications 

adjusting memory size for, 221-223 
compatibility with System 7, 

202-203 
installing, 41-4 3 
multiple, 38-41 

opening, 39, 43- 49 
sharing on networks, 166-168 
sound in, 196 

Athens typeface, 131 , 132, 134.135 
Audio Palette, 190 

Editbutton, 191-193 
Record button , 190 

B 
background printing, 60, 61-62 
balloon help, 34-35 

BigCaps desk accessory, 129-130 
binary file format , 169 
bitmapped typefaces, 55, 110, 117, 

121, 123 
blinking rate, 86 
boldface type, 11 4, 115 

Broderbund TypeStyler, 125 

c 
cache cards, 215, 216. See also disk 

cache 
Cairo typeface, 131 , 133 
Calculator desk accessory, 23 
cards, multi-function, 214- 216 
CD Remote desk accessory, 208 
CD-ROM drives, 208- 209 
CD-ROM Setup disk, 208-209 
CDEVs, 3, 17. See also control panels 
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characters 
extra, 128-130 
repeating, 91 
special, 128-1 30 

Chicago typeface, 118, 119 
Chooser, 9, 12 

accessing networked Macs, 
150-153 

alert messages in, 62-63 
selecting printer, 10-1 1, 60, 61-62 

Clean Up Window command, 32 
Clear Sound command, 193 
clipboard, 51 
Close Window command, 26 
CloseView control panel, 99-101 
cold boot, 33 
Color control panel, 93-95 
color wheel, 93, 94 
colored folders, 49 
colors in desktop pattern, 87-88 
ColorStudio , 211 
compact-disk players, 208-209 
Compatibility Checker, 4 
computer viruses, 229 
control devices (CDEVs), 3. 17 
control panels, 3, 12, 13, 86 

After Dark, 200-202 
Close View, 99- 1 0 I 
Color, 93-95 
Easy Access, 97-99 
File Sharing Monitor, 145, 159-163 
General Controls, 86-88 
Keyboard, 91-92 
Labels, 92-93 
Map,95-96 
Memory, 219-220 
Moni tors, 11 , 13-15,2 13 

Mouse, 90-91 
for networking, 145- 148 
Sharing Setup, 145 , 146-147, 

149, 168 
Sound, 89-90, 182-187 
SoundMaster, 197- I 98 
Starrup Disk, 88-89, 205, 206 
Users & Groups, 145, 147- 148, 

155-158, 168 
Views, 101-104 

Control Panels command, 12, 86 
Courier typeface, 118, 119 
Create Publisher ... command, 176 
Customize option , 5 

D 
DAs. See desk accessories (DAs) 
date, setting, 23, 86 
DCA·RFT file format, 169 
decorative typefaces, 11 2, 113 
DesignStudio, 203 
desk accessories (DAs), 2, 20-21 

Alarm Clock, 21-23 
BigCaps, 129-130 
Calculator, 23 
CD Remote, 208 
conflicts among, 15-18 
Key Caps, 128- 129 
Note Pad, 23-24 
Puzzle, 25 
relocating, 17-18 
ScanDo, 211, 212 

desktop, 20 
arranging icons on, 101- 102 
changing pattern of, 86-88 
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creating icons for, 104- 107 
fonts on, 102-104 

disk cache, 220. See also cache cards 
Disk First Aid utility, 223-225 
disks, repairing, 223-225 
dot-matrix printers, 66-68 
double-clicking mouse, 91 
Duplicate command, 28 

E 
Easy Access control pl\nel, 97-99 
Easy Install option, 5 
Edit menu, 30 
Editions folder 
creating, 176 
sharing, 178 

Eject Disk command, 33 
Empty Folder command. See New 

Folder command 
Empty Trash . . . command, 32- 33 
Epson scanners, 211 , 21 2 
Erase Disk . . . command, 33, 225 
Exotic typeface, 115- 117 
expansion slots, 213, 2 14 
Exposure Pro, 82-83 
extended keyboard, 3- 4 

F 
fanfold paper, 67 
file formats, 44, 169- 174 
File menu, 25-30 
file servers, 14 5 
File Sharing Monitor control panel, 

145, 159-163 

filenames, Mac vs. MS-DOS, 173-174 
files 

backing up, 223 
controlling network access to, 

161- 162 
listing, 16 
opening, 43-49 
renaming Mac files for MS-DOS, 

173- 174 
translating, 169- 174 
viewing, 30-31 

Find . . . command, 28-30 
Finder, 26 
floppy disks, formatting for 

MS-DOS, 174 
folders 

changing ownership of, 163-164 
colored, 49 
listing contents of, 15-16 
opening, 43 
restricting network access to, 

161-163 
selecting, 49- 51 
sharing, 148-150, 159 
status of, 49-51 
sub-folders in, 16-17 
viewing, 30-3 1 

Fom/DA Juggler, 125 
Font/DA Mover, 119, 126, 127 
FontMonger, 142 
Fontographer, 12 5 
fonts. See also typefaces 

on desktop, 102-104 
installing, 119-12 I 
LaserWriter Font Utility, 73-76 
vs. typefaces, 110- 111 

FontStudio, 125, 142 
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formatting MS-DOS disks, 174 
FrameMaker, 203 

G 
General Controls panel, 86-88 
Geneva typeface, 118, 119 
Get Info command, 27, 105, 22 1 
guests, 147, 152, 155 

H 
hand-held scanners, 210 
hard drives 

assigning SCSI ID numbers to, 204 
designating startup drive, 205, 206 
external, 88-89, 205-206 
installing applications on, 42-43 
interleave ratio of, 206-208 
multiple, 88-89 
naming, 206 
partitioning, 207 
removable, 205 
required for System 7, 2 

Help menu, 33-35 
Helvetica typeface, 11 3, 118, 119, 

131, 134 , 135 
HFS disks, 225 
Hide command, 35 
Hierarchical File System (HFS) 

disks, 225 
Highlight Color option, 93, 94-95 
HyperCard, 4 

editingsoundln, 191- 193 

I 

recording sound in, 189- 190 
using sound in, 188-189 

icons 
arranging on desktop, 101 -102 
creating, 104-107 

ImageStudio, 211 
ImageWriters, 10, 66 

Page Setup dialog box, 66- 67 
Print dialog box, 67-68 

impact printers, 66 
initialization programs (I NITs), 2- 3, 17 
!NITs. See initialization programs 

(!NITs) 
inkjet printers, 64-66' 
installing 

applications, 41- 43 
printer drivers, 77-79 
System 7, 4-6 

interleave ratio, 206-208 
italic type, 114, 115 

K 
kerning, 127, 128 
Key Caps desk accessory, 128-1 29 
Keyboard control panel, 91-92 
Keyboard Shortcuts option , 99, 100 
keyboards, 3- 4 

command shortcuts, 26 
Mouse Keys option, 98-99 
repeating characters on, 91 
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Slow Keys option, 98 
Sticky Keys option, 97 
switching active layouts, 91 

L 
Label menu, 31-32 
Labels control panel, 92-93 
laser printers. See LaserWriters 
LaserWriter Font Utility, 73 

Edit menu, 76 
File menu, 74-75 
installing, 7 3-7 4 
Utilities menu, 76 

LaserWriter Options dialog box, 72 
LaserWriters, 9, 10, 11 , 60, 61. See 

also Personal LaserWriter LS 
and font substitution, 119 
Page Setup dialog box, 70-72 
and PostScript, 70-73 
Print dialog box, 72-73 
replacing printer drivers, 77-79 
sharing, 144-14 5 

Letraset. See ColorStudio; FontStudio; 
ImageStudio 

linking, 167-168. See also 
publish/subscribe feature 

Local Talk, 144, 164 
London typeface, 131 , 132 
Los Angeles typeface, 131, 132 

M 
Macintosh 

About This Macintosh command, 
7-9,40-41 , 222 

connecting to networks, 145- I48 

expanding,2I4-216 
as file server, 14 5 
speeding up, 214-215 
System 7 requirements, 2-4 

MacRecorqer, 186-187. See also 
SoundEdit 

MacTools Rescue utility, 226-228 
MacWrite Pro, 69-70 
Make Alias command, 28 
Map control panel, 95-96 
Master Juggler, 125 
memory 

adding, 218-219 
and applications, 40-41, 22 I -223 
checking, 7- 9 
~unning out of, 40-41 
SIMMs, 219 
System 7 requirements, 2-3 
virtual, 219-220 

Memory control panel, 219-220 
Metropolitan typeface, I 13 
Microsoft Word, 125 
Mistral typeface, 113-114 
Monaco typeface, 118, 119 
monitors. See also screens 

configuring, 11-15 
large-screen, 212-214 
multiple, 11 , 12,14 

Monitors control panel, 11 , 
13-15, 213 

monospaced typefaces, 111-112 
mouse, moving, 90-91 
Mouse control panel, 90-91 
M?use Keys option, 98-99 
MS-DOS computers 

exchanging Mac files with, 169-174 
fqrmatting floppy disks for, 17 4 
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renaming Mac files for, 17 3-17 4 
multi-function cards, 214-216 
MultiFinder, 38 
multiple applications, 38-41 
multiple monitors, 11, 12, 14 
multiple printers, 60-61 

N 
naming. See renaming 
networks, 144-14 5 

adding users to, 155-158 
CD-ROM drives on, 209 
controlling shared access on, 

155-168 
printers on, 61 , 144-145 
sharing applications on, 166-168 
sharing files on, 145-154 
shutdown on, 164-166 
terminating access to, 160, 165 
viewing multiple Mac screens, 

178-179 
New Folder command, 26 
New York typeface, 118, 119 
Norton Utilities, 229 
Note Pad, 23-24 

0 
Open command, 26 
operating systems, differing versions 

of, 76-79 
optical character reading (OCR), 210 
Options dialog box, 14-15 

p 

Page Setup . .. command, 63 
Page Setup dialog box 

for Image Writers, 66-67 
for LaserWriters, 70-72 
for Personal LaserWriter LS , 68, 69 
for Style Writer, 65 

PageMaker, 125 
Palatino typeface, 117, 118, 119 
paper, fanfold, 67 
partitioning hard drives, 207 
passwords, 152, 155, 156-157 
Peignot typeface. See Exotic typeface 
Personal LaserWriter LS, 68-70 

Page Setup dialog box, 68, 69 
Print dialog box, 68-70 

PICT files, 44-45 
points (unit of measure), 111 
ports, 10, 187-188 
PostScript printers, 70-73 
PostScripttypefaces, 123, 124, 125, 

135-139, 142 
PowerCard, 215 
Precision Bitmap Alignment option, 68 
Print command, 26, 63 
Print Desktop .. . command, 81-82 
Print dialog box, 63- 64, 66 

for ImageWriters, 67-68 
for LaserWriters, 72- 73 
in MacWrite Pro, 69-70 
in Microsoft Word, 64 
for Personal LaserWriter LS, 63-64, 

68-70 
for Style Writer, 65-66 

Print Window . . . command, 82 
printer drivers, 10, 11 , 71 

and earlier operating systems, 77 
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installing, 77- 79 
printers 

and differing operating systems, 
76- 79 

dot-matrix, 66-68 
ImageWriters, 66-68 
inkjet, 64-66 
LaserWriters, 68-79 
multiple, 60-61 
on networks, 61, 144-1 45 
PostScript, 70-7 3 
selecting, 9-11 
sharing, 144-14 5 
StyleWriter, 64-66 
switching, 62 

priming. See also Print dialog box 
background,61-62 
canceling, 80 
screen contents, 81- 83 

PrintMonitor, 61 , 79-81 , 144 
programs. See applications 
proportional typefaces, 111, 112 
publish/subscribe feature, 175-178 
Publisher Options command, 178 
Publishing .. . command, 176 
Put Away command, 28 
Puzzle, 25 

Q 
QuadraLink card, 215- 216 
QuickSilver multi-function card, 215 
QuickTime, 196- 197 
Quit command, 41 

R 
RAM . See memory 
README files, 44 
rebooting, 33 
Record dialog box, 184 
registered users, 152, 155-158 
renaming 

hard drives, 206 
Mac files for MS-DOS computers, 

173-174 
repeating characters, 91 
Rescue utility, 226-228 
Restart command, 33 

s 
SAM (Symantec AntiVirus for 

Macintosh), 229 
San Francisco typeface, 131, 132 
sans-serif typefaces, 112, 113 
ScanDo desk accessory, 211, 212 
scanners, 209- 212 
Scrapbook, 51-54 
screen savers, 200-202 
screens. See also monitors 

capturing, 81-83 
enlarging part of, 99-10 1 
large, 212- 214 
look of, 6-7 
printing, 81-83 
protecting, 200-202 
viewing multiple, 178-179 

script typefaces, 112-11 3 
SCSI devices, 203 

assigning ID numbers to, 203-204 
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daisy-chaining, 203, 204-205 
serial ports, 187, 188,215-216 
serif typefaces, 112, 113 
Sharing ... command, 27, 148- 150, 

163-164 
Sharing Setup control panel, 145 , 

146-147, 149, 168 
Show All command, 36 
Show User Log option, 172 
Shut Down command, 33 
shutting down, 33, 164-166 
SIMMs, 219 
Size menu, 131, 134 
Slow Keys option, 98 
Small Computer System Interface 

(SCSI) devices, 203- 205 
SmanAn, 125 
Software Bridge, 171-172 
Sound control panel, 89-90, 182-187 
sound options, 89-90 
sound recording, 182-198 
SoundEdit, 194- 195 
SoundMaster control panel, 197- 198 
sounds 

editing in HyperCard, 191- 193 
editing with SoundEdit, 194-195 
in HyperCard, 188-189 
playing, 185-186 
recording, 184-185 
recording in HyperCard, 189-190 
removing, 186 
using in applications, 196 

Special menu, 32- 33 
Startup Disk control panel, 88-89, 

205,206 
Startup Items sub-folder, 47, 49 
Sticky Keys option, 97 

Style menu, 114 
Style Writer, 64 

Page Setup dialog box, 65 
Print dialog box, 65-66 

sub-folders, 16-17 
Subscribe ... command, 177 
Suitcase II, 17, 125-126, 137, 138, 139 
suitcases, 17-18 
SuperDrive, 169 
SuperScrap, 54 
Symantec AntiVirus for Macintosh 

(SAM), 229 
Symbol typeface, 118, 119 
System 7 

compatibility of applications, 
202- 203 

vs. earlier operating systems, 76-79 
hardware requirements for, 2-4 
hidden typefaces, 110, 130-135 
installing, 4- 6 
memory requirements, 2- 3 
menus, 20-36 
typefaces installed with, 110, 

117-124 
System folder 

and DAs, 17 
deleting extras, 88-89 
moving files within, 15-17 
and older utilities, 17 

T 
Teach Text, 35 , 44-45 
terminating devices, 204-205 
text files, exchanging, 169 
32-bit addressing, 219 
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Timbukcu utility, 179 
time, setting, 22, 23, 86 
Times typeface, 113, 118, 119 

translator files, 169, 17 1 
True Type typefaces, 55 . 67 , 68, 110, 

111-112, 117, 118, 135 
problems with, 124-130 
storing, 121-123 

typefaces, 54-57 , 110 

Adobe, 110, 135-1 39, 142 

bitmapped, 55 
on desktop, 102-1 04 
extra characters in, 128-130 
vs. fonts, 110-111 

hidden, 110, 130-135 
installing, 119-121 
obtaining, 140 
selecting, 119, 140-1 41 

sizes in, 13 1, 134 
style attributes for, 114-117 

Truetype, 55 
viewing samples of, 121 , 123- 124 

TypeStyler, 125 

u 
user log, 172-173 
Users & Groups control panel, 145, 

147- 148, 155-158, 168 

utilities 
conflicts among, 15- 18 

relocating, 17 

v 
Venice typeface, 131 , 132 
Ventura Publisher, 126, 127, 128 
View menu, 16, 30-3 1 
Views control panel, 101-104 

virtual memory, 219-220 
viruses, 229 
Voice Link, 188 

w 
warm boot, 33 
Window Color option, 93- 94 
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APPLE/MACINTOSH 

ABC's of Excel on the Macintosh 
(Second Edition) 
Douglas Hergert 
334pp. Ref. 634-0 
Newly updated to include version 2.2, this 
tutorial offers a quick way for beginners to 
get started doing useful work with Excel. 
Readers build practical examples for 
accounting, management, and home/ 
office applications, as they learn to create 
worksheets, charts, databases, macros, 
and more. 

Desktop Publishing with 
Microsoft Word on the 
Macintosh 
(Second Edition) 
Tim Erickson 
William Flnzer 
525pp. Ref. 601-4 
The authors have woven a murder mys­
tery through the text. using the sample 
publications as clues. Explanations of 
page layout, headings, fonts and styles, 
columnar text, and graphics are interwo· 
ven within the mystery theme of this excit· 
ing teaching method. For Version 4.0. 

Encyclopedia Macintosh 
Craig Oanuloff 
Deke McClelland 
650pp. Ref. 628·6 
Just what every Mac user needs-a com­
plete reference to Macintosh concepts 
and tips on system software. hardware, 
applications, and troubleshooting. In· 
stead of chapters. each section is pre­
sented in A·Z format with user-friendly 
icons leading the way. 

Encyclopedia Macintosh 
Software Instant Reference 
Craig Danuloff 
Deke McClelland 
243pp. Ref.753·3 
Help yourself to complete keyboard short· 
cut charts, menu maps, and tip lists for all 
popular Macintosh applications. This 
handy reference guide is divided into 
functional software categories, including 
painting, drawing, page layout, spread­
sheets, word processors, and more. 

Mastering Adobe Illustrator 
David A. Holzgang 
330pp. Ret. 463·1 
This text provides a complete introduction 
to Adobe Illustrator, bringing new sophisti· 
cation to artists using computer-aided 
graphics and page design technology. 
Includes a look at PostScript, the page 
composition language used by Illustrator. 

Mastering AppleWorks 
(Second Edition) 
Elna Tymes 
479pp. Ret. 398·8 
New chapters on business applications, 
data sharing DIF and Applesoft BASIC 
make this practical , in-depth tutorial even 
better. Full details on AppleWorks 
desktop, word processing, spreadsheet 
and database functions. 

Mastering Excel 
on the Macintosh 
(Third Edition) 
Carl Townsend 
656pp. Ref. 622-7 
This highly acclaimed tutorial has been 
updated tor the latest version of Excel. 



Full of extensive examples. tips, applica­
tion templates, and illustrations. This book 
makes a great reference for using work­
sheets, databases, graphics. charts, 
macros, and tables. For Version 2.2. 

Mastering Microsoft Word on 
the Macintosh 
Michael J. Young 
44 7pp. Ref. 541-7 
This comprehensive, step-by-step guide 
shows the reader through WORD's exten­
sive capabilities, from basic editing to cus­
tom formats and desktop publishing. 
Keyboard and mouse instructions and 
practice exercises are included. For 
Release 4.0. 

Mastering PageMaker 4 on the 
Macintosh 
Greg Harvey 
Shane Gearing 
421pp. Ref.433-X 
A complete introduction to desktop 
publishing-from planning to printing­
with emphasis on business projects. 
Explore the tools, concepts and tech­
niques of page design, while learning to 
use PageMaker. Practical examples 
include newsletters, forms, books, man­
uals, logos, and more. 

Mastering Powerpoint 
Karen L. McGraw, Ph.D. 
425pp. Ref. 646-4 
The complete guide to creating high­
quality graphic presentations using 
PowerPoint 2.01 on the Macintosh­
offering detailed, step,by-step coverage 
of everything from starting up the soft­
ware to fine-tuning your slide shows for 
maximum effect. 

Mastering Ready, Set, Go! 
David A. Kater 
482pp. Ref. 536-0 
This hands-on introduction to the popular 
desktop publishing package for the Mac­
intosh allows readers to produce 
professional-looking reports, brochures, 
and flyers. Written for Version 4, this title 
has been endorsed by Letraset, the 
Ready, Set, Go! software publisher. 

PageMaker 4.0 Macintosh 
Version Instant Reference 
Louis Columbus 
120pp. Ref. 788-6 
Here 's a concise, plain-language refer­
ence, offering fast access to details on all 
PageMaker 4.0 features and commands. 
Entries are organized by function­
perfect for on-the-job use-and provide 
exact keystrokes, options, and cross­
references, and instructions for all essen­
tial desktop publishing operations. 

Up & Running with PageMaker 
on the Macintosh 
Craig Danuloff 
134pp. Ref. 695-2 
Ideal for computer-literate users who 
need to learn PageMaker fast. In just 
twenty steps, readers learn to import text, 
format characters and paragraphs, create 
graphics, use style sheets, work with 
color. and more. 

Understanding Hard Disk 
Management on the Macintosh 
J. Russell Roberts 
334pp. Ref. 579-4 
This is the most comprehensive and acces­
sible guide to hard disk usage for all Mac­
intosh users. Complete coverage includes 
SCSI and serial drives and ports, formatting, 
file fragmentation, backups, networks, and a 
helpful diagnostic appendix. 

Up & Running with Norton 
Utilities on the Macintosh 
Peter Dyson 
146pp. Ref. 823-8 
In just 20 lessons, you can be up and run­
ning with Norton Utilities for the Macintosh. 
You'll soon learn to retrieve accidentally 
erased files, reconstruct damaged files, find 
"lost files," unformat accidentally formatted 
disks, and make your system work faster. 

Using the Macintosh 
Toolbox with C 
(Second Edition) 
Fred A. Huxham 
David Burnard 



Jim Takatsuka 
525pp. Ref. 572-7 
Learn to program with the latest versions 
of Macintosh Toolbox using this clear and 
succinct introduction. This popular title 
has been revised and expanded to 
include dozens of new programming 
examples for windows, menus, controls, 
alert boxes, and disk 1/0. Includes hier­
archical fi le system, Lightspeed C, 
Resource files. and R Maker. 

COMMUNICATIONS 

Mastering Crosstalk XVI 
(Second Edition) 
Peter W. Gotten 
225pp. Ref. 642-1 
Introducing the communications program 
Crosstalk XVI for the IBM PC. As well as 
providing extensive examples of com­
mand and script files for programming 
Crosstalk, this book includes a detailed 
description of how to use the program's 
more advanced features, such as win­
dows, talking to mini or mainframe, cus­
tomizing the keyboard and answering 
calls and background mode. 

Mastering PROCOMM PLUS 
Bob Campbell 
400pp. Ref. 657 -X 
Learn all about communications and infor­
mation retrieval as you master and use 
PROCOMM PLUS. Topics indude choosing 
and using a modem: automatic dialing: 
using on-line services (featuring Compu­
Serve), and more. Through Version 1.1 b; 
also covers PROCOMM, the "shareware" 
version. 

Mastering Serial 
Communications 
Peter W. Gotten 
289pp. Ref. 180-2 
The software side of communications, 
with details on the IBM PC's serial pro­
gramming, the XMODEM and Kermit 
protocols, non-ASCII data transfer, 
interrupt-level programming, and more. 

Sample programs in C, assembly lan­
guage and BASIC. 

Mastering UNIX Serial 
Communications 
Peter W. Gofton 
307pp. Ref. 708-8 
The complete guide to serial communica­
tions under UNIX. Part I introduces essen­
tial concepts and techniques, while Part II 
explores UNIX ports, drivers, and utilities, 
including MAIL, UUCP. and others. Part Ill 
is for C programmers, with six in-depth 
chapters on communications program­
ming under UNIX. 

Up & Running with PROCOMM 
PLUS . 

Bob Ca~pbt~ll 
134pp. Ref. 794-0 
Get a fast-paced overview of telecommuni­
Cations with PROCOMM PLUS, in just 20 
steps. Each step takes only 15 minutes to an 
hour to complete, covering the essentials of 
installing and running the software, setting 
parameters, dialing, connecting with and 
using an online service, sending and receiv­
ing files, using macros and scripts, and 
operating a bulletin board. 

NETWORKS 

The ABC's of Local Area 
Networks 
Michael Dortch 
212pp. Ref. 664-2 
This jargon-free introduction to LANs is for 
current and prospective users who see gen­
eral information, comparative options, a look 
at the future, and tips for effective LANs use 
today. With comparisons of Token-Ring, PC 
Network, Novell, and others. 

The ABC's of Novell NetWare 
Jeff Woodward 
282pp. Ref. 614-6 
For users who are new to PC's or net­
works, this entry-level tutorial outlines 
each basic element and operation of 



Novell. The ABC's introduces computer 
hardware and software, DOS, network 
organization and security, and printing 
and communicating over the netware 
system. 

Mastering Novell NetWare 
Cheryl C. Currid 
Craig A. Gillett 
500pp. Ref. 630·8 
This book is a thorough guide for System 
Administrators tp installing and operating 
a microcomputer network using Novell 
Netware. Mastering covers actually set· 
ting up a network from start to finish, 
design, administration, maintenance, and 
troubleshooting. 

OPERATING SYSTEMS 

The ABC's of DOS 4 
Alan R. Miller 
275pp. Ref. 583-2 
This ~tep-by-step introduction to using 
DOS 4 is written especially for beginners. 
Filled with simple examples, The ABC~ of 
DOS 4 covers the basics of hardware. 
software, disks, the system editor EDLIN, 
DOS commands, and more. 

The A~C's of DOS 5 
Alan Miller 
267pp. Ref. 770-3 
This straightforward guide will haven even 
first-time computer users working com­
fortably wjth DOS 5 in no time. Step-by· 
step lessons lead users from switching on 
the PC, through exploring the DOS Shell. 
working with ·directories and files, using 
essential commands, customizing the sys­
tem, and trouble shooting. Includes a 
tear-out quick reference card and func­
tion key template. 

ABC's of MS-DOS 
(Second Edition) 
Alan R. Miller 
233pp. Ref. 493·3 
This handy guide to MS-DOS is all many 
PC users need to manage their computer 
files, organize floppy and hard disks, use 

EDLIN, and keep their computers orga­
nized. Additional information is given 
about utilities like Sidekick, and there is a 
DOS command and program summary. 
The second edition is fully updated for 
Version 3.3. 

The ABC's of SCO UNIX 
Tom Cuthbertson 
263pp. Re. 715·0 
A guide especially for beginners who 
want to get to work fast. Includes hands­
on tutorials on logging in and out; creal· 
ing and editing files; using electronic mail; 
organizing files into directories; printing; 
text formatting; and more. 

The ABC's of Windows 3.0 
Krls Jamsa 
327pp. Ref. 760·6 
A user-friendly introduction to the essen­
tials of Windows 3.0. Presented in 64 
short lessons. Beginners start with lesson 
one. while more advanced readers can 
skip ahead. Learn to use File Manager, 
the accessory programs, customization 
features, Program Manager, and more. 

DESQvlew Instant Reference 
Paul J. Perry 
175pp. Ref. 809·2 
This complete quick-reference command 
guide covers version 2.3 and DESQview 
386, as well as QEMM (for managing 
expanded memory) and Manifest Mem· 
ory Analyzer. Concise, alphabetized 
entries provide exact syntax, options, 
usage, and brief examples for every com­
mand. A handy source for on-the-job 
reminders and tips. 

DOS 3.3 On-Line Advisor 
Version 1.1 
SVBAR, Software Division of 
SVBEX, Inc. 
Ref. 933·1 
The answer to all your DOS problems. 
The DOS On-Line Advisor is an on-screen 
reference that explains over 200 DOS 
error messages. 2300 other citations 
cover all you ever needed to know about 
DOS. The DOS On·Line Advisor pops up 
on top of your working program to give 



you quick, easy help when you need it, 
and disappears when you don't. Covers 
thru version 3.3. Software package 
comes with 31/2" and 51/•" disks. System 
Requirements: IBM compatible with DOS 
2.0 or higher, runs with Windows 3.0, 
uses 90K of RAM. 

DOS Instant Reference 
SVBEX Prompter Series 
Greg Harvey 
Kay Yarborough Nelson 
220pp. Ref. 477-1 
A complete fingertip reference for fast, easy 
on-line help:command summaries, syntax, 
usage and error messages. Organized by 
function-system commands, file com· 
mands, disk management, directories, 
batch files, 1/0, networking, programming, 
and more. Through Version 3.3. 

DOS 5 Instant Reference 
Robert M. Thomas 
200pp. Ref. 804-1 
The comprehensive quick guide to 
DOS- all its features, commands, 
options, and versions- now including 
DOS 5, with the new graphical interface. 
Concise, alphabetized command entries 
provide exact syntax. options, usage, 
brief examples, and applicable version 
numbers. Fully cross-referenced; ideal for 
quick review or on-the-job reference. 

The DOS 5 User's Handbook 
Gary Masters 
Richard Allen King 
400pp. Ref. 777-0 
This is the DOS 5 book for users who are 
already familiar with an earlier version of 
DOS. Part I is a quick, friendly guide to 
new features; topics include the graphical 
interface, new and enhanced commands, 
and much more. Part II is a complete 
DOS 5 quick reference, with command 
summaries, in-depth explanations, and 
examples. 

Encyclopedia DOS 
Judd Robbins 
1 030pp. Ref. 699-5 
A comprehensive reference and user's 
guide to all versions of DOS through 4.0. 

Offers complete information on every 
DOS command, with all possible switches 
and parameters- plus examples of effec­
tive usage. An invaluable tool. 

Essential OS/2 
(Second Edition) 
Judd Robbins 
445pp. Ref. 609-X 
Written by an OS/2 expert, this is the 
guide to the powerful new resources of 
the OS/2 operating system standard edi­
tion 1 . 1 with presentation manager. Rob­
bins introduces the standard edition, and 
details multitasking under OS/2, and the 
range of commands for installing, starting 
up, configuring, and running applications. 
For Version 1 .1 Standard Edition. 

Essential PC-DOS 
(Second Edition) 
Myrll Clement Shaw 
Susan Soltis Shaw 
332pp. Ref. 413-5 
An authoritative guide to PC-DOS, including 
version 3.2. Designed to make experts out 
of beginners, it explores everything from 
disk management to batch file program· 
ming. lndudes an 85-page command sum· 
mary. Through Version 3.2. 

Graphics Programming 
Under Windows 
Brian Myers 
Chris Doner 
646pp. Ref. 448-8 
Straightforward discussion, abundant 
examples, and a concise reference guide 
to graphics commands make this book a 
must for Windows programmers. Topics 
range from how Windows works to pro­
gramming for business, animation, CAD, 
and desktop publishing. For Version 2. 

Hard Disk Instant Reference 
SYBEX Prompter Series 
Judd Robbins 
256pp. Ref. 587·5 
Compact yet comprehensive, this pocket­
sized reference presents the essential infor­
mation on DOS commands used in 
managing directories and files, and in opti· 



mizing disk configuration. lndudes a survey 
of third-party utility capabilities. Through 
DOS 4.0. 

Inside DOS: A Programmer's 
Guide 
Michael J. Young 
490pp. Ref. 710-X 
A collection of practical techniques (with 
source code listings) designed to help you 
take advantage of the rich resources intrin­
sic to MS-DOS machines. Designed for the 
experienced programmer with a basic 
understanding of C and 8086 assembly lan­
guage, and DOS fundamentals. 

Mastering DOS 
(Second Edition) 
Judd Robbins 
722pp. Ref. 555·7 
"The most useful DOS book." This seven­
part, in-depth tutorial addresses the 
needs of users at all levels. Topics range 
from running applications, to managing 
files and directories, configuring the sys· 
tern. batch file programming. and tech· 
niques for system developers. Through 
Version 4. 

Mastering DOS 5 
Judd Robbins 
800pp. Ref.767·3 
"The DOS reference to keep next to your 
computer," according to PC Week, this 
highly acclaimed text is now revised and 
expanded for DOS 5. Comprehensive 
tutorials cover everything from fi rst steps 
for beginners, to advanced tools for sys· 
terns developers-with emphasis on the 
new graphics interface. Includes tips, 
tricks, and a tear-out quick reference card 
and function key template. 

1\!lastering SunOS 
Brent D. Heslop 
David Angell 
588pp. Ref. 683·9 
Learn to configure and manage your sys· 
tern; use essential commands; manage files; 
perform editing, formatting, and prinling 
tasks; master E-mail and external communi­
cation; and use the SunView and new Open 
Window graphic interfaces. 

Mastering Windows 3.0 
Robert Cowart 
592pp. Ref.458·5 
Every Windows user will find valuable 
how-to and reference information here. 
With full details on the desktop utilities; 
manipulating files; running applications 
(including non-Windows programs); shar· 
ing data between DOS, OS/2, and Win· 
dows; hardware and software efficiency 
tips; and more. 

Understanding DOS 3.3 
Judd Robbins 
678pp. Ref. 648-0 
This best selling, in-depth tutorial 
addresses the needs of users at all levels 
with many examples and hands-on exer­
cises. Robbins discusses the fundamen· 
tals of DOS, then covers manipulating 
files and direclories, using the DOS editor, 
printing, communicating, and finishes 
with a full section on batch files. 

Understanding Hard Disk 
Management on the PC 
Jonathan Kamin 
500pp. Ref. 561 ·1 
This lille is a key productivily tool for all 
hard disk users who want efficient, error­
free file management and organization. 
Includes details on the besl ways to con­
serve hard disk space when using several 
memory-guzzling programs. Through 
DOS 4. 

Up & Running with DR DOS 5.0 
Joerg Schieb 
130pp. Ref. 815·7 
Enjoy a fast-paced. but thorough intra· 
duclion to DR DOS 5.0. In only 20 steps, 
you can begin to obtain practical results: 
copy and delete files, password prolect 
your data, use batch files to save time. 
and more. 

Up & Running with DOS 3.3 
Michael-Alexander Belsecker 
126pp. Ref. 750-9 
Learn the fundamentals of DOS 3.3 in just 
20 basic steps. Each "slep" is a self· 
contained, time-coded lesson, taking 15 



minutes to an hour to complete. You learn 
the essentials in record time. 

Up & Running with DOS 5 
Alan Simpson 
150pp. Ref. 77 4·6 
A 20-step guide to the essentials of DOS 
5-for busy users seeking a fast-paced 
overview. Steps take only minutes to com· 
plete, and each is marked with a timer 
clock, so you know how long each one 
will take. Topics include installation, the 
DOS Shell, Program Manager. d isks, 
directories. utilities, customization. batch 
files, ports and devices, DOSKEY, mem· 
ory, Windows, and BASIC. 

Up & Running 
with Your Hard Disk 
Klaus M Rubsam 
140pp. Ref. 666-9 
A far-sighted, compact introduction to 
hard disk installation and basic DOS use. 
Perfect for PC users who want the practi· 
cal essentials in the shortest possible time. 
In 20 basic steps, learn to choose your 
hard disk, work with accessories. back 
up data, use DOS utilities to save time, 
and more. 

Up & Running with Windows 
286/386 
Gabriele Wentges 
132pp. Ref. 691-X 
This handy 20-step overview gives PC 
users all the essentials of using Win· 
dews- whether for evaluating the soft· 
ware, or getting a fast start. Each self· 
contained lesson takes just 15 minutes to 
one hour to complete. 

Up & Running with Windows 3.0 
Gabriele Wentges 
117pp. Ref. 71 1·8 
All the essentials of Windows 3.0 in just 
twenty " steps"- self-contained lessons 
that take minutes to complete. Perfect for 
evaluating the software or getting a quick 
start with the new environment. Topics 
include installation, managing windows, 
using keyboard and mouse. using 
desktop utilities, and built-in programs. 

Windows 3.0 Instant Reference 
Marshall Moseley 
195pp. Ref. 757-6 
This concise. comprehensive pocket ref· 
erence provides quick access to instruc· 
lions on all Windows 3.0 mouse and 
keyboard commands. It features step-by· 
step instructions on using Windows. the 
applications that come bundled with it, 
and Windows' unique help facilities. Great 
for all levels of expertise. 

APPLICATION 
DEVELOPMENT 

The ABC's of TooiBook for 
Windows 
Kenyon Brown 
300pp. Ref. 795·9 
Gain the skill and confidence you need to 
create sophisticated applications for Win· 
dows. This hands-on introduction teaches 
you how to build custom graphical appli· 
cations, without the need for traditional 
computer language. Learn to use the 
Script Recorder to create scripts and add 
animation to presentation applications. 

The Elements of Friendly 
Software Design 
Paul Heckel 
319pp. Ref. 768·1 
Here's what you didn't learn in engineer­
ing school! This entertaining, practical text 
shows how the same communication 
techniques used by artists and filmmakers 
can make software more appealing to 
users. Topics include visual thinking; 
design principles to follow-and mistakes 
to avoid; and examples of excellence. 

Up & Running with TooiBook for 
Windows 
Michael Tischer 
138pp. Ref. 81 6·5 
In just 20 time-coded steps (each taking 
no more than 15 minutes to an hour), you 
can begin designing your own Windows 
applications. Learn to add visual interest 



with lines, colors, and patterns; create a 
customized database form; navigate the 
user interface; draw and paint with Tool· 
Book, and more. 

DESKTOP 
PRESENTATION 

Harvard Graphics Instant 
Reference 
Gerald E. Jones 
154pp. Ref. 726·6 
This handy reference is a quick, non· 
technical answer manual to questions about 
Harvard 's onscreen menus and help dis· 
plays. Provides specific information on each 
of the program's major features, induding 
Draw Partner. A must for business profes· 
sionals and graphic artists who create charts 
and graphs for presentation. 

Mastering Animator 
Mitch Gould 
300pp. Ref.688·X 
A hands-on guide to creating dynamic multi· 
media presentations. From simple animation 
to Hollywood-style spedal effects, from plan· 
ning a presentation to bringing it all to life-

it's all you need to know, in straightforward, 
easy-to-follow terms. 

Mastering Harvard Graphics 
(Second Edition) 
Glenn H. Larsen 
375pp, Ref. 673·1 
"The clearest course to begin mastering 
Harvard Graphics," according to Com· 
puler Currents. Readers master essential 
p rinciples of effective graphic communi· 
cation, as they follow step· by-step instruc· 
lions to create dozens of charts and 
graphs; automate and customize the 
charting process; create slide shows, 
and more. 

Up & Running with Harvard 
Graphics 
Rebecca Bridges Altman 
148pp. Ref. 736·3 
Desktop presentation in 20 steps-the 
perfect way to evaluate Harvard Graphics 
for purchase, or to get a fast, hands-on 
overview of the software's capabilities. 
The book's 20 concise lessons are time· 
coded (each takes no more than an hour 
to complete), and cover everything from 
installation and startup, to creating spe· 
cific types of charts, graphs, and slide 
shows. 
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Introduction to 
Macintosh System 7 _ eference 

m ermedtate How-To 
Advanced 

Introduction to Macintosh System 7 is a complete, plain-language guide to the exciting new features 

and capabili ties of System 7, the much-awaited new operating system for the Mac. Tum here for: 

• Practical, hands-on coverage of every aspect of 

the system, from installation to advanced and 

specialized techniques. 

• Up-to-the-minute information you won't find in 
other books, with full details on features not 
available in pre-release beta versions of System 7. 

• Complete compatibility information for pre­

System 7 programs and accessories-with tips and 

tricks for making your old software work in the new 

environment. 

Explore all the ins and outs of the System 7 
desktop, with a comprehensive tour of the system 

menus and desk accessories. 
Learn how to set up and run multiple 
applications, including tips on organizing the 
system for efficient multitasking. 
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Customize the system to suit your tastes and 
increase productivity. Topics include using 
custom icons; creating labels to group files and 

folders; file aliasing; and much more. 
Learn all you need to know about printing 
and fonts, including printing on a network; and 

detailed coverage of working with TrueType, 
PostScript, and bit-mapped fonts. 

Take advantage of sophisticated file-sharing 
techniques, including how to control file access 
on networks; share disks with MS-OOS computers; 

and link files using Publish and Subscribe. 
You'll also find: in-depth coverage of System 7's 

sound features; an insider's guide to hardware and 

software enhancements; and valuable information 
on memory management, data recovery, and virus 
protection. 
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